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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: "Standard", "High Quality", and
"Specific". The recommended applications for each Renesas Electronics product depends on the product's quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as "Specific" without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as "Specific" or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is "Standard" unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific": Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.
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i. Cautions

i. Cautions

Renesas neither warrants nor grants licenses of any rights of Renesas’ or any third party’s patent,
copyright, trademark, or other intellectual property rights for information contained in this
document. Renesas bears no responsibility for problems that may arise with third party’ srights,
including intellectual property rights, in connection with use of the information contained in this
document.

Products and product specifications may be subject to change without notice. Confirm that you
have received the latest product standards or specifications before final design, purchase or use.

Renesas makes every attempt to ensure that its products are of high quality and reliability.
However, contact Renesas' sales office before using the product in an application that demands
especially high quality and reliability or where its failure or malfunction may directly threaten
human life or cause risk of bodily injury, such as aerospace, aeronautics, nuclear power,
combustion control, transportation, traffic, safety equipment or medical equipment for life support.

Design your application so that the product is used within the ranges guaranteed by Renesas
particularly for maximum rating, operating supply voltage range, heat radiation characteristics,
installation conditions and other characteristics. Renesas bears no responsibility for failure or
damage when used beyond the guaranteed ranges. Even within the guaranteed ranges, consider
normally foreseeable failure rates or failure modes in semiconductor devices and employ systemic
measures such as fail-safes, so that the equipment incorporating Renesas product does not cause
bodily injury, fire or other consequential damage due to operation of the Renesas product.

This product is not designed to be radiation resistant.

No oneis permitted to reproduce or duplicate, in any form, the whole or part of this document
without written approval from Renesas.

Contact Renesas’ sales office for any questions regarding this document or Renesas semiconductor
products.
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ii. Preface

Ii. Preface

About thisguide

This guide explains the use of the Renesas Flash Development Toolkit (hereafter referred to as
FDT).

Chapter 1, Introduction, provides a brief explanation to the tool and listsits key features.

Chapter 2, System Overview, describes how the different facilities make up the FDT Graphical
User Interface.

Chapter 3, Using FDT, describes how FDT is activated and the FLASH ROM iswritten.
Chapter 4 , Wait For_Script
Chapter 5, Access Rights describes configuration of User Names and Passwords

Chapter 6, Configuring the User Interface, provides away to configure the FDT Graphical User
Interface.

Chapter 7, Menus, and Chapter 8, Windows, give reference information about the operations and
facilities available through these respective areas.

Chapter 9, Simple Interface Mode, describes use of FDT with a cut-down Graphical User
Interface.

Chapter 10, Basic Simple Interface Mode, describes use of FDT with a cut-down Graphical User
Interface without the need to setup a workspace and project.

Chapter 11, Field Programming, describes use the Field Programming feature for publishing
projects for other FDT users, and use of published projects.

Chapter 12, Updating the Adapter Software, describes how FDT updates the adapter software.
Chapter 13, Interface Boards describes the supported interface boards

Chapter 14 , QzROM Programming describes the programming of the new style of Renesas Flash
Chapter 15, Locking describes FDT operation with those devices that support erase block locking.

Chapter 16, Unique Code Programming describes how to implement serial humbering into an
FDT project
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ii. Preface

Chapter 17, ROM Code Protection describes support for ROM protection with some Renesas
devices

Chapter 18, Windows Vista® and Windows”® 7 describes the changes in FDT structure to support
execution on Windows Vista® and Windows® 7.

Chapter 19, Intelligent Flash Security (1FS) describes support for setting the ID codes of certain
Renesas devices.

Chapter 20 describes notes about upgrading to FDT 4.08.

Assumptions

It is assumed that the reader is experienced in using Microsoft® Windows® applications on PC-
compatible computers.
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iii. Abbreviations

Target / Device

DLL
FDT
QzROM
HEW
PC
UsSB
FCF

DDI

Kernel

Micro Kerndl

Main Kernel

E8/E8USB

Field Programming -

Publishing
E8Direct

iii. Abbreviations

Refers to the programmable microcontroller or microcomputer that is connected
to the PC ready for programming.

Dynamic Linked Library

Flash Development Toolkit

One time programmable memory

Renesas High-performance Embedded Workshop
Personal Computer

Universal Serial Bus1.1 or above

Flash Configuration File — Used to store information about the device and flash
characteristics

Device Data Image — a hybrid S-Record file format used for storing datafor a
device with multiple flash areas.

Code which takes control of the device and allows reprogramming functions. This
code is often downloaded to the device.

The part of the kernel which gets executed first and allows initia configuration
and downloading of the main kernel.

The part of the kernel which gets downloaded by the micro kernel and handles
downloading of additional modules (if required) to perform the read / write/
blank check / erase functions etc.

ThisisaUSB interface board. It supports programming over the single wire
interface and clock synchronous programming using the four wire interface.

The ability to package al kernel and datafilesinto asingle file for simplified
sending to another FDT user.

A UART mode for use with the E8.
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iii. Abbreviations

E8a The E8ais the Next-Generation E8 with additiona functionality. It is an on-chip
debugging emulator and Flash Programmer.

E8aDirect A UART mode for use with the E8a, designed to be similar to the E8Direct.

E1l An on-chip debugging emulator and flash programmer. This successor to the E8a
and E10A-USB emulators provides significantly more powerful functionality and
performance.

E1Direct A UART mode for use with the E1.

E20 An on-chip debugging emulator and flash programmer. Along with the debugging
functions supported by the E1, the E20 provides a higher level of debugging
functionality, including large-capacity tracing and realtime RAM monitoring.

E20Direct A UART mode for use with the E20.
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iv. Document Conventions

iv. Document Conventions

This manual uses the following typographic conventions:

CONVENTION MEANING

[Menu->Menu Option] Bold text with *->" isused to indicate menu options (for example,
[File->Save As...]).

‘dialog name’ The "’ isused to indicate the name of adialog box or menu.

‘Fi | enane. ext’ Bold Courier Font is used to indicate filenames.

“enter this string” Used to indicate text that must be entered (excluding the “” quotes).

Key+Key Used to indicate required key presses. For example. Ctrl+N means
press the Ctrl key and then, whilst holding the Ctrl key down, press
the N key.

=) When this symbol is used, it is always located in the |eft-hand

(The“how to” symbol) margin. It indicates that the text to itsimmediate right is describing

“how to” do something.

Table 1: Typographic Conventions

Windows” is aregistered trademark of Microsoft Corporation.
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| IE N ESAS Chapter 1 Introduction

Chapter 1 Introduction

The Renesas Flash Development Toolkit (FDT) is an on-board FLASH programming tool for
Renesas Flash microcomputers that provides a high-performance and user-friendly Graphical User
Interface (GUI).

Embedded software development projects created using the Renesas High-performance Embedded
Workshop (HEW) may be programmed into Renesas Flash devices using FDT.

FDT may also be used as a general purpose S-Record or Hex editor.

11 Key Features

— Standard window operation based on the 32-bit Windows® GUI.

— Various online help functions.

— Selectable messaging levels.

— Simple programming environment; optionally controls an adapter board.
— Serial communication.

— USB communications supported via USB Interface Boards

— USB communications directly to selected target devices.

— Wait for Script File facility

— Multiple flash areas in asingle image (DDI)

— Unique code programming for serial numbering etc.

— Programming and erasing of 1D codes (key codes) for generic boot devices with intelligent
flash security (IFS)

12 New Features
FDT4.08 has the following new features:

— Support for the FINE-communications interface with the E1 or E20 (for devices that
support FINE communications)

— A selectable option for whether to allow erasure of User Boot Area
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Chapter 2 System Overview

Chapter 2 System Overview

FDT provides a method of programming, erasing and reading from Renesas Flash devices.
Workspaces and Projects can be used in order to save the settings between sessions, for easy
switching between different settings, and to allow experienced users to configure the settings for
less experienced operators. FDT is designed to provide acommon look and feel, independent of
the actual device to be programmed.

FDT employs a hierarchical structure so that work can be organised in alogical manner. The top
level of the structure is the workspace.

To be useful, the workspace must contain at least one project. In order to create a project, a
workspace must be created first.

Each project specifiesits own target device configuration (specified when creating the project) and
set of target files (S-Record / Hex / Binary) that can be used to program the device.

The project settings for the target device connection need only be set once, asthey can be stored
between sessions by saving the Project.

A single project within the workspace is active at any point in time. The active project is the
context to which all ‘Device' Menu, ‘Project’ Menu and ‘ Project’ Toolbar commands will be
directed.

When a project has been created, target files can be added to it. These files may:

— Be used to program the device.

— Beused to build a Device Image.

— Beopened in the hex editor.

— Bemarked as being destined for the User Boot Area (for devices which support this).
— Have their checksum calculated

— Havetheir data block usage displayed

— Be compared against the data already programmed to the device

When using a project it is possible to take advantage of the following FDT features:

— Advanced messaging levels.

— Device Image builder.

— Uploading data from the target device.

— Viewing uploaded datain big or little endian, or floating point representation.
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Chapter 2 System Overview

— Simple Interface Mode — for smplifying the user interface once the project is configured.
— Automatic masking of non-Flash areas in files upon opening project open
— Automatic masking of reserved sections within Flash areas

21 User Interface

The FDT Graphical User Interfaceis a Windows® application that presents awork environment,
which allows the user to program FLASH memory.

Tonl Ba —— [Eaie &

_#_FF:]-es opeeT
= inHex
Editor

L HexEditor
Address Calumn

Addibional
Project
o
Editer | ———] Diata File
window perties
Diialag
| Qutput
window

AL~ A R K e SO 1
i —aani sty T gl [

O oy e e e U O )

o | = a
Erabus Bar
Flazh Propartizs

window (Cacked)

Figure2-1 FDT Graphical User Interface

211 Menu bar

Commands are grouped into related areas on the Menu bar as indicated by the menu titles. Using
the mouse the user can select a command operation, invoke a dialog box or awindow to interact
with the system. Clicking the left mouse button on a menu title will pull down that menu, from
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Chapter 2 System Overview

which a selection can be made. If a menu item does not perform an action directly, but instead
displays adialog box or window for further user interaction, then its name is appended with an
ellipsis (three dots, ...).

Project  Tools  MWindow Device
Sek Current Project r

Insert Projeck. ..

add Files. ..

Remove Files...

File Extensions. ..

Rebuild Image

Download Image

Field Progranmriinig L

Figure2-2 Menu Ellipsis

If amenu item can also be invoked by pressing a hot key (a combination of keys), then the hot key
isdisplayed to the right of the item. If a menu item toggles afeature ON or OFF then a check mark
will be displayed next to its text when it is ON:

i window Device Help
Cascade
Tile Horizontally
Tile Mertically

Arrange Icons

Close &l

1 22532Tesk.mok
Z ugenll.mok - [0x000002a7]
+ 3 Industrial Contraller. Fpr - [Ox00000292]

Figure2-3 Checked Menu Items

If amenu item has the symbol ( » ) next to it then a cascading or hierarchical menu is available.
Clicking on the menu item will reveal the cascading menu:
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Help Topics

Technical Suppork Create Bug Report, .,
about FOT. .. Check website for updates

Figure2-4 Cascading Menus

Menus can also be selected directly from the keyboard by pressing the ALT key followed by the
corresponding key of the underlined letter or number for the menu item that the user wantsto
select, e.g. pressALT+F, Sin sequence to Save the active file ([File->Save]).

2.1.2 Toolbars

FDT has several toolbars located below the Menu bar. This provides quick accessto FDT features
by clicking the respective button with the mouse.

[ ==& & e e

[@ieas|rtlonisws 2rinel|s
e IEE )
Figure2-5 FDT Toolbars

The buttons on each toolbar are arranged in associated groups. To find out the function of the
button, move the mouse over the button and a hint will be displayed next to the button and in the
status bar. The toolbar buttons can be customised to provide a button for the majority of the
features available in FDT and can be arranged in an order that the user finds convenient. For more
details about changing the arrangement of the toolbar buttons and a detailed description of each
button's function, see Chapter 6.
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Edit toolbar

Have File
Cut
Copy

Paste
Open & Data File

Figure 2-6 Edit Toolbar
Save File - saves the activefile.
Cut - cuts data to the clipboard.
Copy - copies datato the clipboard.
Paste - pastes data from the clipboard.

Open a Data File - Opens an S-Record or other datafile.

FDT toolbar

PSSP R e [

Cormact —[ |
Disconnect
Erase Blacks

Elank Chaclk

Upload

Doemlosd Active File
Checlksum

Go from Address

Faun

Block Locking

Zet ID Code

Caneel

Configume Flah Project

Figure2-7 FDT Toolbar
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Connect - connects the device to the interface.
Disconnect - disconnects the device from the interface.

Erase Blocks - launches the 'Erase Block' dialog box to erase all or individual blocks of the device
FLASH memory.

Blank Check - checks whether or not the FLASH section of the target device is blank.

Upload - launches the 'Upload Image' dialog box to allow data to be obtained from the target
device.

Download Active File - downloads the file which is active in the hex editor.
Checksum - returns a checksum of the datain the FLASH.
Go from Address - launches adialog to select the address to execute from.

Run - places the device into user mode and if necessary supplies power so that programmed device
code can be tested

Block Locking - configure the block locking options (if the device supports block locking)
Set ID Code - setsan ID code (if the device supports this)
Cancel - cancels the current FLASH operation.

Configure Flash Project - launches the 'Project Properties dialog box (or the Project Wizard if the
project is not yet configured).
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SRecord / Data File toolbar

ke B Q& 2SR

Viewr as Bytes E—

Viewr a5 Words

Viewr as D'Words
Endian

Alizn viewr to B byte
Togzle ASCII
Find

Find and Eeplace
Create Selaction
Fill selection
Properties

Figure2-8 SRecord/ DataFile Toolbar
View as Bytes - view the file data as 8 bit bytes.
View asWords - view the file data as 16 bit words.
View as DWords - view the file data as 32 bit double words.
Endian - toggles between little and big endian viewing.

Align view to 8 bytes - datais displayed on each line as 8 bytes. The number of bytes that can be
accommodated on each line is dependent upon the size of the window.

Toggle ASCII - turns ASCII data ON or OFF

Find - launches the 'Find' dialog box.

Find and Replace - launches the Replace dialog box.

Create Selection - selects ablock of the specified size in the activefile.
Fill selection - launches the 'Fill' dialog box.

Properties - launches a dialog with information about the active file.
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Protection toolbar
|0 |e” & |

Lutomatic l
Prorapt
Mone

Figure2-9 Protection Toolbar

Automatic - Set protection automatically on disconnect (if more than one option is available a
dialog will appear to select which type to automatically apply)

Prompt - Ask the user whether to set protection on disconnect.
None - Never set protection on disconnect.

NB setting the protection may stop any further connectionsto that particular target device

Sear ch toolbar

|| [os00 R

Fid in Files

Find
Find Haxt
Fid Previous

Figure2-10 Search Toolbar
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Find in Files - finds selected data in selected files.
Data - isused for the searches.

Find - locates data in active file.

Find Next - locates next occurrence of search criteria

Find Previous - locates previous occurrence of search criteria.

2.1.3 Status Bar

The Status Bar islocated at the bottom of the FDT application window. It provides the user with
information about what the application is doing. The left section of the Status Bar describes the
action of the Toolbar items as the mouse arrow is positioned over a button, as well as displaying
operation status information. When an action is being performed, a progress bar is displayed to
show the progress of the current operation. The last section of the bar indicates the state of the
toggling keyboard keys such as the Caps Lock, Insert and Number Lock keys.
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214 Pop-up menus

Many windows have local pop-up menusin order to make commonly used features easier to
access. These menus are invoked by clicking the right mouse button in the window (or pressing
SHIFT+F10) and then selecting the required menu option. An example pop-up menu is:

Open Uploadd,MOT

&add Files. .. NS
Remaove Files. ..

IT Allow Docking
Hide

Properties

Display Block Usage. ..
Exclude Uploadd.MOT
Ilser Boot Flash

Downlaad File to [User Area)

File Checksum

Compare File- =Device Checksum
Compare File- =Device (Complete Dewvice)

Compare File- =Device (File Data Only)

Figure2-11 Pop-up Menu

The contents and operation of specific pop-up menus are explained in detail in the description of
each FDT window, see the Chapter 8, Windows.

2.2 Help

FDT has a standard Windows® help system. This provides on-line information for using the
system.

Help can be invoked by pressing the F1 key or via the Help menu.
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23 HotKeys

There are various hot keys for frequently used operations. These are as follows by category:-

Description Hot Key
Help

Help F1
File Commands

CloseFile Ctrl+F4

Open Data File Ctrl+R

SaveAll Ctrl+Shift+H

Save Ctrl+S

Exit Alt+F4
Edit Commands

Undo Ctrl+z

Redo Ctrl+Y

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+Vv

Select All Ctrl+A

Eind Ctrl+F

Find In Files F4

Replace Ctrl+H
Tools Commands

Login Ctrl+Shift+U
Simple I nterface Commands

Login Ctrl+Shift+U
View

Workspace Alt+K

Output Alt+U
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Description Hot Key
Window
View as ASCII Alt+A
View as Bytes Alt+1
View asWord Alt+2
View as Dword Alt+4
Align to 8 Bytes Alt+8
Device
Connect Ctrl+Alt+C
Erase Flash Blocks Ctrl+Alt+E
Blank Check Ctrl+Alt+B
Upload Image Ctrl+Alt+U
Download ActiveFile Ctrl+Alt+P
Flash Checksum Ctrl+Alt+S
Go From Address Ctrl+Alt+G
Run Ctrl+Alt+R
Block Locking... Ctrl+Alt+L
Set ID Code... Ctrl+Alt+T
Cancel Operation Ctrl+Break
Configure Flash Project Alt+Shift+R
Data File
Suppressrequest to save changesto Hold Shift key when closing data file
a data filewhen closing it (do not
save changes)
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Chapter 3 Using FDT

31 Quickstart
The stages required in order to program a device are as follows:

1) Start FDT by selecting ‘ Start’ - > ‘Programs’ - > ‘Renesas’ - > ‘Flash Development_Toolkit
4.08', then the * Flash Development Toolkit 4.08" shortcut [see section 3.3]
2) Create aWorkspace and Project [see section 3.4.1]

3) Configure the Project using the Flash Project Wizard (select device, kernel, port, mode etc)
[see sections 3.4.2 to 3.4.8 or section 3.5 for Generic Boot]

4) Addthefileor filesthat you want to download to the project [see sections 8.1.2.1/8.2.2/3.7].
Y ou can now download individual files by right clicking on them in the Workspace Window,
or merge multiple files into adevice image (using the Project- > Rebuild Image menu item)
and download that (using the Project- > Download Image menu item).

Alternatively, to start in FDT Basic Simple Interface Mode:

1) Select ‘Start’- >'Programs’ - > ‘Renesas -> ‘Flash Development Toolkit 4.08’, then the ‘ Flash
Development Toolkit 4.08 Basic’ shortcut [see section 3.3]

2) Configure the settings using the Wizard (select device, kernel, port, mode etc) [see sections
3.4.2t0 3.4.8 or section 3.5 for Generic Boot]

3) Select the flash areathat you want to program (User Area or User Boot Area).
4) Select thefileto program for each enabled area

5) Select the Program Flash Button.

6) Disconnect when programming is completed
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3.2 Background Information
321 What arethe User Area, User Boot Area and Data Areas?

The normal area of (internal) flash for Renesas devices, for user programsis known as the User
Area. Thisiswhere the code is stored which gets executed when the device is reset into User
Mode. The User area can normally be programmed from a Boot Mode or User Mode connection.

On some devices thereis an additional area of flash known asthe User Boot Area. Thisiswhere
the code is stored which gets executed when the deviceisreset into User Boot M ode. The User
Boot Areatends to be much smaller than the User Area and istypically used for storing an
alternative boot stub, for setting up communication via some other communications medium /
protocol. Normally, the User Area and the User Boot Area both start at the same address — thisis
possible because only oneis ever mapped into the memory map at one time. It is only possible to
program the User Boot Area from Boot Mode - not from User Mode.

On some devicesthereis an additional area of flash known asthe Data Area. Thisarea normally
resides at the other end of the memory map to the User Area, and unlike the case of the User
Boot Area, the Data Area is not contiguous with the User Area and always existsin the memory

map.
3.2.2 What isthe difference between Boot M ode and User M ode?

The Renesas Flash devices have different modes of operation which are controlled by the state of
the mode pins when the device is brought out of reset. Most devices have an asynchronous serial
Boot Mode and a User/User Program Mode.

Generally, (asynchronous serial) Boot M ode connections, start with an autobaud — sending
synchronisation data packets to setup initial communications at a given baud rate. Additionally,
for most devices, the entire flash will be erased as part of the connection process, thus preventing
any Intellectual Property held on the device from being read from Boot Mode.

For aUser Mode connection, the device must aready be programmed with some code which talks
to FDT and allows programming. Most kernels are supplied with a User Mode micro kernel and
test program (*usually called “ uGenU. not ” and “ xxxxt est . not ”). Thesefiles provide a
demonstration of User Mode programming and must be programmed into the device and be
executing before FDT tries to connect in User Mode. User Mode does not normally force an erase
of the flash during the connection process and does not autobaud to setup initial communications.
The demonstration User Mode test programs have the required Bit Rate Register value compiled
into them for setting up initial communications at 9600 baud; hence User Mode kernels need to be
rebuilt for different clock frequencies.
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Note: * Note that where the files are to be used as part of an embedded monitor, the User Mode
kernel files may be also output as binary files (.cde) without the reset vector popul ated.
Some kernels use only a single file for the User Mode test program (e.g. Protocol C
kernels).

323 What isthe difference between User Mode and User Program Mode?

Some devices use an additional mode pin to protect the flash from being written or erased by
mistake; this pin is normally known as the “Flash Write Enable” pin (FWE) if it hasto belogic
high to alow programming, or the “Flash Write Protect” pin (FWP) if it has to be logic low to
alow programming. For these devices, this pin distinguishes “User Mode” from “User Program
Mode”. An FDT User Mode connection expects the device to be in User Program Mode at the
point of programming and erasing, and if using the E8Direct, E8aDirect, E1Direct, or E20Direct,
can reset the device into User Mode to execute the programmed code on disconnection.

324 What are“Protocol B”, “Protocol C", “Protocol D” and “Protocol E” Kernels?
“Protocol B" — For 0.35um devices.

Boot Mode - The kernel (made up of the Boot Mode Micro Kernel, Boot Mode Main Kernel, and
the Write and Erase modules) is held on the PC and downloaded as required. The Boot Mode
kernel does not need to be rebuilt for different crystal frequencies; thisinformation is stored in the
FDT project and downloaded at runtime and initial communication is achieved by the autobaud
(where FDT sends 0x00 data until the device synchronises with it).

User Mode — The User Mode Test Program and User Mode Micro-Kernel need to be already
programmed and executing on the device. The initial Bit Rate Register valueis held in the
‘gentest.h’ file and is compiled into the User Mode Test Program; this allows the kernel initialise
the serial communications interface to 9600 baud. If the clock frequency changes from the default
supplied value, the initial Bit Rate Register setting in ‘ gentest.h’ [normally MA_BRR_SCI or
MA_BRR_SCI1] will need to be modified and the kernel recompiled. The User Mode Main
Kernel and the Write and Erase modules are held on the PC and downloaded as required.

“Protocol C" — For devices with embedded kernels (Currently 0.18um).

Boot Mode — A configuration fileis stored on the PC which provides FDT with details about the
device, but the kernel (including the Write and Erase modules) resides internally on the device.
There is no need to rebuild anything for different clock frequenciesin Boot Mode; this
information is stored in the FDT project and downloaded at runtime and initial communication is
achieved by the autobaud (where FDT sends 0x00 data until the device synchronises with it).
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User Mode — Some boards are supplied with a User Mode kernel. Similarly to the Protocol B User
Mode kernels, User Mode Kernel needs to be aready programmed and executing on the device.
Theinitial Bit Rate Register value isheld in the ‘gentest.h’ file and is compiled into the User
Mode Test Program; this allows the kernel initialise the serial communications interface to 9600
baud. If the clock frequency changes from the default supplied value, the initial Bit Rate Register
setting in ‘gentest.h’ [normaly MA_BRR_SCI or MA_BRR_SCI 1] will need to be modified and
the kernel recompiled. The main difference to the Protocol B User Mode Kernelsis that the Write
and Erase modules are held internally on the device.

“Protocol D" — For R8C and former Mitsubishi family devices (eg. M16C, M32 etc).

The E8 and E8a boards can be used with some Protocol D devices. The kernels are internal to the
device, but FDT uses configuration files to store information about the device characteristics.

“Protocol E” — For some H8/Tiny and H8/SLP (Super Low Power) devices (please refer to
'readme’ text file for details).

Although FDT can communicate to H8/Tiny and H8/SLP devices with COM or E8aDirect (as
“Protocol B”), FDT can also communicate to H8/Tiny and H8/SL P devices with E8a as “ Protocol
E”. It isimportant to note though that key FDT functions are not available in “Protocol E”:

e FErasing Datafrom the FLASH ROM is unavailable (although all FLASH ROM datais still
erased during connection)

e Uploading the FLASH ROM Datais unavailable

e Performing a Blank Check isunavailable

e Readback Verify isunavailable (but FDT will automatically perform a checksum after
programming)

3.25 What isthefcf file, and can | edit it?

Stored alongside the other kernel files, the .fcf (Flash Configuration File) file holds details about
the device and kernel. The contents indicate the RAM size, flash-memory size, block
configuration, default baud rate, and default crystal frequency. Thisfileis protected by a
checksum, so editing it will render thisinvalid, which the FDT will detect. Upon detecting an
invalid checksum for the file, the FDT will warn the user, but will not prevent use of the modified
files.

R20UT0508EJ1100 Rev.11.00 RENESAS Page 18 of 216
Mar 07, 2012



Chapter 3 Using FDT

3.2.6 Can | use FDT if I do not have L ocal Machine Administrator rightsfor my PC?

Yes, but only onceit isinstalled and configured. To install FDT and for various configuration
tasks, you must have local administrator rights; thisis because some settings are stored in the
HKEY_LOCAL_MACHINE registry area. Once FDT isinstalled and configured you will be able
to use it with certain limitations. Configuration tasks such as adding new kernel entries to the
registry so that they will be available in the Project Wizard in future requires Local Machine
Administrator rights. Thisincludes adding the Prior Generic Device entry (an administrator must
first connect to the Generic Deviceto allow the Prior Generic Device entry to be created.

3.27 How do | recompileakernel?

It is recommended that the original kernel is copied to another directory and that this copy is
edited, thus leaving the original kernel unmodified. When using the kernel for the first time, you
will need to browse to the alternate location to find the fcf file.

If the kernel has been written using Hew, there will be a Hew workspace file in the project
subdirectory of the kernel. This should be opened from Hew.

If the kernel has been written based upon compilation from the command line, you will need to
run the buildall.bat file from a Dos shell session after setting up the environment variables for the
compiler so that it can be run from the command line. Please refer to the compiler manual for full
details of how to do this. An example environment batch file used to set the environment settings
for the Renesas H8 compiler version 4.0ais shown below:

Setenv.bat:

SET CH38=C: \ hew\t ool s\ Renesas\ h8\4_0_A\ | NCLUDE
PATH=%ATH% C. \ hew\ t ool s\ Renesas\ h8\4_0 A\ bin
set DOS16M= @M 31M

SET CH38TMP=c: \ TEMP

Note:
The above batch file should be modified to reflect the path of your compiler.

Ensure that the specified temporary directory exists and is writeable.
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3.2.8 How do | usethe supplied demonstration User Mode Kernels?

To use the demonstration User Mode kernels, you must first add the User Mode Micro Kernel and
User Mode Test Program from the kernel directory (“ uGenU. not ” and “ xxxxt est . not ") to
aBoot Mode Project and build the User Area Device Image. Next, connect in Boot Mode and
program the image to the device, disconnect and reset the device into User Mode. Create another
project in the workspace, but thistime set it asa User Mode Connection Type, and connect in User
Mode. FDT will start communications with the User Mode Test Program at 9600bps and then
change to the baud rate set in the project. Note that the device does not automatically erase during
connectionsin User Mode. It is not possible to reprogram the FLASH whilst the reprogramming
code is executing from the FLASH so all of the kernel modules needed to keep the connection to
FDT are copied into the RAM to leave the FLASH ROM available for reprogramming. Because of
this, it is possible to erase the entire flash and reprogram it in user mode, but note that if the device
isreset after erasure and before it is reprogrammed, it will not be possible to reconnect in User
Mode until the device has had the User Mode Micro Kernel and User Mode Test Program
reprogrammed into it Boot Mode.

3.2.9 Can | modify the User Mode kernelsto work for a different clock frequency?

It is recommended that the original kernel is copied to another directory and that this copy is
edited, thus leaving the original kernel unmodified. When using the kernel for the first time, you
will need to browse to the alternate location to find the fcf file.

The User Mode kernels need to be rebuilt if a different clock frequency is going to be used. The
initial Bit Rate Register valueis held in the ‘gentest.h’ file and is compiled into the User Mode
Test Program,; this allows the kernel initialise the serial communications interface to 9600 baud. If
the clock frequency changes from the default supplied value, the initial Bit Rate Register setting in
‘gentest.h’ [normally MA_BRR_SCI or MA_BRR_SCI 1] will need to be modified and the kernel
recompiled. Refer to the device hardware manual for details of how to calculate the Bit Rate
Register value.
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3.3 Starting FDT

331 Starting FDT without Security or Simple Interface M ode enabled

To start FDT, open the 'Start’ menu of Windows® and select 'Programs - > 'Renesas - > 'Flash
Development Toolkit 4.08', then the ‘Flash Development Toolkit 4.08' shortcut. The "Welcome'
dialog box will open by default.

kES

oK |
& Lreate 2 new project workspace o |

% ™ Open arecent pioject workspace

I 2]

=2 ™ Browse to another project warkspace
- Admirustiation. |

Figure3-1 Welcome Dialog

To create a new workspace, select 'Create a new Project Workspace' and click the 'OK' button (see
section 3.4.1 for details). To open arecent workspace, select 'Open arecent project workspace' and
the workspace to be opened from the list box. To open an existing workspace which isnot in the
list of recently used workspaces, select 'Browse to another project Workspace'. Finally, click the
'OK" button.

332 Starting FDT in Basic Simple Interface Mode

To start FDT in Basic Simple Interface Mode, open the 'Start'’ menu of Windows® and select
'Programs -> 'Renesas - > 'FLASH Development Toolkit 4.08', then the 'Flash Development
Toolkit 4.08 Basic' shortcut. The previous FDT Basic settings will be restored, and new settings
can be entered by selecting the Options->New Settings& menu item.

3.33 Starting FDT by double clicking on a wor kspace file

FDT can be started by double clicking on aworkspace file from Windows® Explorer. This will
cause FDT to load the selected workspace upon start up.
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3.34 Starting FDT by doubleclicking on a data file

FDT can be started by double clicking on aregistered data file from Windows® Explorer (if this
default option was not unselected during installation). Thiswill cause FDT to load the selected
datafile upon start up.

335 Starting FDT by double clicking on a w4f script configuration file

FDT can be started by double clicking on a.w4f script configuration file from Windows®
Explorer. Thiswill cause FDT to start in Wait For Script mode and |oad the selected
configuration.

3.36 Starting FDT with Simple Interface M ode enabled

If FDT was exited from Simple Interface Mode (see section Chapter 9) FDT will return straight
back to that mode.

3.37 Starting FDT with Access Rights password security enabled

If the Access Rights password security has been enabled, FDT will display the login dialog before
alowing the workspace to be opened. See Chapter 5 for further details.

3.38 Starting FDT by double clicking on a .fpf4 packaged project file

FDT can be started by double clicking on a .fpf4 packaged project file from Windows® Explorer.
Thiswill cause FDT to unpackage the project and start in Simple Interface Mode.

3.39 Starting FDT from the command line
3.3.9.1. Opening data filesfrom the command line
"<FDT path>\FDT.exe" /IDISCRETESTARTUP "osre\"< Filename >\""
€eg:

"C:\Program Files\Renesas\FDT4.08\FDT.exe" /DISCRETESTARTUP "osre\"C:\Program
Files\Renesas\files\myfile.mot\""

This is the method used when an FDT datafile is double clicked in Windows® Explorer
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3.3.9.2. Opening workspace files from the command line

"<FDT path>\FDT.exe" /IDISCRETESTARTUP "ow \"<Long Path Workspacename>\""

€9

"C:\Program Files\Renesas\FDT4.08\FDT.exe" /DISCRETESTARTUP "ow \"C:\Program
Files\Renesas\FDT4.08\Workspaces\1234\1234. AWS\""

This is the method used when an FDT workspace is double clicked in Windows® Explorer

3.3.9.3. Opening data filesfrom the command line with Access Rights password security
enabled

"<FDT path>\FDT.exe" "arl \"<Username>\" \"<Password>\"" /DISCRETESTARTUP "osre \"<
Filename >\""

€9

"C:\Program Files\Renesas\FDT4.08\FDT.exe" "arl \" Administrator\" \" password\""
/DISCRETESTARTUP "osre \"C:\Program Files\Renesas\fil es\myfile.mot\""

3.3.9.4. Opening w4f Script Configuration files from the command line

"<FDT path>\FDT.exe" /DISCRETESTARTUP "w4fRun \"<filename>\""

€9

"C:\Program Files\Renesas\FDT4.08\FDT.exe" /DISCRETESTARTUP "w4fRun \" C:\Program
Files\Renesas\FDT4.08\myconfig.w4f\""

This is the method used when an FDT Script Configuration file is double clicked in Windows®
Explorer

3.3.9.5. Opening w4f Script Configuration files from the command line with Access Rights
password security enabled

"<FDT path>\FDT.exe" "arl \"<Username>\" \"<Password>\"" /DISCRETESTARTUP "w4fRun
\"<filename>\""

€9

"C:\Program Files\Renesas\FDT4.08\FDT.exe" "arl \" Administrator\" \" password\""
/DISCRETESTARTUP "w4fRun \" C:\Program Files\Renesas\FDT4.08\myconfig.w4f\""
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3.3.9.6. Starting FDT Basic Simple I nterface M ode from the command line

"<FDT path>\FDT.exe" /[DISCRETESTARTUP "SimplelnterfaceMode /u \"<User Area
Filename>\" /b \"<User Boot Area or Data Area Filename>\""

€g

"C:\Program Files\Renesas\FDT4.08\FDT.exe" /DISCRETESTARTUP "Smplel nterfaceMode /u
\"c:\uploadl.mot\" /b \"c:\upload0.mot\""

Note that the /u <User Area Filename> and the /b <User Boot Area> are optional. Additionally,
adding /r causes the last settings to be restored and the configuration Wizard will not be displayed.
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34 Creating a New Workspace and Project

When FDT is started in full mode (not FDT Basic Simple Interface Mode), a workspace and
project must be opened or created. See Chapter 10 Basic Simple Interface Mode for details on
programming without setting up a workspace and project.

34.1 New Project Workspace

rew Project Workspace i x|
Propects |

‘Workspace Nane:
|I niustial Cortrader

tFrlT f-::n;i:g-u:':l: -Ifi-El'lﬂl--:ﬂl:l [

Project Mame;
II ndustnal Cortrader

Direchoey:

IE:".FDT “Workzpacesh ndustial Cortraler Browse. . I

Froperties. .

Ok I Cancel

Figure3-2 New Workspace

Enter the workspace name (the project name is the same by default), then click the 'OK" button. If
you wish to change or create adirectory, input adirectory name or use '‘Browse..." button.
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34.2 Choose Device and Kernel (not Generic Boot*)

Select the device/kernel you wish to use from the list. The list can be filtered by typing into the
Filter box, note that if the project name starts with three or more numbers then these will
automatically be entered into the Filter box. It is possible to have more than one kernel option
displayed for agiven device, and double clicking on a kernel will open an optional "readme.txt"
file that has information about the kernel (such as the device, version number and the compilersit
was created with). If you have an aternative kernel elsewhere, which isnot in the list, select
‘Other..." to specify the kernel Flash Configuration File (.fcf).

Note: Registering a new kernel requires' Administrator' privileges. On Windows Vista® or
Windows® 7 this may require the user to provide extra confirmation or credentials.

* For connection to a Generic Boot Device see the "Configuring a Project for a Generic Boot
Device" section.

Choose Device And Kernel x|

The FLASH Development Toolkit supportz a number of Renezas FLASH devices.

Select the device you wizh to uze with thiz project from the list below,

Fiter  [ha/a02

Type | Full Harmne | K.ernel Yersion I Info
H8/300H HE/3022F 1000
H&/300H HE/3024F 1.2 00
H8/300H HE/3026F 1200
H&/300H HE/3028F 1100

Generc BOOT Device  Genenc BOOT Device  MAA

1 | i

¢ Back I et > I Cancel |

Figure 3-3 Device and Kernel Selection
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Supplementary:

1. Type Names of Devices Intended for x-Line Connection Only

The suffix “_xLine” for type names indicates that the devices are intended for x-line
connection only.

2. Type Names of Devices That Vary According to Whether or Not ECC Datais Included

If you wish to program a device that has E2 data flash memory, select either of the following
type names according to whether or not the data to be written to the device includes ECC data.

(a) R32C/100 series

- When ECC dataisincluded: R5F64xxx_ECC

- When ECC datais not included: R5F64xxx

(b) M16C/50 series

- When ECC dataisincluded: R5F35Mxx_ECC _xLine
- When ECC datais not included: R5F35Mxx_xLine

R20UTO508EJ1100 Rev.11.00 < RENESAS Page 27 of 216
Mar 07, 2012



Chapter 3 Using FDT

343 Communications Port
Select the port (and interface if available) from the drop-down list, then click the 'Next' button.

Communications Port |

|Use this page to select your desired communications
portfinterface. All settings may be changed after the project is
created.

Select port: EfaDirect -

(1) Output O
(2] GND

(3] Output C
(4] Output &
(5] Txd

(6] Output E
(7] Output B
(3] UYCC

(9] U¥CC2

(10) Output F
[11] Rxd

(12] GND

(13) RESET
{14} UCONHECT

Select an Interface type to connect to the target device with.
Momally this will be "Direct Connection” or simply left blank.

Select Interface: j

[ Set Reset pin as low when disconnecting

< Back Mest = Cancel

Figure 3-4 Communications Port
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E8a Debug Interface with E8a
E8 Debug Interface with E8
El Debug Interface with E1
E20 Debug Interface with E20
E8aDirect UART with E8a
E8Direct UART with E8
E1Direct UART with E1 (include the FINE interface)
E20Direct UART with E20 (include the FINE interface)
COM RS-232C
USB Direct UsB
Supplementary:

Setting to Place the Low Level on the Reset Pin at the Time of Disconnection

If * Set Reset pin aslow when disconnecting’ is selected in the * Communications Port’ dialog box,
alow-level signal will be output by the reset pin when the device is disconnected. Thisoption is
only available when E8a, E8aDirect, E1, E1Direct, E20, or E20Direct has been selected for ‘ Select
port’.
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344 Device Settings

Enter values for the device settings; enter the input clock, then select the main and peripheral
clock multipliers from the drop-down lists, and click the 'Next' button.

Device Settings )

iﬂ?-._-u_“i__ 4
i-.:';:rk':;par& 'lnrJu]EE | Tr_'_'
i=F DI:\‘-[JL':I';" i
H __! Devics Jnnage
= ;[:-_"unt Files
;_,] LEB, mok
B Karbaardn
5] Comms, miak

-.F.—I! Drévice Tmaos
(- Target Files
...ﬂ Doy e nak
=Y Dt apmok
:J Algorithim.m

Fleaze enter the specific device options bazed on:

| [HES/2282F] using [Frotocol B]

5]

Select the external clock or the |E:-:terna| Clack

internal clock:
[ M
I HIOMNE = I

-
I j'

Enter the CPU ciystal frequency
for the zelected device:

Enter the clock mode for the
zelected device:

Select the multiplier for the bMain
clock frequency [CEM];

Select the multipler for the
FPeripheral clock frequency [CEP:

Cancel

¢ Back I Mext = I

Figure 3-5 Device Settings
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Supplementary:

1

Clock Setting
Select the clock source to be supplied to the CPU.
(@  When the device in use does not support switching of clock sources:
Clock oscillator or clock resonator: [External Clock or Resonator]
(b)  When the devicein use supports switching of clock sources:
Clock oscillator: [External Clock]
Clock resonator: [External Resonator]
On-chip oscillator: [Internal Clock]
CPU Crystal Frequency
Enter the frequency of the CPU clock or the crystal generator. This can be specified upto 4
decimal places. Thetarget device, the kernel and the Clock Mode determine the valid range.
Clock Mode
If enabled, select the required value from the drop-down list.
Multiplier for CKM
If enabled, select the input clock multiplier for the master (system) clock. The available
options depend upon the target device, the kernel and the Clock Mode.
Multiplier for CKP
If enabled, select the input clock multiplier for the peripheral clock. The available options
depend upon the target device, the kernel and the Clock Mode.

Note: To enter the clock mode, input clock, and multipliers, refer to the device hardware manual

and/or the target board manual to confirm the values required.
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345 Connection Type

Select whether the connection is for Boot Mode or User Mode in the 'Connection Type' dialog.
Additionally, for a connection to akernel that is still running on the device from a previous
session, select the 'Kernel already running' check box. Next, select the communication speed (bps)
if the default value is not correct or not present. Speeds where the target error rate is greater than
4%, or the E8Direct\E8aDirect\E1Direct\E20Direct error rate is greater than 0% are automatically
removed from the recommended list. When using the E8Direct\E8aDirect\E1Direct\E20Direct the
'‘User Specified' connection speed option is enabled; when selected, this allows the user to specify
anon-standard baud rate. The error rate will be displayed this takes into account the target
peripheral clock rate, the target Bit Rate Register calculation formula, and the
E8Direct\E8aDirect\E1Direct\E20Direct characteristics.

Click the 'Next' button to continue.

Connection Type X ﬂ

The FLASH Development Toolkit can connect to your device in a
numbet of different ways. All the options on this page may be
S changed after the Project has been created.

ﬁ':;rt #'F_"""F-' "Trdeg, a1 Select Connection:
D : " USER Program Mode
__J I.l.:u..._.n:r: J'l'l-.'ll_‘.je
< Target files [T Kernel already runming
ﬂ t:;‘:;‘:d 1) In B2OT Prograim mode the device erazes itz FLASH prior to
* L..Jrnmc .-.u..rl connection. The Toolkit dovwnloads programming kernels to the
P " device as reguired.

= Deylce Image The Recommended Speed setting is based on the current device

fel T ar *.J"ﬁ':_"““:' ] and clock. The user may also input their owen, if this is supported
= "":“';:'C'r' by the kernel (and the optional FOM).
=Y Dabamok

=0 Algo (TR > R ded S ds: |=7 -
= * Recommended Speeds: l:n’ 500 "] v Defait

A il o Uzer Specified: |

¢ Back I Mewst » I Cancel

Figure 3-6 Connection Type
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Note that 'Use Default' is designed for use with the Renesas Evaluation Board or Evaluation
Development Kits. Uncheck thisto allow manual selection of the bit rate.

3.4.6 Programming Options

Select the protection level for programming the FLASH ROM and the messaging level, then click
the 'Finish' button, or if the E8Direct\E8aDirect\E1Direct\E20Direct was selected, click 'Next' to

continue.

e |

I':';'l"".'lrl'ﬂ' e _ . :

] "'F-'"-"'E-'[n,:l T
T -EE;] Bisglay ik E
.-__l Device Itnage

o= Target Files
12 |LEE . Mok
l'_jl Eavboard, m

18] Carfnms , Mk

] Diévice Tmage
— 4 Target files
=Y Dok
= Daamok
':] Aot

What level of device protection would you like?

— Protection
¥ ftomatic

" |nteractive " Mone

What level of messaging would you like?

When programming the device, any blocks found to have been
written previoushy will automatically be erased.

— Messaging
" Standard

¥ Advanced

The Toolkit will display verbose messages whenever it is
communicating with the Target device. This mods is useful for
Inteface hardware development, and Kemel development.

Would you lilke to perform readback verfication after programming 7

— Readback Verfication

£ Mo

< Bach I Finish I

Cancel

Figure3-7 Programming Options
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3.4.7 E8Direct\E8aDirect\E1Direct\E20Direct Pin Settings

[Only if the E8Direct, E8aDirect, E1Direct, or E20Direct is selected] Select the 'Operating Mode'
and 'Clock Mode' and if 'User Defined', set the pin settings. [For 'Boot Mode' projects set the 'Boot
Mode Outputs and the 'Boot Mode Setting' for the required mode, for 'User Mode' projects set the
'‘User Mode Outputs, 'User Mode Setting' and the 'User Program Mode Setting' for the required
mode.] Click the 'Next' button to continue. "*Mode Outputs" sets which pins are driven, "* Mode
Setting (High)" sets whether output pins are driven High (checked) or Low (Unchecked).

Notes: Setting the mode pins requires caution. Please confirm the pin settings with the hardware
manual even if a default setting is available. Note that in some devices, changing the mode pin
setting changes the maximum supply voltage.

Pin Settings |
Fleaze select the pin zettings
BOOT Maode  ysing Clock Mode INDNE YI
Operating Mode: [N =]
WA R MIMG: Incorect zettings may damage the hardware.
(1) Output O -
(2] GND .
(3] Output C
(4] Output &
(5] Txd
(6] GND
(7] Output B
(3] UYCC
(9) —
(10) GHND
[11] Rxd
(12] GND
(13) RESET
{14} UCONHECT
¢ Back I MHest > I Cancel

Figure 3-8 E8Direct Pin Settings

Output: T O B &
BOOT Maode
I Dutputs I_ I_ I_ I_ = 0=00
BOOT Made _
S etting [High] I I =000
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Pin Settings |
Please select the pin settings
BOOT Mode  using Clock Mode IHOHE "I
| | Operating Mode:  |[WEIRESg W= ~
WARNING: Incomect settings may damage the handware.
(1) Output O
(2] END
(3] Output ¢
o Oupt: C D B FE A
(8] Dutput E BOOT Mod
{7) owpur & S
(8] U¥CC
(9) U¥CC2 BOOT Mode -
E::; gum:put F Setting (High) r | I T I =000
(12] GND
(13] RESET
{14) UCONNECT
< Back et = Cancel

Figure 3-9 E8aDirect Pin Settings
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Pin Settings El

Flease select the pin settings

S BOOT Mode  using Clock Mode ICLISTOM "I

- Operating Mode: ILI: |ser Defined j

Output: o5 iod ind in? ol ol
o N i i i mil 2
BOOT Mode :
JOTede - F T T o

« Back Mest = Cancel

Figure3-10 EI1Direct Pin Settings
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Pin Settings El

Please select the pin settings

LA BOOT Mode  using Clock Mode ICLISTOM "I

- Operating Mode: ILI: |ser Defined j

Output: o5 iod ind in? ol ol
BOOT Mod

BOOT Mod -
Seﬂing{H?ghi - r r V-0

< Back Mext = Cancel

Figure3-11 E20Direct Pin Settings
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3.4.8 Reset Pin Settings

[Only if the E8Direct or E8aDirect is selected] Select the 'Operating Mode' and 'Clock Mode' and
if 'User Defined', set the Reset pin settings. Set the 'RESET Outputs' and the 'RESET Setting
(High)' for the mode required immediately after disconnection. Click the 'Finish' button. "RESET
Outputs' sets which pins are driven, "RESET Setting (High)" sets whether output pins are driven
High (checked) or Low (Unchecked).

Notes: Setting the mode pins requires caution. Please confirm the pin settings with the hardware
manual even if a default setting is available. Note that in some devices, changing the mode pin
setting changes the maximum supply voltage.

RESET Pin Settings |

Select the pin zettings required after a Disconnect RESET

RESET Mode  using Clock Mode [N ~

Operating Mode: ILI: Idzer Defined j
WARMIMG: Incomect settings may damage the hardware,

(1) Output O
(2] GND

(3] Output C
(4] Output &
(5] Txd

(6] GND

(7] Output B
(3] UYCC
9 —

(10) GHND
[11] Rxd
(12] GND
(13) RESET
{14} UCONHECT

Output: T
RESET
Qutpuits r

RESET

D B
I [ = 0x00
Setting [High) rr

[~ = 0=00

¢ Back I Finizh I Cancel

Figure3-12 ES8Direct RESET Pin Settings
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Mar 07, 2012

RESET Pin Settings |
Select the pin settings required after a Disconnect RESET
RESET Mode  using Clock Mode -
| | Operating Mode: II_I: |zer Diefined j

WARNING: Incomect settings may damage the handware.
(1) Output O
(2] END
(3] Output ¢
o Oupt: C D B FE A
(6] Dutput E RESET
{7) owpur & A e
(8] U¥CC
£10) outpe i I | Y %
o Setting {High)
(12] GND
(13] RESET
{14) UCONNECT

< Back I Finish I Cancel
Figure 3-13 E8aDirect RESET Pin Settings
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RESET Pin Settings x|

Select the pin settings required after a Disconnect RESET

‘*ilﬂ RESET Mode  using Clock Mode ICLISTO M "I
- Operating Maode:
..-:r,-
Output: o5 iod ind in? ol ol
RESET
Dutpu‘ts I_ I_ I_ I_ I_ |_=[hdI!
RESET -
Setting (High) I i r T M =od00

< Back I Finish I Cancel

Figure3-14 EI1Direct RESET Pin Settings
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RESET Pin Settings

x|

7,
e
T
5 ’-{‘
-

-
-

Select the pin settings required after a Disconnect RESET

RESET Mode  using Clock Mode ICLISTOM "I

Operating Mode:  [IRNES AN gz

Output: o5 iod ind in? ol ol
odpas | T T [ C-om

RESET -
Setting (High) I i r T M =od00
< Back I Finish I Cancel

Figure3-15 E20Direct RESET Pin Settings
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35 Configuring a Project for a Generic Boot Device

It isaso possible to connect to a Generic Boot Renesas Device - where you do not need akernel
or configuration file installed, instead FDT extracts the required information from the device itself.
Because of this, the device must be connected and set into Boot Mode at the time you create the
project. If a Generic Boot device is selected, then a series of screens appear displaying the results
of the inquiry functions, you will be required to make selections about the device and clock mode
(one boot program may be shared for multiple devices).

351 New Project Workspace

Enter the workspace name, then click the 'OK' button. (Specify whether or not adirectory isto be
created and alocation.)

Mew Project Workspace x|
Projects |

Workspace Mane
II ridustrial Costroler

e

"FI_'ITT:;:|:||-I': Eneraton

Project Mame:
II ndustnal Cortrader

Directone:
IE:'I.FDT “wimbkzpacesiindustnal Cortraller Browse. . I
CPL family:

T ool chain:

Il-l.l 1 LI

Properties. .

Ok I Cancel

Figure3-16 New Workspace
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352 Generic Boot - Choose Device and Kernel
(1) When using a device that does not support FINE communications

Select 'Generic Boot Device' (or a device supported by Generic Boot) and click 'Next'.

Choose Device And Kernel x|

The FLASH Development Toalkit supports a number of Benezas FLASH devices.

Select the device you wigh to uge with thiz project from the list below,

Filker:  |genenic

Type | Full Harne | K.ernel Yersion | Irfo
Frior Generic Device RA5FE1ER4 Y

Genenc BOOT Device  Genenc BOOT Device  MAA

1] | i

4 Back I Mext » I Cancel |

Figure 3-17 Generic Boot Device Selection

Note: Some Protocol C devices which appear in the device list are supported by using Generic
Boot. This means that when one of these devicesis selected in the Project Wizard, FDT
will behave asif "Generic BOOT Device" was selected, and will connect to the deviceto
obtain the device characteristics instead of using an existing fcf file for thisinformation.
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Choose Device And Kernel x|

The FLASH Development Toalkit supports a number of Benezas FLASH devices.

Select the device you wigh to uge with thiz project from the list below,

Filker:  |genenic

Type | Full Harne | K.ernel Yersion | Irfo

Has HES 20743F [Generic]  MAA Generic BOOT Devic
Has5 HE5/20243F [(Generic]  MAA& Generc BOOT Devic
5 SHA7083F [Genenc] N Generc BOOT Devic
SH SH/T084F [Generic] [{ e Generc BOOT Devic
SH SH/7085F [Generic] Y Generic BOOT Devio
SH SH/TOBEF [Generic] M A Generc BOOT Devic
SH SH/AT124F [Generic] I A Generic BOOT Devic
SH SH /71 25F [Generic] M A Generc BOOT Devic
Frior Generic Device RA5FE1ER4 Y

Genenc BOOT Device  Genenc BOOT Device  Mah

1] | i

4 Back I Mext » I Cancel |

Figure 3-18 Device Support via Generic Boot
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(2) When using a device that supports FINE communications

Select "ooxxxFINEx(Generic)' and click 'Next'.

Choose Device And Kernel

The FLASH Development Toolkit supports a number of Renesas FLASH devices.

Select the device you wish to use with this project from the list below.

Fitter: |FINE Cther...

T'_.fpe | FuII Mame | Kemel Version | Irfo

Giereric BUC L

2

ZEae, Next > Cancel |

Figure 3-19 Generic Boot Device Selection (FINE)
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3.5.3 Generic Boot - Communications Port

Select the port (and interface if available) from the drop-down list, then click the 'Next' button.

Communications Pork i

X|

IJze thiz page to select your desired communications

portfinterface. All zettingz may be changed after the project iz

created.

Select port; i

Select an Interface twpe to connect bo the target device with.
Marmally this will be "Direct Connection' or simply [eft blank.

Select Interface: [rrect Connection j

< Back I Mext = I

Cancel

Figure 3-20 Communications Port
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354 Generic Boot - E8Direct Pin Settings [E8Direct connection only]

If E8Direct is selected the following two screens will be shown. The first allows optiona power to
be supplied to the target board via the E8 (see also section 3.6.1)

Target Power Settings x|

[T Supply power from E3/EBasE1 to user tareet board.

— Pawer supply from EBSESa/El
Claay CENY

Cancel

—Information an the user-power supply
[T 18w

Be zure to 2elect this check o it user
power supply at 18 Wis to be provided.

[T Memorize the settines in this dialog box until the workspace closed.

Figure3-21 E8 Target Power Supply Selection

WARNING: Damageto thetarget device may occur if theincorrect voltage setting is chosen!

Thiswill be followed by the mode pin settings dialog, required to place the device into Boot
Mode. Click 'OK' to continue.
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Pin Settings ES

Flease t24 the pin values o connechon

C D B A
BOOT Mode <
il m [~ = 0400
BOOT Made -
Pt o i I~ =0400

WARNIMNG: Incomect zettings could damage pour hardwane
oF | Cancel

Figure 3-22 ES8Direct Generic Device Pin Settings

Note: Setting the mode pins using the E8Direct requires caution. Please confirm the pin settings
with the hardware manual even if a default setting is available. Note that in some devices,
changing the mode pin setting changes the maximum supply voltage.

If the E8 has not yet been restarted as an E8Direct device then the following messages will appear
inthe FDT output window:

Preparing for re-enunmeration of E8 to E8Direct...
Sendi ng re-enuneration comrand. ..
Request sent successfully, closing E8 Conms. ..

At the same time Windows® will re-enumerate the device (see also Chapter 13 - E8Direct).

When the 'Select USB Device' Diaog is displayed you must select which E8Direct unit isto be
used to set up the connection.
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x4
| 1 IS device located [ |

EGDIRECT - ( [Clocad e

Figure 3-23 Select USB Device
355 Generic Boot - E8aDirect Pin Settings [E8aDirect connection only]

If E8aDirect is selected the following two screens will be shown. Thefirst allows optional power
to be supplied to the target board via the E8 (see also section 3.6.1)

Target Power Settings x|

[T Supply power from ES/ESa/E1 to user target board.

— Power supply from EB/EBa/E1
g [

Cancel

— Information on the user-pawer supmly
[T 18w

Be =zure ta select this check box if user
power =upply at 18 Wis to be provided.

[T Memorize the zettings in thiz dialog box until the workspace cloged.

Figure3-24 Select Target Power

WARNING: Damageto thetarget device may occur if theincorrect voltage setting is chosen!

Thiswill be followed by the mode pin settings dialog, required to place the device into Boot
Mode. Click 'OK' to continue.
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Pin Settings

Pleaze zet the pin values for connection ;

E D B F E A
Pirn Outputs [ ] FlEr] = =81
Pin Setting ] - 0w

WARMIMNG: Incarect settings could damage your hardware

2k, l [ Cancel

Figure 3-25 ES8aDirect Generic Device Pin Settings

Note: Setting the mode pins using the E8aDirect requires caution. Please confirm the pin settings
with the hardware manual even if a default setting is available. Note that in some devices,
changing the mode pin setting changes the maximum supply voltage.

When the 'Select USB Device' Dialog is displayed you must select which E8aDirect unit isto be
used to set up the connection.

Select USB Device X

1 USE device located

LCancel

=
—

Figure3-26 Select USB Device
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35.6 Generic Boot - E1Direct Pin Settings [E1Direct connection only]

If E1Direct is selected, the following two screens will be shown. The first allows optional power
to be supplied to the target board via the E1 (see also section 3.6.1).

Target Power Settings x|

[T Supply power from E3/EBasE1 to user tareet board.

— Pawer supply from EBSESa/El
Claay CENY

Cancel

—Information an the user-power supply
[T 18w

Be zure to 2elect this check o it user
power supply at 18 Wis to be provided.

[T Memorize the settines in this dialog box until the workspace closed.

Figure 3-27 Select Target Power

WARNING: Damageto thetarget device may occur if theincorrect voltage setting is chosen!

Thiswill be followed by the mode pin settings dialog, required to place the device into Boot
Mode. Click 'OK" to continue.
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x

Flease zet the pin values for connection :

fala) o4 iod a2 ol el
Fin Qutputz [ m [ [ [ =n0«00
fnSSi . © ¢ N i Y %

WHRMNING: Ihcorrect settings could damaee wour hardware

Cancel |

Figure 3-28 E1Direct Generic Device Pin Settings

Note: Setting the mode pins using the E1Direct requires caution. Please confirm the pin settings
with the hardware manual even if a default setting is available. Note that in some devices,
changing the mode pin setting changes the maximum supply voltage.

When the 'Select USB Device' Dialog is displayed you must select which E1Direct unit isto be
used to set up the connection.

Select USB Device x|

| 1 USE device located

E1: QHMO3TT

Figure3-29 Select USB Device

357 Generic Boot — E20Direct Pin Settings [E20Direct connection only]

Selecting E20Direct opens the mode pin settings dialog box. Make the settings that are required to
place the device into Boot Mode. Click on 'OK' to continue.
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x

Flease zet the pin values for connection :

fala) o4 iod a2 ol el
Fin Qutputz [ m [ [ [ =n0«00
fnSSi . © ¢ N i Y %

WHRMNING: Ihcorrect settings could damaee wour hardware

Cancel |

Figure 3-30 E20Direct Generic Device Pin Settings

Note: Setting the mode pins using the E20Direct requires caution. Please confirm the pin settings
with the hardware manual even if a default setting is available. Note that in some devices,
changing the mode pin setting changes the maximum supply voltage.

When the 'Select USB Device' Dialog is displayed you must select which E20Direct unit isto be
used to set up the connection.

select USB Device x|

| 1 USE device lozated

E20: 0GMOo1

Figure 3-31 Select USB Device
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3.5.8 Generic Boot - Confirmation

FDT then waits for you to confirm that the device is connected and powered. FDT will try to
connect to the device when you click 'OK'.

FLASH Development Toolkit i x|

_."' FOT wall now 2tbempt ko conmect bo vour generic device.
.

Please ensure the board is connected, powered and in Boot mode,

Figure3-32 Generic Boot Confirmation

After this, FDT displays adialog that displays the boot progress. At various points during the
Generic Boot process, the user isrequired to select or confirm details of the device; see below for
detalls.
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359 Generic Boot Select Device

Because some devices share a boot program, alist is provided of all those supported. The user
should select the correct device from the list then click 'OK".

i
% | The FLASH Develonment Toolki suppors connection thifouat
Mime.| Jucry Generic Device N 3¢| )i pageto
Wﬁ:ﬁ.‘t - : Ay be
o : I
= D v  Booling Device
Gy " Sending Suppoited Devices Inguiry.
Selecting Device
2 EE Sending Clock Mode Inoury. . e v ith,
L it blank,
itk Selecting Clock Mode
Sending Othes |nguines
e Lot i | Cangel |
F
§ Cancel
Select a device : |HDE4F7058 = 3

IT] Cancel I

Figure 3-33 Generic Boot Device
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3.5.10 Generic Boot Select Clock Mode

Because some devices have anumber of Clock Modes, alist is provided of al possible Clock
Modes. The user should select the correct Clock Mode from the list then click 'OK'. Please check
with the hardware manual / target board manual to ensure that the correct mode is chosen.

|
% I The FLASHDevemn'm ToolkR Suppors connection throuat
— x| 5 e to
m W = may be
3 &lo +  Buooling Device
j L v Sending Supported Devices Inguiry. _.
' +"  Salecting Device HDE4FTEE
|=E0g N S e Elack M g ice with,
| e It blank,
| == Selecting Clock Mode
|
r Sending Dthes |nquiries
_.j_ J J Cancel |
|
Cancel |
Select a clock mode - ID j
ak. I Cancel l
Figure 3-34 Clock Mode
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3511 Generic Boot Setup Complete
Having selected the Clock Mode, the Generic wizard completes as bel ow.
] x|

Query Generic Device

+  Booting Device

+  Sending Supported Devices Inquiny...

+'  Selecting Device HDB4FT0SE
v+ Sending Clock Mode Inquiry. ..

+"  Selecting Clock Mode 0

+  Sending Dther Inquiries

0K Cancel

Figure 3-35 Generic Boot setup complete

Dependent on device support, FDT may also require ID code confirmation at this point. If thisis
necessary then adialog will be shown to allow the ID code to be input (in Hex bytes):

ID Check x|

ID Code

High 8 Bytes: [0123456789abCDEF
Low § Bytes:  |1234ABCDEF000000

Cancel |

Figure 3-36 ID Check dialog

Clicking 'OK" will confirm the ID code and on success the Project Wizard will then continue
through the remaining pages. Clicking 'Cancel’ will abort the connection process.

R20UTO508EJ1100 Rev.11.00 < RENESAS Page 57 of 216
Mar 07, 2012



Chapter 3 Using FDT

Notes: 1. For deviceswith an 8-byte ID code, enter OxFF in each byte of ‘High 8 Bytes' or leave
it blank.

2. If the value entered has less than 8 bytes, the FDT will automatically pad the value
with OXFF from the | eft.

3. If the device has a control code, enter this value asthe first of the valid bytes.
Example 1
When the number of valid bytes = 16, control code = H’'45, and ID code = H’' 010203,
H’ 04050607, H' 08090A 0B, H' OCODOEOF-:
‘High 8 Bytes': 4501020304050607
‘Low 8 Bytes': 08090A0BOCODOEOF
Example 2
When the number of valid bytes = 8, control code = H’45, and ID code = H’ 010203,
H’ 04050607:
‘High 8 Bytes': FFFFFFFFFFFFFFFF
‘Low 8 Bytes': 4501020304050607

3.5.12 Generic Boot Device Settings
Please Refer to Section 3.4.4
3.5.13 Generic Boot - Connection Type
Please Refer to Section 3.4.5
3.5.14 Generic Boot Programming Options
Please Refer to Section 3.4.6
3.5.15 Generic Boot Reset Pin Settings
Please Refer to Section 3.4.8
35.16 Generic Boot Reinterrogate on connect option

'‘Reinterrogate on Connect' on the 'Programmer’ tab of the 'Flash Properties dialog allows the user
to configure whether FDT should reinterrogate the Generic device on each connection. The default
is set to 'No', so after a connection has been established once, FDT re-uses the data collected from
theinitial inquiry functions. If this option is changed to 'Y es, FDT will interrogate the device for
the device details each time it connects in Boot Mode. This means that one Generic Boot project
will work with any Generic Boot Device.
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3.5.17 Prior Generic Device

Selection of the 'Prior Generic Device' device alows a connection to the last device configured
using 'Generic Boot Device'. It usesthe .fcf file which was generated when first connecting using
'Generic Boot Device' (however, this facility is not usable under the Windows Vista® or Windows”
7 operating system).
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3.6 Connecting to the device

Thisisachieved by selecting the Device- >Connect to Device menu item, using the Ctrl-Alt-C
hotkey, or clicking the Connect toolbar button. If aflash operation (Upload, Download, Blank
Check, Checksum etc) is selected before a connection is established, FDT will automatically
perform a connect operation first.

36.1 E8\E8a\E1 USB Connection

When connecting for the first time since opening the workspace, and using the EB\ES8a\E1 USB
interface board, adialog will be displayed to allow selection of whether the board should supply
power to the target, and at which voltage level. The selected power level will be supplied to the
target device when connecting and switched off when disconnecting. The power level selection
will be remembered until the workspace is closed. The setting in this dialog can also be modified
in the ‘ Target Power’ section of the ‘ Communications' tabbed page of the 'Project Properties
dialog box.

Target Power Settings x|

[T Supply power from ES/ESa/E1 to user target board.

— Power supply from EB/EBa/E1
g [

— Information on the user-pawer supmly
[T 18w

Be =zure ta select this check box if user
power =upply at 18 Wis to be provided.

[T Memorize the zettings in thiz dialog box until the workspace cloged.

Figure 3-37 E8\E8a\E1 Target Power Supply Selection
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e  Supply power from E8/E8a/E1 to user target board:
When this check box is selected, either 3.3V or 5.0 V can be selected.

e Information on the user-power supply:
This check box can be checked when 1.8-V programming is supported and when * Supply
power from E8/E8a/E1 to the user target board’ is not selected. Also, for the user-power
supply voltage, refer to the additional document, ‘ Precautions on Using Flash Development
Toolkit'.

e Memorize the settingsin this dialog box until the workspace closed:

When this check box is selected, the selected setting is remembered until the workspace is
closed (or the FDT session is terminated).

Notes: 1. The target device may be damaged if an incorrect voltage setting is chosen or if the
1.8-V user power supply is applied without selecting the ‘ Information on the user-
power supply’ check box.

2. The E20 cannot supply power to the target device.
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3.6.2 ID Check Dialog

Devicesthat support the ID checking function are capable of verifying datainput to the ID check
dialog box against the ID stored in the device. Aswell asinput to the fields, the mot or ID file can
be selected by the "Browse..." button. This dialog box can also be set in the 'Auto Send ID' section
of the 'Communication' tabbed page of the 'Project Properties dialog box.

ID Check ]|

D - |'|'| |'2'2 IEE |44 IEE IEE I_."_." Browse. |
¥ Enable sutomatically verfying I0: OK I Cancel |

Figure 3-38 1D Check Dialog

e Enableautomatically verifying ID

When this check box is not selected, the dialog will be displayed every time the connection is
made (however, it will not be displayed if the ID code has already been checked.)

3.6.3 Locking

For devices which support locking of erase blocks FDT may aso check with the user whether to
unlock the device. Thisis dependent on the current locking settings (see more on thisin the
Locking Connection section).

Flash Development Toolkik |

D The device reports ane or more erase blocks are currently locked

2)

Should FOT kemporarily disable this locking ko allow erase and program?

Yes Mo

Figure 3-39 Locking Query Dialog
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3.7 Programming the Data to the FLASH ROM

371 Programming an individual fileto the User Area (normal flash area)

1. Select [Project- >Add Files...] or pressthe INS key to add the file to be downloaded to the
project.

2. Click the right mouse button on the file displayed in the workspace window, and select
‘Download File'. Programming will be completed when ‘Image written to device' is displayed
in the output window.

3.7.2 Programming multiple filesto the User Area (normal flash area)

1. Add all therequired target files to the project by selecting [Project- >Add Files...] or pressing
the INS key. Note that multiple files can be added at once from the * Add File(s)’ diaog.

2. Build the device image for the User Area (create afile which is the result of merging all of the
included target files) by selecting the menu item:

[Project- >Rebuild Image]

3. Click the right mouse button on the Device Image file (<ProjectName>.ddi) displayed in the
workspace window, and select ‘ Download Image’ (or select the menu item
[Project- >Download | mage])

4. Programming is complete when ‘Image written to device' isdisplayed in the output window.

3.7.3 Programming an individual fileto the User Boot Area

1. Select [Project -> Add Files...] or pressthe INS key to add the file to be downloaded to the
Project.

2. Click the right mouse button on the file displayed in the workspace window, and select * User
Boot Flash’ to mark thisfile as being for the User Boot Area

3. Click the right mouse button on the file displayed in the workspace window, and select
‘Download Fileto [User Boot Flash]'. Programming will be completed when ‘Image written
to device' isdisplayed in the output window.
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374 Programming multiple filesto the User Boot Area

1. Add dl therequired target filesto the project by selecting [Project- >Add Files...] or pressing
the INS key. Note that multiple files can be added at once from the ‘ Add File(s)’ dialog.

2. Click the right mouse button on each file displayed in the workspace window which is destined
for the User Boot Area, and select ‘User Boot Flash’ to mark it as being for the User Boot
Area

3. Build the device image for the User Boot Area (create a file which is the result of merging all
of the included target files) by selecting the menu item: [Project- >Rebuild | mage]

4. Click the right mouse button on the Device Image file (<ProjectName>.ddi) displayed in the
workspace window, and select ‘ Download Image’ (or select the menu item [Pr oj ect-
>Download I mage] )

5. Programming is complete when ‘ Image written to device' isdisplayed in the output window.

375 Programming some filesto the User Area and other filesto the User Boot Area

1. Add dl therequired target filesto the project by selecting [Project- >Add Files...] or pressing
the INS key. Note that multiple files can be added at once from the ‘ Add File(s)’ dialog.

2. Click the right mouse button on each file displayed in the workspace window which is destined
for the User Boot Area, and select ‘User Boot Flash’ to mark it as being for the User Boot
Area

3. Build the device image for the User Boot Area (create a file which is the result of merging all
of the included target files) by selecting the menu item: [Project- >Rebuild | mage]

4. Select the menu item [Project- >Download | mage] )

5. Programming is complete when ‘ Image written to device' isdisplayed in the output window
for both the User Area and the User Boot Area

3.7.6 Note on Programming Checksum

For those devices which support this feature, FDT will perform a CRC based checksum
immediately after a programming run. The CRC for the file will be compared to the CRC of the
programmed data and the result echoed to the Output Window. Any mis-match will be reported as
an error.

The CRC calculation is based on the CRC16-CCITT algorithm and covers the range of the
programmed area (assuming an initial value of OxFFFF and a final reverse of the result).
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3.8 Erasing Data from the FLASH ROM

1. Select [Device -> Erase FLASH blocks...] to display the 'Erase Blocks' dialog box.
2. Select the block(s) to be erased. (When the checkbox is ticked, the block is selected.)*
3. Click the 'Erase' button to start erasure.
4. When 'Erase complete' is displayed in the output window, erasure is completed.
Erase x|
Tree I
Redion | Stark | End | Size | Wwrithen | Locking | Frotection Select Al
& [F] RSF21123
E| [ User Flash _ 0x00000000  Dx0D00FFFF _ St wiien
B Unkniown /8
- 0¥0000E000 OxO000FFFF 8K Unknown
E| @) Data Flash  0x00002000  DxDD002FFF
--[Z]EBA  0x00002000 Ox000027FF 2K Unknown
“[JEBE  0x00002800 OxOOO02FFF 2K Unknown
[dpload Erase Cancel

Figure3-40 Erase Blocks

Note: * Toeraseall blocks, clicking the 'Select All* button will tick every available check box.
To erase al non-blank blocks, clicking the 'Select Written' button will tick every
associated check box. Ticking the box of a parent item will toggle the state of all child
items. A greyed check-box indicates that only some of the child items are ticked.
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39 Uploading the FLASH ROM Data

1. Display the 'Upload Image' dialog box from [Device -> Upload Image...].
either

2. Select the Address tab

3. Enter the start and end addresses, or the start address and length.

4. Click the 'Upload' button to start reading.
or

5. Select the Treetab

6. Select the blocks to be uploaded (corresponding to the erase blocks and\or the device flash
areas).

7. Click the 'Upload' button to start reading.

Note: When FDT is started in boot mode, the flash memory data has normally already been
erased (depending on the kind of device).

x
Tree  Addiess |

User Flast Start Address:

Lser Flash

User Boot Flash Im
End Address:
IDx?ffff
Length:

Start Address = 0x00000000 ngaggnu

End Addresz = 0:0007FFFF

Size = 512K
V¥ &bsolute Image

Upload I Erase Cancel

Figure 3-41 Upload Image Dialog - Address
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Upload

I Address I

Region

| Start

| End

| Size | Written

| Lucklng

- [#] ser Flash
- [#] EED

- [#] EB1

- [#] EBZ

- [w] EBZ
-5_

[55]

b= P

o oo oo ooh
S

AAERAEAERAREIARS

ko
Lrkromwn
Urkerown
Lrkromwn
Urkerowen
ko
[
ko
Lrkromwn
[ —
Lrkromwn
Urkerowen
ko

B8N HD64F3069

[

]|

Select Al

Select Written

¥ Absolute Image

Upload I

LErese

| Cancel

Figure 3-42 Upload Image Dialog Tree

Note: The Upload via erase block has the same selection functionality as the Erase block dialog
itself, i.e." Select All" will check every block (a complete device upload) and 'Select
Written' will check the non-blank blocks (an upload of programmed areas).

When 'Upload operation complete' is displayed in the output window and the uploaded datais
displayed in the hex editor, reading is complete.

If the user specifies an Absolute image, the uploaded data will be placed in an image the size of
the FLASH memory at the same address it was uploaded from. Use an Absolute Image if the
uploaded data needs to be added to the project. It is not possible to upload a region outside of the
FLASH into an Absolute Image.

After asuccessful upload FDT will automatically display the checksum of the uploaded data into
the output window. Thiswill be in the form of araw checksum, i.e. asimple 32 bit addition of the
byte values within the upload. If more than one flash areais uploaded then separate checksum
results will be given for each area. (For other checksum options see the main FLASH Checksum

operation, the file checksum operations, or the Checksum Tab on the Data File Properties window)
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3.10 Performing a Blank Check

For kernels which support it, a blank check can be performed by selecting the ‘ Device- >Blank
Check’ menu item. Thiswill perform ablank check on al available device areas (e.g. User and
User Boot).

3.11 Disconnecting from the device

Thisis achieved by selecting the ‘ Device- > Disconnect’ menu item, or clicking the Disconnect
toolbar button.

312 SavingaWorkspace
When the [File -> Save Wor kspace] menu option is selected, the FDT workspace can be saved.
3.13 Closing a Workspace

Select [File -> Close Workspace] to close the FDT workspace. If the workspace or its project has
changed, a dialog box asks if the user wishes to save the project. Select “Yes’ if the workspace is
to be saved, “No” if the workspace is not to be saved, and “Cancel” to return to the workspace. If
you are prompted to save the session, then select “Yes’. These prompts can be switched on and off
by changing the setting in the Workspace tab of the [T ools -> Options] dialog.

3.14  Exiting FDT

To exit FDT, select [File -> Exit], pressthe Alt + F4 key, or select the * Close’ option from the
system menu (the system menu can be opened by clicking the icon in the upper-left are of thetitle
bar).
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Chapter 4 Wait For Script

4.1 Wait For Script Overview

Thismode allows FDT to be automated and controlled by atext file containing a script of
commands. Once in thismode FDT acts as a server which polls for the existence of afilein a
predetermined location. Once thisfileisfound, FDT executes each command in order and can
then optionally delete or move the script file upon completion, so that FDT is ready to look for the
next script file. Thisallows FDT to connect, program, erase, blank check etc, under the control of
an external application, viathe use of asimpletext file.

The messages in the output window can optionally be echoed to alog file for later analysis and
traceability. Additionally, a status file can be created, which holdsinformation about the state of
the current and previous script processes. This status file can be used by the external application to
determine whether the script has been processed successfully.

To set up FDT Wait For Script, a configuration file needs to be created to specify the search path
for the script file and other parameters such as the settings for the log and status files, and how to
handle errors.
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4.2 Wait For Script —New Configuration
Thisisinvoked from the Tools, Wait For Script, New Configuration... menu.

42.1 Script File Page

Wait-For-Script Configuration il

Script File | Log File | Status File | Enor Handing |

Dezcription:

'r'ou can tppe a description for thiz configuration here...

— Script file Settings
File... |
Script Path: I
Wwildcard... |
Fall for file every: I 1000 _I; milliseconds
YWhen found, wait: 100 _:I milliseconds before executing file

Save I Cancel

Figure4-1 Script File Page
Thisisthe only essential page in the wait for script configuration.
4.2.1.1. Description

Thisisan optional text description that may be used to describe, e.g. who created the file, why it
was created, what it does, etc. It is not used in any way, other than for display.

4.2.1.2. Script Path

Thisisthe only mandatory field. This edit box allows the user to set up where to find the script file
to run. This can either be a specific file (e.g. c:\Scripts\MyScript.fsf) or a directory and wildcard
combination (e.g. c:\Scripts\* .fsf).

The File... button to the right of the edit field invokes browse dialog to allow the user to navigate
to the file they want to use. The Wildcard... button to the right of the Wildcard edit field invokes a
standard Windows directory selection dialog. If adirectory is chosen from this dialog then a
trailing \*.fsf (fsf is the default script extension) will also be appended to the path as a convenience
to the user. Thisfield can also be edited manually.
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4.2.13. Timings

Thisallows user control over how often FDT polls for the script file and how long FDT should
wait before processing, after finding the script file and having accessto it.

4214. Save

This savesthe FDT Script Configuration file (with the default extension .w4f). FDT will prompt to
ask if you want to execute the saved script immediately.

4.2.2 Log File Page

Thisisan optional page; leave the fields blank if nolog fileis required. It can either append to or
overwrite existing files

Wait-For-Script Configuration 5[

Script File  Log File | Status File | Errar Handlingl

Log File Directony: I Browse... |

Log File Mame: I
If File Exists: @ Append ¢ Overwrite
Walid Delimiters
% = User Hame %0 = Senipt Execution Duate %% =The X zign
%M = Machine Name T = Script Execution Time

Save I Cancel

Figure4-2 Log File Page
4.22.1. LogFileDirectory

Enter the directory that the optional log file should be created in. FDT can insert additional details
into the directory path such asthe user name, machine name, date or time by using the %U, %M,
%D and %T delimiters.

4.222. LogFileName

Enter the name of the optional log file. FDT can insert additional details into the file name such as
the user name, machine name, date or time by using the %U, %M, %D and %T delimiters.

R20UTO508EJ1100 Rev.11.00 < RENESAS Page 71 of 216
Mar 07, 2012



Chapter 4 Wait For Script

4223. Save

This savesthe FDT Script Configuration file (with the default extension .w4f). FDT will prompt to
ask if you want to execute the saved script immediately.

4.2.3 Status File Page

Thisis an optional page; leave the Enable status output to file checkbox unchecked if no statusfile
isrequired. See section 4.7 for details of the contents of the statusfile.

Wait-For-Script Configuration 5[

Seript FiIeI Log File  Status File I Errar Handlingl

Status File Directomny: I Browse... |

Status File Marme: Islatus.txt

Walid Delimiters
|7 %U = User Name %M = Machine Mame

Save I Cancel

Figure4-3 StatusFile Page
4.2.3.1. StatusFileDirectory

Enter the directory that the optional status file should be created in. FDT can insert additional
details into the directory path such as the user name and machine name by using the %U and %M.

4.2.3.2. StatusFile Name

Enter the name of the optional statusfile. FDT can insert additional details into the file name such
as the user name and machine name date or time by using the %U and %M delimiters.

4.2.33. Save

This savesthe FDT Script Configuration file (with the default extension .w4f). FDT will prompt to
ask if you want to execute the saved script immediately.
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4.2.4 Error Handling Page

Thisisan optional page.

Wait-For-Script Configuration 5[

Seript Fie | Log File | Status File  Eror Handiing

On Script Fail " #hork " Continue " Run Script

Brawsze. . |

Save I Cancel

Figure4-4 Error Handling Page
4.24.1. On Script Fail

Abort - leave the On Script Fail radio button set to the default Abort to cause FDT to abort
processing of further scripts upon encountering an error.

Continue - allows FDT to ignore the fact that the error occurred and continue processing further
scripts.

Run Script - forces FDT to process an error handling script upon encountering an error. The script
file to execute on script fail can be entered in the input box manually or by using the browse
button. Typically afail script may contain the disconnect command, an alert command and the
abort command.

# Script processing failure handling script exanple 1

# Di sconnect to allow reconnection
Di sconnect

# Display a nmessage to the user

khkhkkhkhkhkhkhkhhkdhhhhhhdhdhhhhhdhhdbhhhhdhhdhhhhdhhdhdbhhdrhrdhdbhrhhhdrhrdhrhhrhdhdxx
Al ert output|

Alert output|*********x THE CURRENT SCRI PT PROCESSI NG HAS FAI LED ****%%*x*sksxx
Alert out putl******************************************************************
Alert output|** The script which was being processed will now be del eted. **

Alert output|** Please reset the board and regenerate the script to retry **
Alert OUt putl******************************************************************
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# Delete the script file which failed
# so that FDT will wait for it to be regenerated before retrying
del ete $script

# Script processing failure handling script exanple 2

# Di sconnect to allow reconnection
Di sconnect

# Display a nmessage to the user

R R R R R R R
Al ert output|

Al ert output|******xxx** THE CURRENT SCRI PT PROCESS| NG HAS FAI LED **** %%k % kok sk %

AI ert out put | EREEEEEEEEEEEEEEEEEEEEEEEEREEREEEEREEEEEEEEESRESRERERESEEEEREEEEESEEEESESSE]

Alert output|** Wait For Script Processing will now be aborted *x
Alert output|** To retry, use Tools, Wit for Script, **
Alert output|** Run configuration... and select the configuration **

AI ert out put | EEEEEEEEEEEEEEEEEEEEEEEEEEEREEEREEREEEEREREERERERERESREREREEEEESEESEESEESESE]

#Stop script processing
Abor t

4.2.4.2. Save

This savesthe FDT Script Configuration file (with the default extension .w4f). FDT will prompt to
ask if you want to execute the saved script immediately.
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4.3 Wait For Script — Edit Configuration...

Thisisinvoked from the ‘ Tools', ‘Wait For Script’, ‘ Edit Configuration...” menu and allows you
to edit the configuration settings for a given configuration file.

4.4 Wait For Script Run Configuration...

Thisisinvoked from the Tools, Wait For Script, Run Configuration... menu and allows the user to

browse to select the desired Wait For Script Configuration file (w4f). FDT then enters Wait For
Script mode:

*# test - Flash Development Toolkit

10/
Fle Edt View Project Took Window Device Help
dszalg|m Frnas|rllorsrzcaels]
[Detautt =l |[oetat == HJ & 8w |
=
=]
I test

'Wait For Script
Seript Path : |E:¥_FDT seiptsgtest faf

Stalus Path ||: ¥_FDT soripts¥ abel tst

Configuration: [ione
Desciiption

Click to Catcel
N & Projects
| Waiting ;I
7|/ [File Opened: "C:¥_FDT scripts¥test.fsf (Last Modified: 13-Apr-06 16:11:58)

[FDT1test 4 FindinFiles /

|Defaultl desktop | == — S [ m
Figure4-5 Wait For Script execution

Ready
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4.5 Wait For Script — Script Commands

A script file is nothing more than atext file containing a series of commands that FDT will
recognise, one per line. Each command may also have a series of arguments associated with it, on
the same line. By default these script fileswill have a“ .fsf” extension.

The syntax for a script line is the command, followed by a space, followed by required arguments
(separated by the ‘| operator). Optional extra arguments follow these, and can be placed in any
order.

Normally a script file should end with the ‘delete $script’ command. This causes FDT to delete the
script once processing is finished, thus preventing the same script file being processed more than
once. FDT will then start looking for the next script file. Alternatively the move command could
be used to move the script file to an alternative directory once completed

Each script command should be written on a separate line of the text file; FDT will cope with
DOS and UNIX styleline breaks (CR or CR LF). File paths within the script file can include drive
letters or network paths (including | P addresses).

45.1 Workspace

Description = loads a specified workspace into FDT (Note: avalid workspace and configured
project must be opened to use any of the device-related commands)

Arguments:

<Workspace Path> Required The path to the workspace

Example:
Workspace C:\Workspaces\3069serial\3069serial AWS

NB: FDT will use the active project from this workspace — there is currently no facility for
changing which is the active project from the script
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4.5.2 Connect
Description = connect to a device

Arguments:

<PORT> Optional | If the port specified does not
match the project port
settings the command will
fail. For USB Direct, ES,
E8a, E1, E20, E8Direct,
E1Direct, and E20Direct
connections this must be set
to “USB".
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When <PORT> is |“USB”|<USB PID>|<USB BID> Optional | When using USB Direct it is
“UsB” (Oneof) |possibleto pre-empt the
Select Device connection
dialog normally seen with
these settings.
“USB"|"E8"| If using E8, E8a, E1, E20,
<USBID>| E8Direct, E8aDirect,
<CONNECT VOLTAGE>| E1Direct, or E20Direct the
<DISCONNECT VOLTAGE> unique ID of the device, the
“USB"['E8d| initial connection volt_age and
<USBID>| the\{oltaget(_) beappll_edat
<CONNECT VOLTAGE> | *! theti mg pf disconnection can
<DISCONNECT VOLTAGE> be specified. (NB — currently
supported voltage values are
“USB"|'EL"| “5.0",“3.3" or “0.0")
<USBID>|
<CONNECT VOLTAGE>| **
<DISCONNECT VOLTAGE>
“USB”|"E20" |
<USBID>|
<CONNECT VOLTAGE> **
<0.0>
“USB"|"E8Direct’|<USB ID> |
|< CONNECT VOLTAGE> |
<DISCONNECT VOLTAGE>
“USB”|"E8aDirect”[<USB ID>| Notes **:
<CONNECT VOLTAGE>| When the device supports
<DISCONNECT VOLTAGE> 1.8-V programming and 1.8
“USB"['ELDirect’|<USB ID> | V isbeing supplied from the
<CONNECT VOLTAGE>| user power-supply, be sure to
<DISCONNECT VOLTAGE> specify “Userl.8" asthe
<CONNECT VOLTAGE>,
“USB”|"E20Direct”|<USB ID>| otherwise, damage to the
<0.0>| target device may occur.
<0.0>
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Note that the connection will only be attempted with the project port setting and not to change the
port used to connect. Specification of the port in this command is only to force afailureif the
project does not match this setting, and to suppress the Select Device connection dialog for USB
devices by allowing it's unique identifier (e.g Serial number) to be preselected.

The unique identifier for the USB style device will vary depending on device type. For example,
an E8 will requireit's instance number but an E8Direct will require a serial number (this can be
confirmed in the Select Device connection dialog box). An E8a, an E1, an E20, an E8aDirect, an
E1Direct, or an E20Direct also require a serial number (this can also be confirmed in the Select
Device connection dialog box).

(See also the 'ID' command for specifying the ID code of the device at connection)
Examples:

Connect

Connect COM1

Connect USB|0x000D|0

Connect USB|E8|0001/5.0/0.0

Connect USB|E8a|6J5999999]5.0/0.0

Connect USB|E8a|6JS999999|User1.8/0.0
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453 Download

Description = download the selected project image to the device

Arguments:

“image’ Required (One of) | Download the device image

<filename> Download the named file

“user” Required (One of) | Download to the User/Data/lE2Data area

“userboot” Download the user boot image\Download to the user boot
area. This can aso be used to download to the User Area.

“both” Download the user and user boot image (only valid when
specifying “image”)

“norebuild” Optiona Don't rebuild the image(s) before downloading, even if they
are out of date (only valid when specifying “image”)

“verify” Optiona Perform areadback verify when the download completes (not
available when using Protocol E)

Example:

Download imagejuser|norebuild|verify

Download C:\files\My Srecord.mot|userboot

454 Erase

Description = erase specified flash blocks on the device (not available when using Protocol E)

Arguments:
<block num(s)> Required (One of) A list of block numbersto erase
(block numbers are only
specifiable as decimal numbers)
<block name(s)> A list of block namesto erase
“written” Erase all blocks currently marked
aswritten
“device’ Erase the entire device
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Example:
Erase O|1/4|7
Erase EBO|EB1|EBA|EBB

Erase device

455 BlankCheck

Description = check if the device is blank (not available when using Protocol E)

Arguments:
“user” Optional TellsFDT to check the user area
(Oneof) of flash
“userboot” Regired when * stoponwritten’ TellsFDT to check the user boot
f fl if t

or “stoponblank” is specified areaof flash (if supported)

“data’ TellsFDT to check the data area
of flash (if supported)
“stoponwritten” Optional Stop processing the script if the
deviceis not blank
“stoponblank” Optional Stop processing the script if the
deviceisblank

Example:
BlankCheck

BlankCheck userboot|stoponwritten
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45.6 Upload

Description = upload data from the device (not available when using Protocol E)

Arguments:

<filename> Required File to write the upload out to — will be created or overwritten if
necessary. If not needed, specify “none’

<start address> Required Start address in Hex to start the upload from

<length> Required Number of bytes (in Hex) to upload

“noabsolute’ Optional Assign the start address of uploaded data to 0x00

“userboot” Optiona Upload from the user boot area or the data area (if supported)

Example:

upload nonel0]0x6000

upload c:\upload\upl oadtest.mot|0x100]0x200|userboot|noabsol ute

457 Checksum

Description = perform a checksum on a device (not available when using Protocol E)

Arguments:

“device’ Required Checksum the device |
Example:

Checksum device
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45.8 Disconnect

Description = disconnect from a device. Note that issuing of a disconnect command even if FDT is
not connected is allowed. This can be useful for ensuring that FDT is disconnected before a
connect operation. (Note that this option is not valid for COM based connections).

Arguments:

“reset” Optional TellsFDT to perform areset as
part of the disconnect

Example:

Disconnect

Disconnect reset

4.5.9 Rebuildlmage

Description = rebuild the specified image from the project target files

Arguments:

NONE - -

Example:

Rebuildimage
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45.10 # Comment

Description = placed at the start of aline, this symbol comments out the rest of the line

Arguments:

NONE - -

Example:

# thisismy commented line

4511 Alert

Description = indicate to the user that something has happened

Arguments:

“beep” Required (One of) |FDT will output awarning beep

“output” FDT will output a message on the active project tab
Example:

Alert output|Please make sure the board is connected

4512 Pause

Description = this command will pause script file execution for the specified number of
milliseconds

Arguments:

<time> Required Number of milliseconds to pause for

Example:

Pause 2000
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4513 Delete

Description = deletes the script file. NB: FDT will process the script no further than thisline

before deleting it

Arguments:

“$script”

Required

Delete the script file

Example:

Delete $script

4514 Move\ Copy

Description = move or copy the script file.

NB: FDT will process the script no further than this

line

Arguments:

“$script” Required Copy\move\rename this script file
<filename> Required Thefile\directory the sourcefileisto be
<directory> copied\moved\renamed to

Example:

Move $script \\server\networkfiles\done.txt

Copy $script|C:\backups\
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45.15 Abort

Description = stop processing the script and return failure. NB: This command is primarily
designed to be used in an error processing script

Arguments:

NONE - -

Example:

Abort

45.16 L ock

Description = lock specified flash blocks on the device or set the device master lock bit (not
available on devices which don't support erase block locking)

NB: The device master lock bit must be unlocked (with 'Unlock device') before individual blocks
can be locked (see "Unlock” below).

Arguments:

<block num(s)> Required (One of) A list of block numbersto lock

“written” Lock all blocks currently marked as written

“device’ Sets the master device lock bit

Example:

Lock O[1/4[7

Lock device
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45.17 Unlock

Description = unlock specified flash blocks on the device or disable the device master lock bit (not
available on devices which don't support erase block locking)

NB: The device master lock bit must be unlocked (with 'Unlock device’) before individual blocks
can be unlocked.

Arguments:

<block num(s)> Required (One of) A list of block numbers to unlock

“written” Unlock all blocks currently marked as written
“device’ Disables the master device lock bit
Example:

Unlock device

Unlock 0|1[4(7

4518 Exit

Description = stop processing the script and exit FDT

Arguments:

NONE - -

Example:

Exit
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4519 ‘ID’

Description = Specify an ID code which will be compared with the ID code of target device
(where supported). Note: This command must be executed before the 'Connect’ command

Arguments:
<size> Required Specify the size of the ID code.
R8C, M16C, M32C, R32C and 740 devices. 7
Generic Boot devices: 16
NB: If <size> isset other than 7 or 16, FDT will error
<ID code> Required ID code - must bein hexadecimal form and match the
supplied <size> parameter.
Example:
ID 7|112345678ABCDEF

ID 16|FFFFFFFF11111111AAAAAAAA22222222

Note: In Generic Boot devices, the number of bytesin the ID code differs with the devicein
use. When the actual number of bytesislessthan 16, pad the higher-order bytes of the

ID code value with ‘H'FF'.
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4.6 Wait For Script — Example Script File

What followsis an example of how a script file for FDT may look. This highlights some of the
available commands and gives an idea of how they might be used:

# EXAMPLE SCRI PT FI LE

# open this workspace and associ ated project

# (for which the flash project w zard nmust have conpl eted successful ly)
wor kspace C:\ Wirkspaces\ 2215ushdi rect\ 2215UsbDi r ect . AWS

# Ensure that comms is closed (in case previous attenpt failed and didn't
di sconnect)
di sconnect

# connect over the USB to the device with this Product 1D + Bus ID
connect USB| 0x000D| 0

# do an initial blank check
bl ankcheck

# downl oad the file "C\2215uAuto. not" and verify that progranmm ng was OK
# (script processing will stop if this verify fails)
downl oad C:\2215uAut o. not | user|verify

# upl oad data fromaddress O to address 0x1000 and save to file “upl oad. not”
upl oad c:\ UPLOADS\ upl oad. not | 0x0| 0x1000

# erase all bl ocks
erase device

# do a bl ank check (and stop if the user area is dirty)
bl ankcheck stoponwritten

# rebuild the inage
Rebui | dl mage

# downl oad the user inage
downl oad i mage| user

# get the checksumfor the user area of the device
checksum devi ce

# pause for 100 nmilliseconds
pause 100

# di sconnect fromthe device
di sconnect

# Display message in output w ndow
alert output|This text will be displayed in the output wi ndow and the log file

# delete this script
# (will stop FDT fromrunning through the file again)
del ete $script
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4.7 Wait For Script — Status File For mat

While FDT isin Wait For Script mode, aremote user may wish to find out what state the
application is currently in. Thisis achieved by having astatusfile that FDT writesto asit carries
out actions and which an external user can read. This has the following options:

By default, status file writing will be disabled. Ticking the Enable checkbox will open the
Directory and Name fields for editing; allowing the user to specify where the status file will be
created.

[ FDTScript Status v1.0] < Theconfigurationfileversion

Current Scri pt = < Thelocation of the current script being executed, or the
search path being used whilst waiting

User | D= < The user name of the person running the copy of FDT
writing to thisfile

Machi ne= < The machine name the copy of FDT is executing on
Last Updat e= < Thetime and date this file was |ast changed
Current St at us= < The current state of FDT. Thiswill be either ‘waiting’ (if

FDT islooking for a script), ‘processing’ (if FDT has
found a script and is using it), ‘error processing’ (if
something has gone wrong with the script) or ‘waiting for
user input’ (if adialog iswaiting for user intervention). If
FDT exitswait for file mode correctly this entry will be

blanked
Previ ousScri pt = < The location of the previously run script
Previ ousSt at e= < The outcome of the previously run script. Thiswill either

be‘COMPLETED’ or ‘FAILED’

JobNo= < Anincrementing number of successfully completed runs.
This number will wrap back to 0 when it reaches 32,768.
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When FDT begins a Wait For File session, with status writing enabled, it will first check for the
existence of the specified file. If it is not found then it will be created and FDT will continue. If it
isfound the file will be opened and checked. If CurrentStatusis blank (implying that a previous
session exited correctly and that no-one elseisusing the file) FDT will continue. If an entry is
found in CurrentStatus, e.g. ‘ Processing’ then FDT will aert the user, viaa message box, that a
previous session may have crashed or that another copy is running and using thisfile also. The
option will then be given to continue and overwrite the values or abort.
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Chapter 5 Access Rights

51 Access Rights Overview

To prevent accidental changing of settings when using FDT to program devices (especialy in a
multi-user environment), the Access Rights feature allows creation of usernames and passwords to
give different levels of accessto different users. Typically, there would be three levels of access
rights:

Administrator level which allows the user to create and modify user accounts
Supervisor level which allows project creation and editing

SIM User level which alows a Simple Interface Mode user the right only to program the device
image from Simple Interface Mode. A supervisor would need to configure the project before a
SIM User could use FDT.

NOTE: Access Rights when running under the Windows Vista® and Windows® 7 O/S are currently
disabled in preference for the User Access Controls provided by Windows Vista® and
Windows © 7. See the FDT Usage section for more information.

52 Enabling Access Rights

FDT issupplied by default with the user accounts specified above but without passwords set. Y ou
will not need to log in to FDT until the Access Rights feature is enabled by setting the password
for thebuilt in Administrator account. Thisis achieved by using the ‘ Tools', * Access Rights,
‘Administration...” menu item. The first timethisis run, you will be prompted to enter a password
for the Administrator account.
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5.3 Access Rights Administration

Thisisreached viathe ‘Tools', ‘ Access Rights', ‘ Administration...” menu item.

Useradmin x|

Dizable all
Ueer Account Names :
CIM I_'IS-BF Jd E.;j"!'I NET=
Supervizor
. Add User |
Delete User
Fezet Pind
Claze

Figure5-1 User Admin
531 Disable All

This button allows disables all user accounts and switches off Access Rights password security
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5.3.2 Modify User

This button alows modification of the settings for the selected user by invoking the Modify User
dialog.

Modiyuser N x|

—Account Acoess Rights——————
SIk User |

[NaccessRights:&dmin
[ IFDT:Project Edt

[ 15 implel nterface: Exi :
[15implelnteface: Dowrload Fils m
]S implelrterface Download Progct Image
Set Default
Apply
Carcel

Figure5-2 User Admin
The available access options are:
AccessRights: Admin — Allows administration of user accounts and passwords

FDT:Project Edit — Allows editing of FDT Projects; enables the ‘ Back to Project’ button in
Simple Interface Mode

Simplel nterface: Exit — Allows exiting of FDT; enablesthe ‘Exit’ button in Simple Interface
Mode.

Simplel nterface:Download File — Allows user selection of the file to download; enablesthe
‘Download File' section of the Simple Interface Mode.

Simplel nterface:Download Project |mage — Allows the user to download the project image(s);
enables the ‘ Download Project Image’ section of the Simple Interface Mode.
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533 Add User

This button allows creation of new user accounts. FDT will prompt for a user name and password
then invokes the Modify User dialog.

534 Delete User

This button allows deletion of user accounts.
535 Reset Pwd

This button allows setting of the password for the selected user.
5.3.6 Close

This button closes the User Admin Dialog.
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Chapter 6 Configuring the User Interface

When the user interface for FDT was designed an attempt was made to make frequently used
operations quickly accessible and have related operations grouped in alogical order. However,
when the user isin the middle of along session he may find it more useful to have a different
arrangement of the user interface items. FDT facilitates this user customisation. This chapter
describes how the user interface can be arranged and how various aspects of the display can be
customi sed.

6.1 Arranging Windows
6.1.1 Minimising windows

When an operation is finished on an open Editor window but it may be necessary to look at it inits
current state later, it can be reduced to anicon, thisis called minimizing the window. To minimise
awindow click on the ‘minimise’ button of the window.

The window is minimised to an icon at the bottom of the Editor window.
Note: Theicon may not be visibleif there is another window open over the bottom of the screen.

To restore the icon back to awindow either double click on the icon, or click once to pop up the
icon menu and select [Restor €], or select required window from the Menu bar [Window] drop-
down menu.

6.1.2 Tiling windows

After some time there may be many windows open on the screen. All the windows can be
arranged in atile format with none of them overlapping each other using the "Tile Windows"
option. To invoke this select the[Window->Tile Horizontally] or [Window->Tile Vertically]
menu option.

All currently open windows are arranged in atile format. Windows that are minimised to icons are
not affected.

6.1.3 Cascading windows

The open windows can be arranged in a cascaded format by using the "Tile Windows' option. To
invoke this select the [Window->Cascade] menu option.
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6.2 Locating Currently Open Windows

When many windows are open in the FDT application window it is quite easy to lose one of them
behind the others.

6.2.1 L ocating a specific window
There are two methods to find the lost window.

1. To select a specific window, invoke the [Window] menu. Click on the required window from
thelist of open windows at the bottom of the menu. The currently selected window will have a
check mark next to it in the window list.

The window selected will be brought to the front of the display. If it is minimised theicon is
restored to a window.

2. A specific window can also be selected by clicking on the tab containing the file name at the
bottom of the Editor window. If the window is not minimised it will be brought to the front of
the display. If it is minimised, the minimised icon will be brought to the front of the display.

6.3 Enabling/disabling the Toolbar

The user has the option to enable or disable the Toolbar. By default, the Toolbar is displayed at the
top of the FDT application window. To disable the display of the Toolbar, select each of the
displayed toolbars, and disable their view.

To display or disable toolbars, use the [T ools->Customise] menu option or Right Click on the
Toolbar area..

6.4 Enabling/disabling the Wor kspace Window

The user has the option to enable or disable the Workspace. By default, the Workspace is
displayed. To disable display of the Workspace, select the [View->W orkspace] menu option.

If the disable option is selected, the Workspace will be disabled and removed from the FDT
application window display. To re-enable the Workspace display, select the [View->W or kspace]
menu option again. The Workspace will be enabled and added to the FDT application window
display and the menu option checked.
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6.5 Enabling/disabling the Output Window

The user has the option to enable or disable the Output Window. By default, the Output Window
isdisplayed. To disable display of the Output Window, select the [View->Output] menu option.

If the disable option is selected, the Output Window will be disabled and removed from the FDT
application window display. To re-enable the Output Window display, select the [View->Output]
menu option again. The Output Window will be enabled and added to the FDT application
window display and the menu option checked.

6.6 Customising the Toolbar

The selection and arrangement of buttons displayed on the Toolbar can be customised to suit a
users requirements. To change the display, invoke the [T ools->Customise...] menu option. The
defaults are to display the Editor, Search, FDT, QzROM and S-Record toolbars. Note that the S-
Record Toolbar option is only available when there is a data file open.

The 'Customise’ dialog box will be displayed:

Toolbars | tenu |

Toolbars:

¥ Show Toaoltips Mew...

(w|Search
[wIFDT Fieset
[w]QzR0OM —l

(w5 -Record

<] 2
Toolbar name
|Editar

Figure6-1 Customise FDT
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The 'Customise’ dialog box has a number of tabs, which are further described in Chapter 8 -
Windows.

6.6.1 Toolbars Tab

The Toolbars tab allows the user to select which toolbars are displayed. The default isto display
only the Editor, Search, and FDT toolbars.

The New... button launches the 'Toolbar Name' dialog box which allows the user to name and
generate a new toolbar. After entering the new name and clicking on OK, the new name will be
added to the Toolbars list and an empty toolbar is displayed on the interface.

Selecting the Commands tab allows the user to select and add buttons to the new toolbar. The user
can place the new toolbar anywhere on the GUI by dragging it with the mouse.

When auser created toolbar is selected in the Toolbars list, the Reset button is renamed to Delete.
Clicking on this button will remove the new toolbar from the list and from the GUI.

The Reset button resets the selected toolbar to its default settings.
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Figure7-1 FDT Menus
7.1 FileMenu
The 'File' menu is used for aspects of the program that access datafiles.
7.11 Close
Thiswill close the current active file in the editor window.
712 New Workspace...

Launches the ‘New Workspace' dialog box allowing the user to specify the name and location of a
new workspace and creates a new workspace directory

713 Open Workspace...

Launches the ‘Open’ dialog box alowing the user to open an existing FDT Workspace file (.aws).
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7.1.4 Save Workspace

Savesthe details of the currently active Workspace.
7.15 Close Workspace

Closes the currently active Workspace.
7.1.6 Open a DataFile...

Launches the ‘Open a Data File' dialog box allowing the user to open an existing file. Thefile
may be an S-Record file (.rec, .mot, .a20, .a37, .s2), a Device Imagefile (.ddi), or abinary file
(.bin, .cde).

717 Save
Saves the current activefile.
7.1.8 Save As...
Launchesthe ‘Save As' dialog box allowing the user to save and name the currently open file.
7.19 Recent Workspaces
Show alist of recent workspaces opened in FDT. Select one to open.
7.1.10 Recent Data Files
Show alist of recent files opened in the Hex Editor. Select one to open.
7111  Exit

Closes and exitsthe FDT _application.
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7.2 Edit Menu

The 'Edit’ menu is used for aspects of the program that access or ater datain the Editor window.
721 Undo

Allows the user to reverse the previous editing operation.
722 Redo

Allows the user to reverse the previous Undo operation.
723 Cut

Thiswill remove the contents of the highlighted block from the window and place it on the
clipboard in the standard Windows manner. This option is only available if ablock is highlighted.

7.24 Copy

Thiswill copy the contents of the highlighted block to the clipboard in the standard Windows
manner. Thisoption is only available if ablock is highlighted.

7.25 Paste

Thiswill copy the contents of the Windows clipboard into the child window at the current cursor
position.

7.2.6 Select All
Selects all the information in the active file in the editor window.
727 Find...

Thiswill launch the ‘Find’ dialog box allowing the user to enter either hexadecimal or ASCII data.
The scope of the search is bounded by the area selected, for the active file in the Editor window. If
amatch isfound, the Editor window is updated to display the found data.

7.2.8 Find In Files...

Thislaunches adialog to allow data to be located in files external to the activefile.
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7.2.9 Replace...

Thiswill launch the ‘Replace’ dialog box allowing the user to enter either the hexadecimal or
ASCII datato be found and the replacement data, in the same format. The scope of the search is
bounded by the area selected, for the active file in the Editor window. If a match is found, the
Editor window is updated to display the found data, click on the now enabled Replace button to
replace the data.

7.3 View Menu

The*View’ menu isused to display or remove FDT GUI features, such as the Workspace and
Output Windows.

731 Workspace
Displays the Workspace window.
7.3.2 Output

Displays the Output window.

7.4 Project Menu
The *Project’ menu provides high level control and facilities for projects within the workspace.
74.1 Set Current Project

This option allows the user to select the active project where there are multiple projectsin the
workspace.

7.4.2 Insert Project...
This option alows the user to create a new project, and add it to the workspace.
7.4.3 Add Files...

Launches the ‘Open’ dialog box allowing the user to add data files to the project.
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744 Remove Files...
Removes the selected file from the project.
745 File Extensions...

This option alows the user to select which file extensions are recognized by FDT and configure
how they are handled.

21 x|

Extenzion | Group OF.

5] " b Binary Files
|Z] “ede  FDT Binaey Files Cancel
[Bl*ddi  EDT OO Files

Eipe  FDT Image Fies Add.

=E'[ a2l AR A20Fies

j[ ‘a3l AR A37 Files
= e BEC Fles _ T
B mal  S-Fecord Files (penyk]

[

Figure7-2 File Extensions Dialog
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7.45.1. FileExtensonsAdd...
Selecting ‘Add..." dlows FDT to handlefiles of new extension types

21
e s |
Canced

~Fle proup:
1 Esterion belongs o an egiding gioup
|Bram P |
1+ Extenzion belongs 1o a new giou:
|y Mew EC lype Files

-dssocisted apphcabian: -
Opan My Mew HEC Lipa

Hew Edits = |
E diean

Hane
Othar
‘i defaul

Figure 7-3 Add File Extensions Dialog
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7.45.2. File Extensons Modify...

Selecting ‘Modify..." allows selection of how FDT handlesfiles of this extension type.

21
[ o
[ Recaries

Azgociatad apoication : Gancel

Dpan 5-Record File:" with:

Hex Edior __TJ
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‘wdindows dalault

Figure 7-4 Modify File Extensions Dialog
7.4.6 Rebuild Image

Rebuilding the image merges al filesin the project that are not excluded. The default ROM areais
the User Area, some devices also have a User Boot Areaor a Data Area. FDT will warn if the
component files overlap. Building an image can be advantageous when the data you wish to
program is made up of separate component files — especially if datafrom different fileswill reside
in the same erase block area because downloading each component file separately could cause the
device to erase the block before the second download if automatic protection is used.

74.7 Download Image

Downloads the image built by a Rebuild Image. If the image is out of date (i.e. source files have
changed) then FDT will offer to rebuild before the download occurs.

7.4.8 Field Programming

Publish... Create asingle .fpf4 file which contains all kernel and data files to send to another FDT
user.

Run Published File... Unpackage a .fpf4 file and use it in Simple Interface Mode.

See Chapter 11 Field Programming for more details
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75 Tools Menu

The ‘Tools' menu is used to launch additional FDT features, which are not related to either
projects or target devices.

751 Administration...
This displays adialog with the tools available to the user under different categories.
752 Customise...

This allows the user to customise FDT, and is covered in more detail in section 8.9 Customise -
Toolbars.

753 Options...

Allows access to additional features, some of which are reserved for future enhancements. The
workspace tab is the most useful tab asit allows the user to specify options such as whether to
open the last workspace at start-up, whether to prompt before saving workspaces and sessions, and
the default directory for new workspaces.

754 Format Views...

This allows the user to change the appearance of different windows.
755 Simple Interface...

Simplifies the appearance of FDT. For more details see section Chapter 9
7.5.6 Wait For Script

This alows creation, editing or running of a Wait For Script configuration. See Chapter 4 for
further details.

75.7 Access Rights
7.5.7.1. AccessRights—Login...

This allows changing of which user islogged in to FDT. The hotkey Ctrl-Shift-U also invokes the
Login dialog. See Chapter 5 for further details
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7.5.7.2. AccessRights— Change Password...
This alows the currently logged in user to change their password. See Chapter 5 for further details
7.5.7.3. AccessRights— Administration...

This allows configuration of user names and passwords for restricting accessto FDT. See Chapter
5 for further details

7.5.8 Unique Code Programming...

Allows setup and control of the Unique Code Programming feature within FDT. See Chapter 16
for further details.

7.6 Window Menu

The *“Window’ menu is used to alter the display of currently open windows within the FDT GUI.
Files displayed in the Editor window are appended to the following list, these files are identified
by their filename and the currently active file is denoted by check mark.

7.6.1 Cascade

This option allows multiple windows to be staggered so that each fileisvisible.
7.6.2 TileHorizontally

This option allows the windows to be displayed with maximum possible horizontal width.
7.6.3 Tile Vertically

This option allows the windows to be displayed with maximum possible vertical height.
7.6.4 Arrange lcons

This option arranges the file icons in rows at the bottom of the screen.
7.6.5 Close All

This option closes any files open in the editor window.
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7.6.6 ‘file name’

This option becomes active when afile name is selected and checked.

7.7 Device Menu
The ‘Device’ menu provides control facilities for interacting with the target device.
771 Connect to Device

This connects the GUI to the deviceif it is not connected. Progress messages will appear in the
Output window.

7.7.2 Disconnect

This disconnects the GUI from the deviceiif it is connected. Progress messages will appear in the
output window.

7.7.3 Erase FLASH blocks
This launches the ‘ Erase Blocks' dialog box.

The ‘Erase Blocks' dialog box allows the user to specify which blocks are to be erased. The
Written column indicates whether data is present in the block.

To start the operation, select the required block names in the list and then click the Erase button.
774 Blank check

This launches a blank check on the device FLASH and reports back to the Output window.
7.75 Upload Image

Thislaunches the ‘ Upload Image’ dialog box, which enables the uploading of arange of data from
the target device. Thisisintended for access with FLASH memory. The datais placed in the
Editor window.

7.7.6 Download Active File

This downloads the current active file into the target FLASH memory.
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7.7.7 FLASH Checksum

This launches a checksum calculation on the device FLASH and reports back to the Output
window. Thisis an EPROM Style checksum which is a 32 bit addition of the byte valueswithin
the range of the flash, padded with OxFF' s to the next EPROM size (e.g. 64Kb, 128Kb etc).

7.7.8 Go From Address...

Thislaunches a dialog that allows the user to select an address to execute code from. Thereis an
option to select an indirect address mode, so that the address referenced is itself an address of
where the code needs to run from.

7.7.9 Run

Thisinputs the reset signal to place the device into user mode and if necessary supplies power so
that programmed device code can be tested. No other FDT functions are available while in this
mode. Toggle to cancel. (Note it may be necessary for FDT to query for user mode pin settings
and power |evelsto complete this operation)

7.7.10 Block Locking...

Thislaunches a dialog that allows the user to setup the locking settings for the project - should the
configured device support thisfeature.

7711 Set|D Code...

This launches a dialog box that allows the user to set an ID code for the project (only if the
configured device supports this feature).

7.7.12  Cancel Operation
Cancels the current FLASH operation.
7.7.13  Configure Flash Project

Displays the Flash Properties dialog or launches the Project Wizard if the device is not yet
configured.
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7.8 Help Menu

The ‘Help’ menu is used to access additional information on how to use the functionality provided
by FDT.

781 Help Topics

Launches the Help system for FDT. The ‘Help Topics dialog box for FDT is displayed, enabling
help to be accessed on required FDT subjects through several methods.

7.8.2 Technical Support
This allows the user to report a problem with FDT, or to check the website for the latest updates.
7.8.3 About...

Launches the * About Flash Development Toolkit’ dialog box, through which additional
information regarding FDT can be accessed:

e FDT version.
e Copyright information.
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Chapter 8 Windows

This chapter describes each child window type, the features each supports and the options
available through their associated pop-up menus.

There are three main windows - Workspace window, Editor window and Output window.

Most windows have local pop-up menusin order to make commonly used features easier to
access. These menus are invoked by clicking the right mouse button within the window (or
pressing SHIFT+F10) and then selecting the required menu option.

Windows may also be launched from a number of the main menu items.

8.1 W or kspace window
The Workspace window contains details of the itemsin the workspace including the workspace
name, projects contained in the workspace and for each project their Device Image files and
Target files.

811 Workspace

The Workspace is the first item in the window, in the following example thisis "Workspace
‘Industrial Controller™:

=R Industnal Euntmller Insert Project...
= tﬂ Device Image - ;
e (4] Industrial Controller fpr ! ¥ Allow Docking

tﬂ FO'T Image Files Hide
IJ tﬂ S-Record Files :
[ 2282Test mat Properties
o [H] uGenU.mot

=~ IE Ilzer Mode Reprogramming
B- tﬂ Device Image
: ----- D Ilzer Mode Reprogramming. fpr
=9 FDT Image Files
I_'I tﬂ S-Record Files
(] 2282Testmot
o[ 3] uGenl).mot

Figure8-1 Workspace Window
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Invoking certain menu items from a pop-up menu in the Workspace window will launch
additional windows.

The Workspace window pop-up menu has the following items:
8.1.1.1. Insert Project...

Invoking this option allows the user to add a project to the Workspace.
8.1.1.2. Allow Docking

Invoking this option allows the user to select if the window is docked, or if it can "float" around
the main window.

8.1.1.3. Hide
Invoking Hide conceal s the Workspace window. It is restored by [View->Workspace].
8.1.1.4. Properties

This option displays information about the Workspace including the file path.

Workspace Properties

Hams: |tndl.sstrrel Comiraler

Location: EAFDT SwWorkzpacesindusinal Controlerilndustial Co
Lazt modified: 124538, Tuesday, March 11, 2003

CPU famnike All Flazh Devices

Tood chain:

Infioematian:
Hio waikspace information available 3

o
[T Show werkspacs information on workspace open
Figure8-2 Workspace Properties
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8.1.2 Project

The Project is the next item in the hierarchy below the Workspace. In the following example, the
Workspace is called "Industria Controller" and there are two projects: the first isalso called
"Industrial Controller" and the second is called "User Mode Reprogramming”.

=

=~ @ Induztrial Eu:untn:uller
& l@
-9 5-Record FI|ES
[£] 2282Testmo
: uGenl. ot
------ I@ IJzer Mode Reproagrar

&dd Files, ..
Remove Files., .,

IMS

&dd Falder. ..

IT Bl Docking

Hide

Properties

Sel as Current Projeck
Rermove Projeck
Lnlmad Projeck

Add Files From Kernel Dir. .,

Figure 8-3 Workspace Project

In addition to the 'Allow Docking' and 'Hide' menu items inherited from the workspace, the pop-up
menu for Projects has the following items:

8.1.21. AddFiles...

Launches the 'Open’ dialog box allowing the user to add data files to the project.

8.1.2.2. RemoveFiles...

Launches adialog to select the files to remove.

8.1.2.3. Add Folder...

Adds afolder to the Project

R20UTO0508EJ1100 Rev.11.00
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8.1.24. Allow Docking
See Section 8.1.1.2
8.1.25. Hide

See Section 8.1.1.3
8.1.2.6. Properties

Displays the project properties dialog. Note that thisis not the same as the Flash Properties dialog
which can be reached by selecting Configur e Flash Project from the FDT toolbar or device
menu.

8.1.2.7. Set ascurrent Project

Sets the highlighted project as the current active project. This option is not available if the
highlighted project is already the active project.

8.1.2.8. Remove Project

Remove the highlighted project from the Workspace. This option is not available if the highlighted
project is the active project.

8.1.2.9. Unload Project

Unloads the highlighted project from the Workspace. This option is not available if the highlighted
project is the active project. Note that any changes to the project made since the last save, will be
lost when the project is unloaded (FDT will not prompt to save changes before unloading).

8.1.2.10. Add FilesFrom Kernel Dir...

This allows the user to select files from the current kernel directory and add those files to the
current project.
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8.1.3 Device Image - Folder

This contains the Device Image file(s) for the project. The device image will be called the same as
the project but with a .ddi extension.

Ell@ |ndusgtrial Contraller
EII@ Industrial Controller

Hemove Folder

Rename Falder

-4 FDT DDI Files
=3 FDT Image Files IT &llow Crocking

E-53 5-Record Files Hide
fpl.MOT
fuk fp2MOT
----- G User Mode Praject

Figure8-4 Devicelmage Folder

In addition to the 'Allow Docking' and 'Hide' menu items inherited from the workspace, 'Device
Image - Sub Folder' pop-up menu has the following items:

8.1.3.1. Remove Folder
Allows the user to delete folders.
8.1.3.2. RenameFolder

Allows the folder to be renamed.
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8.2 Device File

The Device Fileis the item containing the data to Flash into the device.

=3 3069
= 3069
-3 Device Image
- 069, ddi
223 5-Record Files

raa.MOT Open Uploadd,MoT
UploadO.MOT [LIE]

Add Files... IMS

Remove Files. ..

IT Allow Docking
Hide

Properties

Display Black Usage. ..
Exclude Upload,MOT
IT Ilser Boot Flash

Download File to [Iser Book Flash]
File Checksurmn
Compate File- =Device Checksum

Compare File- =Device (Complete Dewvice)

Compare File- =Device (File Data Only)

Figure8-5 DeviceFile
The pop-up menu for Device File has the following items:
821 Open ‘filename’
This feature opens the selected file.
822  AddFiles..

Allows additional files to be added to the project.

R20UT0508EJ1100 Rev.11.00 RENESAS Page 118 of 216
Mar 07, 2012



Chapter 8 Windows

8.2.3 RemoveFiles...

Removes files from the project.
8.24 Allow Docking

Allows the Workspace window to dock or be floating.
8.25 Hide

Hides the Workspace window.
8.2.6 Properties...

Launches the device file properties dialog box.
8.2.7 Display Block usage...

Launches the ‘ Data File Properties’ dialog box and displays the Block usage tab.
8.2.8 Exclude ‘filename’

If afileisexcluded, it will not be used to form the built image if Rebuild Image is selected. Once

selected as excluded, using the right mouse click, it is possible to “Include ‘filename'”.
8.29 User Boot Flash

User Boot Flash : When this option is selected (ticked), the selected file is tagged as being
destined for the User Boot Area. If not ticked, it will default to the User Area. This option isonly
available if the target device supports a User Boot Area

8.2.10 Download Fileto [User Area] /[User Boot Flash]

Downloads the selected file to the device FLASH memory. Note that the Flash Area used is
determined by whether the fileistagged as a'User Boot Flash' file.
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8.2.11 File Checksum

The file checksum returns the checksum for the file using the algorithm in the kernel (EPROM
style) and also araw checksum. The raw checksum is a simple 32 bit addition of the byte values
within the range of the flash. The EPROM style checksum pads the data with OxFF s to the next
EPROM size (eg 64 Kb, 128 Kb etc) before cal culating the checksum. The result is shown in the
output window. An example is shown below:-

Fil e Checksum O0x07F5A651 (EPROM style),
Raw Checksum 0x07F5A651 (over address range 0x00000000 - Ox0007FFFF)

8.2.12 Compare File->Device Checksum

This command allows the user to compare the selected file checksum to the device checksum. The
output window will show the sum check for both the file and the device. The user may then
confirm that they are the same.

An example is shown below:-

Cal cul ati ng device checksum
Fl ash Checksum O0x07F5A651 (User Area)

Fil e Checksum O0x07F5A651 ( EPROM style),
Raw Checksum 0x07F5A651 (over address range 0x00000000 - Ox0007FFFF)

8.2.13 Compare File->Device (Complete Device)

This mode would compare the data in the device flash (starting at the device start address) to the
corresponding datain the file. The process would only stop once the entire device had been
checked, or differences were found. Areas that are not covered by the file would be assumed to be
OxFF and would therefore require a corresponding blank area on the device to be verified
correctly.

8.2.14 Compare File->Device (File Data Only)

This mode would compare the data in the file to the corresponding data on the device. Thisis
identical in behaviour to the after-write readback verify process. Areas not covered by thefile
would not be checked. Typicaly thiswill be afaster operation, as the entire flash does not have to
be uploaded, however, it is therefore a less thorough process.
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8.3 Workspace Properties
Invoked from the Workspace pop-up menu item Properties.... See also section 8.1.1.4.
The ‘Workspace Properties’ dialog box shows details of:

e The Workspace Name
e Thefilename and path
e Thetime and date when the workspace was last saved

Workspace Properties il

I ame; IIndustriaI Controller

Lacatian: FAFDT Work zpacessndustial Controllers ndustrial Cao C I
Eastmodfied: 134838 Tuesday, Mareh 11, 2003 ﬁl

CPLI Farnily: Al Flazh Devices
Tool chain:
Irfarmnatior;
Mo workspace infarmation available ;I

[T Show waorkzspace information on workspace open

Figure8-6 Workspace Properties
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8.4 Project Properties
Invoked from the Project pop-up menu item Properties....
The ‘Properties’ dialog box shows details of :

e The name of the project
e Thelocation and the filename of the project file
e Thelast modification date and time

Marne: Indusztrial Cantrolle oK
Location: C¥Program Fileg¥Renezaz¢FDT 3. 2w ork spaces¥|ndustrial Contrall
Cancel
Last modified: 11:03:10, Monday, August 01, 2005
CPU Farmily: All Flazh Devices
Tool chain:
Yerzsion;
[ Project relative file path
Figure 8-7 Project Properties
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8.5 Configure Flash Project (Flash Properties)

The * Configure Flash Project’ dialog box can be invoked from the ‘ Configure Flash Project’
toolbar button or Device Menu item. It defaults to being docked at the bottom of the FDT window
but can be dragged to dock in other locations or to float. To prevent unintentional docking, hold
the Ctrl key whilst dragging.

85.1 Kernel Tab

This shows the kernel path, frequency, protocol, clock multipliers, and clock mode. Double
clicking on these entries when disconnected will invoke the Project Wizard at the appropriate
screen.

Flash Properties - Industrial Controller i A
Property I Yalue |

kernel Path Ci¥Program Files¥Renesas¥FDT3, 0S¥k ernels¥ProtC¥3060¥Renesas¥1_0. .,
Frequency (External) 25.0000 MHz

Protocol C

kM 1

CKP A

Clock Mode 0

MKernel .f{. Communications h Dranice ,]H. Programmer h Modules {'

Figure8-8 Kernel Properties

Kernel Path
This shows the kernel path.
Frequency

This shows the input clock and whether that clock is external or internal to the target
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Protocol

This shows the type of communication protocols. See also section 3.2.4
Protocol B: 0.35-um devices

Protocol C: 0.18-um devices

Protocol D: R8C, M16C, M16C/Tiny, M32C or 740 devices

Protocol E: H8/Tiny or H8/SLP devices (via E8a)

CKM

This shows the multiplier of the system clock (master clock) for the input clock.

CKP
This shows the multiplier of the peripheral clock for the input clock.
Clock Mode

This shows the clock mode.
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8.5.2 Communications Tab

This shows the default and current baud rates and the current port. It also allows the user to change

the Port and Baud Rate when disconnected.

Hash Properties - Industrial Controller

Property I Value
Part Efalirect
Baud Fate 1158200 bps
Default Baud Fate MAA
Ise Default Baud M/A
Target Fower E3/E8a/E1 Supphy_5 0V
Auta Send 1D MNAA
Pins: Boot Direction & State:
C [mput (0]
] [mput (0]
B [mput (0
F Input {0
E [mput (0]
A [mput (0]
Pins: Reset Direction & State:
C [mput (0]
] [mput (0]
B [mput ()
F [mput ()
E Input {0)
A [mput ()
‘ N
4 }r\ Kernsl ,]HICummunicatiuns .f{. Device h Programmer .r]\. Modules f'

Figure 89 Communications Properties

Port

This drop-down list provides the user with alist of supported COM ports available for connection
to the device. Thislist includes the USB port options.

Baud Rate

Display the currently selected Baud Rate. Double clicking invokes the Project Wizard to allow

editing of thisitem.
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Default Baud Rate
Display the Default Baud Rate.
Use Default Baud

If thisis checked, the default Baud Rate will be used. (This option should be set only when the
Renesas Evaluation Board or Evaluation Development Kit is used.)

Target Power

Double-clicking on this item launches the 'Target power settings' dialog box, where the setting can
be changed.

Auto Send ID
Double-clicking on this item launches the 'ID check' dialog box, where the setting can be changed.
Pins

This section displays the direction and state of the controlled mode pins for the Connect and
Disconnect with Reset operations.

8.5.3 Device Tab

This shows the device information. It also allows the user to select BOOT Mode or USER
Program M ode and the ‘ Direct Connection’ interface. In addition, it can specify whether or not
the kernel isin the target device.
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Flash Properties - Industrial Controller

H

Property | Value

Device Ha/30a9F

RAM Size 16K

FLASH Size 512 K (User Flash) & K {User Boot Flash)

FLASH Start 000000000 {User Flash)  0w00000000 (User Book Flash)
Conneckion Bk

Interface Direct Cannection

kernel Resident Mo

Available RAM IS

Free RLAM IS

Buffer Size 1)

Device ID I

4 I |3 I'-. Kermel ,}\. Communications ,}\. Device A Programmer ,}\. Madules f

Figure 8-10 Device Properties

Device

Displays the name of the active device. Double clicking invokes the Project Wizard to allow

editing of thisitem.
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RAM Size, FLASH Size, Flash Start
These are for display only and are not editable.
Connection

Boot Mode: This connection type specifies that the on-board programming BOOT mode sequence
isto beinitiated. Thiswill cause the entire FLASH memory to be erased and a kernel loaded.

USER (Program) Mode: This connection type specifies that the on-board programming USER
Program mode sequence isto beinitiated by a previously loaded user program that is used to
reprogram the FLASH memory.

Interface

If the target is connected directly to the host computer, the connection interface should be selected
to ‘Direct Connection’.

Double clicking invokes the Project Wizard to alow editing of thisitem.
Kernel Resident

This specifies that amain kernel is aready resident and running on the target device before
connection by FDT. Double clicking invokes the Project Wizard to allow editing of thisitem.

Available RAM and Free RAM

These are for display only and are not editable.
Buffer Size

This shows a size of programming the flash memory.
Device D

Thisisnot used in communication protocol B, C or D.
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854 Programmer Tab

This shows the state of the Function Map and allows the user to select the Device Protection
Option of Automatic, Interactive, or None and the message level option of Advanced or Standard.

ﬂ
Property I "Wallue
Device Protection Automatic
Meszage Level High
Feadback ‘erification Mo
Feset on Disconnect Mo
Connection Reset NS
Reinterrogate on Connect M
Security Protection Prompt
File Cwer Warning Yes

Erazure of Uzer Boot Area Mo

Function Map :

it ite KA
Fead NS
Eraze N
Blank Check NS
Data Buffer ko
BEvtes Available I Inkrnown

Y

| v
}r\ Kermel }H. Communications ,]H. Drevice }H.Prngrammer Modules

Figure8-11 Programmer Properties

Device Protection

This allows the user to select either automatic protection (Automatic) or interactive protection
(Interactive) to protect the FLASH device from accidental over-erasure and over-programming.
Automatic protection will erase blocks from the device prior to programming, as necessary.
Interactive protection will ask the user before an erase occurs. In addition, None can be selected to
disable device protection. Double click to edit the setting.

Whilst connected to adevice FDT keepstrack of the state of the FLASH blocks and is able to
determine when a programming operation will over-program aregion of FLASH memory.

Note: If device protection is disabled the user is responsible for erasing the device prior to
programming.
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M essage level

The user can select either Standard or Advanced message levels. A Standard message level
generates general FDT/target device status messages regarding high-level communications details.
An Advanced message level generates more detailed information regarding lower level
communications details. Double click to edit the setting.

Readback Verification

After programming, FDT can verify the data was programmed successfully by performing a read-
back verification. Use this option to specify whether you would like to perform read-back
verification, always, after confirmation, or never. Double click to edit the setting.

Reset on Disconnect

Executing the "Disconnect” item while the E8, E8Direct, E8a, E8aDirect, E1, E1Direct, E20, or
E20Direct is connected resets the target hardware. Use this option to specify whether you would
like to reset the device, always, after confirmation, or never. Double click to edit the setting.

Note — Please be sure to supply power from the user system when you use this option.
Connection Reset

Not used.

Reinterrogate on Disconnect

This option forces FDT to reinterrogate Generic Boot devices on connection. With this option set
to "No" (default), the device settings are saved in an automatically generated fcf file and re-used.
With this option set to "Yes', FDT will always reinterrogate the device for its details upon
connection; this allows one project to work with many Generic Boot devices. If this option is set
to "Query", FDT will ask you to select whether to reinterrogate the device. Y ou can edit the
setting after double-clicking on this row.

Security Protection

This option controls whether FDT should security protect (some QzROM devices) or parallel
mode protect (some R32C devices) as it disconnects. It echoes the setting on the Protection toolbar
(see 2.1.2). Select “Automatic” to always protect the device at disconnection. Select “Prompt” to
query the user what to do and select “None” to never protect the device at disconnect. NB — It
might not be possible to reconnect to a protected device.
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File Over Warning

With this option set to "Yes' (default), the FDT opens adialog box to confirm whether
downloading should continue or be aborted when the file being downloaded is larger than the size
of the ROM. Y ou can edit the setting after double-clicking on this row.

Erasure of User Boot Area

With this option set to "Yes', erasure of the User Boot Areais enabled. With this option set to
"No", erasure of the User Boot Areaisdisabled. Y ou can edit the setting after double-clicking on
this row. Thisoption is only available for devices that support erasure of the User Boot Area.

Function Map

Thisis not used in communication protocol B, C, D, or E.

8.5.5 Modules Tab

This shows each Kernel file name. Some entries may be blank because most kernels do not use all
of the modules.

Flash Properties =

Properky I Yalue ]

Boot Mode Micra Kerme

AT emel b Comvasicators h Device b Frogammer B Modules f
Figure8-12 Module Properties
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8.6 Data File Properties Window

Once afileisopen and selected in the Hex Editor window the dialog can be invoked by clicking
the Properties button on the S-Record/Data File toolbar, from the Right-Click Properties Menu
entry or using the Alt+Shift+P hot key.

8.6.1 Block Usage Tab

Thistab shows the starting, finishing address and sizes of the data blocks contained in the active
filetab. If thefileis open in the editor window, double clicking on a range highlights the selected
data.

Data File Properties 2282 Test.mok’ I i ﬂ

Black USEIQE | Curzor ".'."a||_,|ei Checksum ]

Address I Length I

H'oooooooo - H'Ooooooosz  H'ooooooo4
H'Oooolooo - H'OOO0O011l1lD  H'O0O0OO011E

Figure 8-13 Data File Properties Block Usage
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8.6.2 Cursor Value

This tab shows various representations of the data at the cursor position. The display depends
upon whether the display unit is set to Byte, Word or DWord. Note that it assumes data alignment
of the display unit size so for example, the same value is displayed wherever the cursor is
positioned within a DWord.

Data File Properties "2282Test.mot’ Rl =]
Block Usage  CursorVake | Checksum |

| Biw Endian | Litrie Endian |
Cursor Pogition Dx00000000 -
Value QurooLo0D Qx00L00000
Decinal value [(signed) ago02036 01048576
Decinal valus (unsigned) ooo04096 1048576
Floaot wvalus E_T7397185e=042 1.4693679e=03%

Figure 8-14 Data File Properties Cursor Value
8.6.3 Selection Value

This tab shows various representations of the data that is currently selected. The display depends
upon whether the selection is a Byte, Word or DWord.

Data File Properties "2282Test.mot" |

Block Uzage Eﬂhﬂﬁﬂﬂ'-"c‘iﬂ| Checksumn 1

| Big Endian | Little Endian |
Selecrion size DT 0RD DWOED
Yalue 0x0000L000 0E00L00000
Decinal walue [signed) 00004098 01048575
Decinal walue [unsigned) 00004096 D104B576
Float walus E.72087185.-042 1,46926752-030

Figure8-15 Data File Properties Selection Value
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8.6.4 Checksum Tab

Thistab shows the Raw style checksum for the selected datarange.

Data File Properties *2Z282Test.mot" x|

Block Usage  Selection Value l:heckmi

Selection | Faw |

Ox00000000 = OxO007FFFE OxD7FFEAGE]L

Figure8-16 Data File Properties Checksum Tab

8.7 Output Window

The Output window is one of the main windows contained in the FDT GUI.

3

5T For) 308s { Fadin Fie |

Figure8-17 Output Window

The window has available pop-up menu that contains the following items:
871 Copy

Copies any selected text to the clipboard
8.7.2 Clear Window

Thiswill clear the Output window.
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8.7.3 Save

Allows the contents of the window to be saved to atext file. A Save Dialog will appear to specify
the intended file location.

8.7.4 Allow Docking

With this option checked the Output window is capable of being docked within the FDT
application window. With the option unchecked the Output window is a floating window.

8.75 Hide

Invoking Hide conceal s the output window. It isrestored by [View->Output].

Note — the output window will not log messages indefinitely. The current default is 500 lines of
text, after which older messages will be purged.
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8.8 Hex Editor Window

The Hex Editor window is one of the main windows contained in the FDT GUI. It is used to
display file contents or target uploads within FDT. There are several ways of opening afile within
the editor:

e double-click on aproject file from the Workspace view

e double-click on an FDT file type from Windows® Explorer

e drag and drop afile from Windows® Explorer onto the editor space
e choose' Open aDataFile..." from the File menu or toolbar icon

o upload data from atarget device

_(ol x|
0000CO00 00 OL 02 03 04 05 06 07 0B 03 L0 11 12 13 14 15 =
0000C010 00 0L 02 03 04 05 06 07 FF FF FF FF FF FF FF FF i y
gooocCoz20 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §yyyigiyiiyiigyy
0000C030 55 55 55 55 55 5§ 55 55 55 §5 55 5§ §E 55 5§ §5  UHUOHUNUIUUDINOT
0000C040 &5 55 55 55 55 55 55 55 55 §5 G5 G5 55 55 5§ G5  UUUUNUUUIUUTUOUY
0000C050 G5 55 55 55 G5 G 5§ G5 55 §5 G5 55 55 G5 5§ 55  UUUUOUNUNUUDUOUY
0000COE0 G5 55 55 §E G5 5§ 5§ ES G5 G5 EL 55 BE EC 5§ 55 IOUUOUNUNUUDUNUY
000OCD70 55 §5 55 55 B5 55 &1 P 111411 1 i1 4
0000C080 55 55 55 55 55 55 § . = hygurouononunog
0000C090 55 55 5 5E G5 55 & ooy ceec  fomononunoununon
0000COAD 55 G5 55 EE EG E5 § poge iy TOUDODOUIUUOTOOU
0000COBO0 55 55 55 55 55 55 §_ - TUTOTTUTUTUIUITY
D0OOCOCD 55 55 55 §5 55 65 & | s PUUUUUDUUOTUUUUY
0000CODD G5 55 55 5§ G5 5 5 o - TOTTUTUIUIUIIT
0000COED G5 55 G5 G55 G5 B & fedo Colty FOUDUTUTUIUIUTOT
0000COFD 55 55 55 55 55 G5 § U UIUUY
0000C100 G55 55 55 55 G5 GG & Display Unit v [OUOUTUTUIUIUTOY
0000C110 55 55 5§ G55 B EE § T . i}
000O0C120 S5 E5 55 55 B BE § [ Liele Endian
0000C130 55 55 §5 55 55 G5 §| Al+s Big Endian
0000C140 FF FF FF FF FF FF F

0000C150 FF FF FF FF FF FF F 0 1090l A5CI colmn e

0000C160 FF FF FF FF FF FF F .

0000C170 FF FF FF FF FF FF F ki Creatsdelection... Al

D0DOC180 FF FF FF FF FF FF F &0 fl. AL

0000C150 FF FF FF FF FF FF F & -

0000CIAD FF FF FF FF FF FF F R EMd. Chite

0000C1E0 FF FF FF FF FF FF F & Replace.., Ctrl+H

0000C1CO FF FF FF FF FF FF F

0000C1D0  FF FF FF FF FF FF F &% Properties... Ale+5hift+P

0000CIED FF FF FF FF FE FE F o0 0 0

N000C1FD FF FF FF FF FF FF F__ 000 AeHve Froiscs eI

0ooncC200 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF yyyyyyyyyyyyyyyy Li
IEII\User Flash j"\ Crata Flash f

Figure8-18 Hex Editor Window

The window will have one or more tabs along the bottom of the view, each of which will
correspond to aflash area on the target device for the project. Each tab will be set to the address
range of that flash area and will show the data that corresponds to that area. DDI files and uploads
viablocks are capable of adding into multiple tabs simultaneously. Normal S-record and binary
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files (and uploads via address) will only have data for one flash area at atime, which will leave the
other tabs empty (although they can till be edited manually).

Across the top of the window the current filename will be displayed (or upload name), along with
the current cursor location (or selected area) and the endian of the view. FDT will default to 'Big
Endian'. (Note that swapping the endian view of a file will not affect the data that is saved to that
file)

Additionally, should a project device support the concept of 1D codes (check the device hardware
manual for more information) then FDT will highlight the byte locations affected:

0000FFCO FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 9yyyyyvvyyyyyyyyy
0000FFDO FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 9yyyvyyevyyyyyyy
0000FFED FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF wyyyvvyyvyyyivyy :j

0000FFF0 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF yyyvevyvyvyvivey
User Flash ;{\ Data Flash !“

Figure8-19 ExamplelD code highlighting

To close an open file, click the crossin the top right corner of that file. If thefileis unsaved, FDT
will prompt to ask if you want to save the open file unless the shift key is held down whilst the
crossisclicked. After closing and saving, FDT will ask if you wish to add the file to the current
project if it is not included already.

When saving a .ddi file as a different file type, e.g. S-Record, then FDT is not able to output the
data from each of the DDI tabsinto asinglefile. In this case it will issue awarning that only the
data from the active tab will be saved into thefile. The active tab is the currently viewable tab.
NOTE - This may result in data loss when compared to the original DDI file.

Also note that FDT will default to saving text based file formats (e.g. S Record or DDI) as
uppercase, even if the original file was lowercase. Thisisto improve compatibility with other
Renesas tools. This behaviour is new from 3.06 and can be modified by adding an entry into the
FDT.ini file:

[ ECXSRecor dVi ew]
Lower CaseSRecor dSave=1

Thiswill make FDT case aware and ensure it saves lowercase filesin their original format.

The above window has aright-click pop-up menu that contains the following items:
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8.8.1 Cut

Thiswill remove the contents of the highlighted block from the window and place it on the
clipboard in the standard Windows® manner. Thisisonly available if ablock is highlighted.

8.8.2 Copy

Thiswill copy the contents of the highlighted block to the clipboard in the standard Windows®

manner. Thisisonly availableif ablock is highlighted.

8.8.3 Paste

Thiswill copy the contents of the Windows”® clipboard into the child window at the current cursor

position.
884 Undo

Reverses the last editing operation on the selected data.
8.85 Redo

Reverses the last undo operation.
8.8.6 Display Unit

Invokes the cascaded menu as follows:

Byte - view the data as 8-hit bytes.

Word - view the data as 16-bit words.

DWord - view the data as 32-bit double words.
8.8.7 Endian

Invokes the cascaded menu asfollows:

Little Endian - view the dataiin little endian format.

Big Endian - view the data in big endian format.

R20UTO508EJ1100 Rev.11.00 < RENESAS
Mar 07, 2012

Page 138 of 216



Chapter 8 Windows

8.8.8 Align to 8 Bytes

Datais displayed on each line as 8 bytes. The number of bytes that can be accommodated on each
line is dependent upon the size of the window. The default for this setting is 'on'.

8.8.9 Toggle ASCII Column
Allows the ASCII column to be removed or displayed.
8.8.10 Create Selection...

Launches the 'Create Selection’ dialog box allowing the user to create a selection area by entering
its start address, end address and length. The selected area can be used in conjunction with the
Clipboard, Fill or Search and Replace.

88.11 Fill...

Launches the 'Fill' dialog box for the current active file to write the specified data to the selected
area. When the 'ASCI| Fill' check box is selected, the data to be written can be specified with
ASCII characters.

88.12 Find...

Thiswill launch the 'Find' dialog box allowing the user to enter either hexadecimal or ASCII data.
The scope of the search is limited to the data within the active file in the Editor window. If a
match is found, the Editor window is updated to display the found data.

8.8.13 Replace...

Thiswill launch the 'Replace’ dialog box allowing the user to enter either the hexadecimal or
ASCII datato be found and the replacement data, in the same format. The scope of the search is
limited to the data within the active file in the Editor window. If amatch is found, the Editor
window is updated to display the found data, click on the now enabled Replace button to replace
the data.
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8.8.14 Properties...
Launches the 'Data File Properties dialog box.
8.8.15 AddtoActive Project

Adds thefile to the active project. This menu item will be disabled if the file is already added to
the project.

8.8.16 Data Entry Note

When entering datain the 'Find', '‘Replace’ or 'Fill' dialog boxes only hexadecimal or ASCII values
can be used, based on the ASCII Search check box. When entering hexadecimal values a
preceding '0x' is fixed in the entry text box, so hexadecimal values are appended.

8.8.17 Goto Address

Double clicking on the address column displays the 'Goto Address dialog. This alows entry of a
hex address to set the hex editor cursor position to. Note that thisis entirely different to the
similarly named kernel command "Go From Address'.
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89 Customise - Toolbars

Invoked by [Tools->Customise...] in the ' Customise’ dialog box.

customise 2
Toaolbars I Meru |
Toolbars:
¥ Show Toclips Hew.. |
Fesst

W 5-Fecord

4] i3

Toalbar name

Figure 8-20 Customise Toolbars Dialog
8.9.1 Show Tooltips

A check mark in the Show Tooltips box indicates that the action of the button will be displayed
when the mouse arrow is pointing to the button. If the box is unchecked, no action is displayed.

8.9.2 New...

The New... button launches the ‘ Toolbar Name' dialog box which allows the user to name and
generate a new toolbar. After entering the new name and clicking on OK, the new name will be
added to the Toolbars list and an empty toolbar is displayed on the interface.

Selecting the Commands tab allows the user to select and add buttons to the new toolbar. The user
can place the new toolbar anywhere on the GUI by dragging it with the mouse.
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8.9.3 Reset

The Reset button resets the toolbar to the default.
894 Toolbar name

Reflects the toolbar selected in the list.
8.9.5 OK

Clicking on OK, in the ‘' Toolbar Name' dialog box adds the new name to the Toolbars list on the
Toolbars window and invokes a blank toolbar on the GUI.

Clicking on OK in the ‘ Customise’ dialog box saves any changes made and closes the dialog box.
8.9.6 Delete

If anew toolbar has been added to the Toolbars list and it is selected, the Reset button is renamed
to Delete. Clicking on this button will remove the new toolbar from the list and from the GUI.
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810 Customise—Menu

Invoked by [Tools->Customise...] and then select the Menu tab in the * Customise’ dialog box.

customise 20x|
Tl:mll:lars] Menu ]
Apolicabon wide bools:

Mame | Werzion |

Workspace vade tools:

Plame | version | dd..

Figure8-21 Customise Menu Dialog
< To add anew menu option:

1. Select [Tools->Customise...]. The dialog shown above will be displayed. Select the “Menu”
tab. Thefirst thing for you to decide is whether you are adding a global application wide tool
(“Application wide tools:”), which will be available to al of your workspaces. Or whether you
wish to add aworkspace wide tool (*Workspace widetools:”), which isonly valid for the
current workspace. Once you have made the choice choose the relevant section of the dialog.

2. Click the“Add...” button. If you would like to add an existing system tool to the menu then
select the “ Select from existing system tools” radio button, choose the tool from the drop-down
list and then click “OK”. Alternatively, if you would like to add atool of your own then follow
the remaining steps.

3. Enter the name of thetool into the “Name” field.

4. Enter the command, excluding arguments, into the “Command” field.

5. Enter any arguments that you would like to pass to the command into the “ Arguments” field.
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6. Enter aninitia directory in which you would like the tool to run, into the “Initial directory”
field.
7. Click “OK” to add the menu option to the “Tools” menu.

Add Tool HE

= Defire new user ool 1]

Tool details:

Hame: ﬂl
|Expl:-!er

Command .

|$P\'H'END!H]\.::nplnlnr.mcl: ’LI _Emwse...l

Arguments ;

| 2

Iritial directony |

|$ITEI'-'IF'DIFII ILI Browse.., |

" Select fiom exisling sustem tools!

|;:-4. Fi Mapyisw [versian 1.00 -|

Figure8-22 Add Tool Dialog

New menu options are added to the bottom of the list (i.e. bottom of the tools menu) by default.
The order of menu optionsin the [Tools] menu can also be modified.
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< To modify a menu option:

1. Select [Tools->Customise...]. The diaog shown below will be displayed. Select the “Menu”
tab.
2. Select the menu option that you would like to modify and then click the “Modify...” button.
3. Makethe desired changes on the “Modify Tool” dialog and then click “OK”.
ModifyTool EHE
Nane
_ Gl |
Command :

|$I'W'I MDIR fexplomer.exe

Argumsiis

] o |

»

Iritia! directan :

|$ITEI'-'IFEJIFI]

LI i

2 To remove a menu option:

Figure 8-23 Modify Tool Dialog

1. Select [Tools->Customise...]. The dialog shown in Figure 6-19 will be displayed. Select the

“Menu” tab.

2. Select the menu option that you would like to remove and then click the “ Remove” button.
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Chapter 9 Simple Interface Mode

Invoked by [Tools- >Simple I nterface...]. Thisis used to ssmplify the look and feel of FDT once
aproject is configured. See Chapter 5 Access Rights for details about using thisin conjunction
with user names and passwords. This chapter describes the full Simple Interface Mode; see
Chapter 10 for details of Basic Simple Interface Mode.

FDT Simple Interface N

Opkions
Project ; | Industial Cordraler
E it
[tevice : | He/2028F Pt COR1
i~ File#image Selecton
% Dowrload Project Image ihsl.rid Controlle¥ Industial Cantiollei i ndustnal Controler.dd
" Diowerdioad File
¥ Uger f Dats fres 1
|- Uzer Hoatisrea J

Fragram Flazh |

Figure9-1 FDT Simple Interface
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9.1 OptionsMenu

91.1 Login...

This allows changing of which user islogged in to FDT. The hotkey Ctrl+Shift+U also invokes
the Login dialog.

9.1.2 Batch Erase Mode...

Thiswill change the dialog box so that the operation is erasure rather than programming. The
‘Program Flash’ button will change to ‘ Erase’, the file\image selection buttons will be disabled
and the programming options will also be disabled. Clicking ‘Erase’ will erase the whole device
(it is not possible to specify the areato erase).

9.1.3 Compare Mode

Thiswill change the dialog box so that the operation is comparison rather than programming. The
‘Program Flash’ button will be replaced by a button labeled ‘ Compare'. Clicking on ‘ Compare’
will start comparison of datain the file with datain the flash memory.

9.14 AutoDisconnect

Thisforces FDT to automatically disconnect after programming (or eraseif in Batch Erase Mode),
so that the user does not need to press the Disconnect button.

9.15 Readback Verify

This option controls whether FDT automatically performs aread and compare operation after
programming. The default setting is taken from the project setting (“ Readback Verification” on the
Programmer tab of the Project Properties window), but the user can override the default by
selecting this menu item.

9.1.6 Request Checksum

This option controls whether FDT automatically performs a checksum request operation after
programming. The setting is remembered between sessions.

9.1.7 Erase Device Before Program

This option controls whether FDT automatically performs an erase operation before programming
the device. Thiswill erase all blocksin all memory areas prior to programming. The setting is
remembered between sessions.
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9.1.8 File Over Warning

The FDT opens a dialog box to confirm whether downloading should continue or be aborted when
the file being downloaded is larger than the size of the ROM.

9.1.9 Erasure of User Boot Area

Select the checkbox to enable erasure of the User Boot Area. Otherwise deselect the checkbox.
Thisoption is only available for devices that support erasure of the User Boot Area.

9.1.10 Security Protection

This option controls whether FDT should security protect (some QzROM devices) or parallel
mode protect (some R32C devices) as it disconnects. Select “ Automatic” to always protect the
device at disconnection. Select “Prompt” to query the user what to do and select “None” to never
protect the device at disconnect. NB —a QzROM protected device cannot be reconnected to.

9111 Set ID Code...

This option alows programming and erasing of ID codes (key codes) for generic boot devices
with intelligent flash security (IFS). For details, refer to section 19, Intelligent Flash Security
(IFS).

9.1.12 Block Locking...

This option allows the user to lock or unlock blocks (for some M 16C-family and generic boot
devices).

9.1.13 Other Properties Settings

Target Power...: The'Target Power Settings dialog box, where the setting can be changed, is
launched.

Auto Send ID...: The'ID check’ dialog box, where the setting can be changed, is launched.

9.1.14 Field Programming->Run Published File...

Unpackage an .fpf4 file and use it in Simple Interface Mode.
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9.1.15 Unique Code Programming...

Allows setup and control of the Unique Code Programming feature within FDT. See Chapter 16
for further details.

9.1.16 About...

Shows the About box.

9.2 Dialog Controls

921 Back to Project

Thisreturnsto the full FDT view. Thiswill be disabled if the user currently logged in to FDT does
not have the ' FDT:Project Edit’ access. [see Chapter 5 for details]

922 Exit

Clicking thiswill exit FDT and FDT will start up in the Simple Interface Mode next timeit is
loaded. Thiswill be disabled if the user currently logged in to FDT does not have the
‘Simplelnterface:Exit’ access. [see Chapter 5 for details|

9.2.3 Download Project Image/ Download Fileradio buttons

These are mutually exclusive and will be disabled if the user currently logged in to the FDT does
not have permission for access to * Simplelnterface:Download File' or * Simplel nterface:Download
Project Image’ . [see Chapter 5 for detailg]

‘Download Project Image':
When this button is selected, the FDT shows the names of image files for downloading.

‘Download File':
When this button is selected, the user can select downloading to the User/Data Area or the User
Boot Area*.

*Not selectable if the device in use does not have a User Boot Area.
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9.24 Compare File-> Device (Compare Device) / Compare File-> Device (File Data
Only) radio buttons

These radio buttons are mutually exclusive and only usable in the comparison mode.

‘Compare File -> Device (Compare Device)':

This mode would compare the data in the device flash (starting at the device start address) to the
corresponding datain the file. The process would only stop once the entire device had been
checked, or differences were found. Areas that are not covered by the file would be assumed to be
OxFF and would therefore require a corresponding blank area on the device to be verified
correctly.

‘Compare File -> Device (File Data Only)':

This mode would compare the data in the file to the corresponding data on the device. Thisis
identical in behaviour to the after-write readback verify process. Areas not covered by thefile
would not be checked. Typically thiswill be afaster operation, as the entire flash does not have to
be uploaded, however, it is therefore aless thorough process.

9.25 Program Flash \ Erase\ Compare

Clicking on Program Flash alows FDT to download the specified file or image to the FLASH
memory. If in Batch Erase mode this button will switch to ‘Erase’ and will perform an entire
device erase. In the comparison mode, the label on this button will be replaced by ‘ Compare’, and
pressing the button will initiate comparison of datain the file and datain the flash memory.

9.2.6 Disconnect
Clicking on Disconnect forces FDT to disconnect.
9.2.7 File Selection

The filename can be specified in the File Selection section by typing directly into the field or
clicking on the arrowed button and then either browsing or selecting from the recently-used list
(which can hold up to four entries).
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Chapter 10 Basic Simple Interface Mode

Invoked from the start menu "Flash Development Toolkit 4.08 Basic'. Thisis used to simplify the
look and feel of FDT and does not need a Workspace and Project. See Chapter 5 Access Rights for
details about using thisin conjunction with user names and passwords. This chapter describes the
Basic Simple Interface Mode; see Chapter 9 for details of the full Simple Interface Mode.

Basic Simple Interface Mode will restore any previous settings on start up. To change the device,
kernel or port settings, the Options- >New Settings& menu will invoke the Wizard to collect the
new details.

FDT Simple Interface i

Options
| BASIC FILE PROGRAMMING Exit
Dravice : | Has/2218UF Pt - LISE Direct
—File Selection
% [owriozd File

[ User / Data fuea ]

™ UzerBoctiifea |

foaram Flash Disconrest

Figure10-1 FDT Basic File Programming
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10.1  OptionsMenu

10.1.1 Login...

This allows changing of which user islogged in to FDT. The hotkey Ctrl+Shift+U also invokes
the Login dialog.

10.1.2 Batch Erase Mode...

Thiswill change the dialog box so that the operation is erasure rather than programming. The
‘Program Flash’ button will change to ‘ Erase’, the file\image selection buttons will be disabled
and the programming options will also be disabled. Clicking ‘Erase’ will erase the whole device
(it is not possible to specify the areato erase).

10.1.3 Compare Mode

Thiswill change the dialog box so that the operation is comparison rather than programming. The
‘Program Flash’ button will be replaced by a button labeled ‘ Compare'. Clicking on ‘ Compare’
will start comparison of datain the file with datain the flash memory.

10.1.4  AutoDisconnect

Thisforces FDT to automatically disconnect after programming (or eraseif in Batch Erase Mode),
so that the user does not need to press the Disconnect button.

10.1.5 Readback Verify

This option controls whether FDT automatically performs aread and compare operation after
programming. The setting is remembered between sessions.

10.1.6  Request Checksum

This option controls whether FDT automatically performs a checksum request operation after
programming. The setting is remembered between sessions.

10.1.7 Erase Device Before Program

This option controls whether FDT automatically performs an erase operation before programming
the device. Thiswill erase all blocksin all memory areas prior to programming. The setting is
remembered between sessions.
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10.1.8 File Over Warning

The FDT opens adialog box to confirm whether downloading should continue or be aborted when
the file being downloaded is larger than the size of the ROM.

10.1.9 Erasure of User Boot Area

Select the checkbox to enable erasure of the User Boot Area. Otherwise deselect the checkbox.
Thisoption is only available for devices that support erasure of the User Boot Area.

10.1.10 Security Protection

This option controls whether FDT should security protect (some QzROM devices) or parallel
mode protect (some R32C devices) as it disconnects. Select “ Automatic” to aways protect the
device at disconnection. Select “Prompt” to query the user what to do and select “None” to never
protect the device at disconnect. NB —a QzROM protected device cannot be reconnected to.

10.1.11 Set ID Code...

This option alows programming and erasing of ID codes (key codes) for generic boot devices
with intelligent flash security (IFS). For details, refer to section 19, Intelligent Flash Security
(IFS).

10.1.12 Block Locking...

This option allows the user to lock or unlock blocks (for some M 16C-family and generic boot
devices).

10.1.13 Other Properties Settings

Target Power...: The'Target Power Settings dialog box, where the setting can be changed, is
launched.

Auto Send ID...: The'ID check’ dialog box, where the setting can be changed, is launched.
10.1.14 New Settings...

Run the Wizard to allow entry of the new settings.
10.1.15 About...

Shows the About box.
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10.2 Dialog Controls
1021  Exit

Clicking thiswill exit FDT and FDT will start up in the Simple Interface Mode next timeit is
loaded. Thiswill be disabled if the user currently logged in to FDT does not have the
‘Simplelnterface:Exit’ access. [see Chapter 5 for detail g

10.2.2 Download Fileradio button

Thiswill be disabled if the user currently logged in to FDT does not have permission for access to
‘Simplelnterface:Download File' . [see Chapter 5 for details]

‘Download File':
When this button is selected, the user can select downloading to the User/Data Area or the User
Boot Area*.

*Not selectable if the device in use does not have a User Boot Area.

10.23 CompareFile-> Device (Compare Device) / Compare File -> Device (File Data
Only) radio buttons

These radio buttons are mutually exclusive and only usable in the comparison mode.

‘Compare File -> Device (Compare Device)':

This mode would compare the data in the device flash (starting at the device start address) to the
corresponding data in the file. The process would only stop once the entire device had been
checked, or differences were found. Areas that are not covered by the file would be assumed to be
OxFF and would therefore require a corresponding blank area on the device to be verified
correctly.

‘Compare File -> Device (File Data Only)’:

This mode would compare the data in the file to the corresponding data on the device. Thisis
identical in behaviour to the after-write readback verify process. Areas not covered by thefile
would not be checked. Typicaly thiswill be afaster operation, as the entire flash does not have to
be uploaded, however, it is therefore aless thorough process.

10.24  Program Flash \ Erase\ Compare

Clicking on Program Flash alows FDT to download the specified file or image to the FLASH
memory. If in Batch Erase mode this button will switch to ‘Erase’ and will perform an entire
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device erase. In the comparison mode, the label on this button will be replaced by ‘ Compare’ and
pressing this will initiate comparison of datain the file and data in the flash memory.

10.25  Disconnect
Clicking on Disconnect forces FDT to disconnect.
10.26  File Selection

The filename can be specified in the File Selection section by typing directly into the field or
clicking on the arrowed button and then either browsing or selecting from the recently-used list
(which can hold up to four entries).
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Thisisafeature designed to assist FDT usersto send their FDT projectsto other FDT users. Once
aproject is configured correctly and the project images are built, FDT can package all required
files (Kernel and datafiles) into asingle file (with an ".fpf4" extension). This can be sent to
another FDT user (using the same version of FDT), who can simply double click on the package
fileto start FDT and unpack the project files. FDT will unpack the files and update the references
to the file paths for the new location, and allow programming of the Project Images using FDT
Simple Interface Mode (subject to the user having the correct access rights).

To publish (create) a package file, select the Project->Field Programming...- >Publish... menu
item when in the full FDT Workspace view. Because a project image is a prerequisite for
publishing aproject, if the project does not have a Project Image built aready, FDT will ask you if
you want to build one now. FDT will then prompt you to select an output directory for the
published package file.

To run a published file, select the Project->Field Programming...- >Run Published File...
menu item from the full FDT Workspace view, or the Options-> Field Programming- >Run
Published File... menu item from the Simple Interface Mode screen. Also, double clicking on a
" fpf4" file from Windows® will start FDT in Simple Interface Mode using the selected package
file

On open, FDT checks the creating version of the package file and will warn the user if thefile
cannot be unpacked and run by the currently installed version. A message box will highlight the
required version to run the package.

FDT will unpack the .fpf4 filesinto the Published Projects subdirectory of FDT.
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FDT Simple Interface '
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Figure1l-1 FDT Field Programming Interface
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11.1  OptionsMenu

11.1.1  Login...

This allows changing of which user islogged in to FDT. The hotkey Ctrl+Shift+U also invokes
the Login dialog.

11.1.2 Batch Erase Mode...

Thiswill change the dialog to be erase based, rather than programming based. The * Program
Flash’ button will changeto ‘Erase’, the file\image selection buttons will be disabled and the
programming options will also be disabled. Clicking ‘ Erase’ will erase the whole device (it is not
possible to specify the areato erase).

11.1.3 AutoDisconnect

Thisforces FDT to automatically disconnect after programming (or eraseif in Batch Erase Mode),
so that the user does not need to press the Disconnect button.

11.14 Readback Verify

This option controls whether FDT automatically performs aread and compare operation after
programming. The setting is remembered between sessions.

11.1.5 Request Checksum

This option controls whether FDT automatically performs a checksum request operation after
programming. The setting is remembered between sessions.

11.1.6  EraseDevice Before Program

This option controls whether FDT automatically performs an erase operation before programming
the device. Thiswill erase all blocksin all memory areas prior to programming. The setting is
remembered between sessions.

11.1.7 FileOver Warning

The FDT opens adialog box to confirm whether downloading should continue or be aborted when
the file being downloaded is larger than the size of the ROM.
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11.1.8 Erasure of User Boot Area

Select the checkbox to enable erasure of the User Boot Area. Otherwise deselect the checkbox.
Thisoption is only available for devices that support erasure of the User Boot Area.

11.1.9  Security Protection

This option controls whether FDT should security protect (some QzROM devices) or parallel
mode protect (some R32C devices) as it disconnects. Select “ Automatic” to aways protect the
device at disconnection. Select “Prompt” to query the user what to do and select “None” to never
protect the device at disconnect. NB —a QzROM protected device cannot be reconnected to.

11.1.10 SetID Code...

This option alows programming and erasing of ID codes (key codes) for generic boot devices
with intelligent flash security (IFS). For details, refer to section 19, Intelligent Flash Security
(IFS).

11.1.11 Block Locking...

This option allows the user to lock or unlock blocks (for some M16C-family and generic boot
devices).

11.1.12 Other Properties Settings

Target Power...: The'Target Power Settings dialog box, where the setting can be changed, is
launched.

Auto Send ID...: The'ID check’ dialog box, where the setting can be changed, is launched.
11.1.13 Field Programming->Run Published File...

Unpackage another .fpf4 file and useit in Simple Interface Mode.
11.1.14 Unique Code Programming...

Allows setup and control of the Unique Code Programming feature within FDT. See Chapter 16
for further details.

11.1.15 About...

Shows the About box.
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11.2  Dialog Controls

11.2.1 Back toProject

Thisreturnsto the full FDT Workspace view. Thiswill be disabled if the user currently logged in
to FDT does not have the ' FDT:Project Edit’ access. [see Chapter 5 for details|

1122  Exit

Clicking thiswill exit FDT and FDT will start up in the Simple Interface Mode next timeit is
loaded. Thiswill be disabled if the user currently logged in to FDT does not have the
‘Simplelnterface:Exit’ access. [see Chapter 5 for details|

11.2.3 Download Project Imageradio button

Thiswill be disabled if the user currently logged in to FDT does not have the
‘Simplelnterface:Download Project Image' access. [see Chapter 5 for details]

11.2.4 Program Flash \ Erase

Clicking on Program Flash allows FDT to download the specified file or image to the FLASH
memory. Additionally, if Readback Verify is switched off, the Checksum will also be calculated
and output to the screen. If in Batch Erase mode this button will switch to ‘Erase’ and will perform
an entire device erase.

11.25 Disconnect

Clicking on Disconnect forces FDT to disconnect.
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Chapter 12 Updating the Adapter Software

When connecting to an E8, E8a, E1, or E20 interface adapter board, FDT will check that the
firmware (adapter software) isthe correct version and correct type for supporting the connection to
the selected device. If there isamismatch then FDT will offer to update the firmware in order that
the connection can be continued. Also if the firmware checksum isincorrect, an update will be
required. Note that in some cases, an update to an earlier version number may be required if the
current version does not support the selected device. It is very important that the interface board is
not unplugged during the update process because this could result in the interface board being | eft
in an erased state.

121 E8and E8a

The E8 and E8a have two firmware areas, a'Level 0' and a'Level 1' (the Bootstub and Adaptor
Software respectively). Typically FDT will only update the Level 1 areabut in some cases a Level
0 update is also required. Thisisusually seen when connecting with an E8 in E8Direct mode (see
Chapter 13 - Interface Boards) for the first time and will result in a dightly different update
process, shown below for comparison (note that the processis similar for an E8a):

Level 0 and Level 1 update:

E8 target power has been set to ON at 5.0V

Connecting to device 'R5F21174' on 'E8'

Confi gurati on:

' BOOT Mbde' connection - using emul ated interface
Opening port 'E8' ...

Checking for E8 update...

Adapt or checksum OK

Processing Data file :'c:\FDT\ ADPFi | es\ E8- Rel -1 ng. not'

M smat ched Boot stub (Level 0) version nunber found (current E8 version
= 0. 00.00. 018, FDT hol ds version 2.00.00.000, FDT requires version
2. 00. XX. XXX)
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FLASH Development Toolkit x|

\i:') FOT will now update the EG/ESa firmware ko a newer version to allow connection ta this device
-

fourrent Bootstub flewvel O) wersion = 0.00.00.018, new version = 2.00.00.000)

Click 2k ko continue

Zancel |

Figure12-1 Update Confirmation Message

Updat e sel ect ed

Adapt or update started (do not unplug)...

Processing Data file :'c:\FDT\ ADPFi | es\ MonpMai n. not "'
Adapt or updat e program downl oaded. ..

Processing Data file :'c:\FDT\ ADPFi | es\ AdpEr ase0. not'
Adapt or erased. ..

Processing Data file :'c:\FDT\ ADPFi | es\ AdpWiteO. not'

Updati ng. ..

Adapt or updat ed successfully

<Connection continues...>
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Level 1 only update:

E8 target power has been set to ON at 5.0V

Connecting to device 'R5F21174' on 'E8'

Configuration:

' BOOT Mbde' connection - using emul ated interface
Openi ng port ' E8'

Checking for E8 update...

Adapt or checksum OK

Processing Data file :'c:\FDT\ ADPFi | es\ E8- Rel -1 ng. not'
Adapt or versi on nunber OK

(current E8 Bootstub (Level 0) version = 2.00.00.000, FDT holds version
2.00. 00.000, FDT requires version 2.00. XX XXX)

Adapt or version type K
(current type = ESEMILATOR)
Processing Data file :'c:\FDT\ ADPFi | es\ E8- Rel -1 ng. not'

M smat ched Adaptor Software (Level 1) version nunber found (current E8
version = 0.02.00. 000, FDT holds version 2.00.00.000, FDT requires
version 2.00. XX. XXX)

FLASH Development Toolkit x|

FOT will now update the E&/ESa firmware ko a newer version ko allow conneckion ba this device
\_¢¢) [current Adapkor Software (Level 1) version = 0,02.00,000, new version = 2,00,00,000)

Click, Ok ko conkinue

Zancel |

Figure 12-2 Update Confirmation Message
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Updat e sel ect ed

Adapt or update started (do not unplug)...

Processing Data file :'c:\FDT\ ADPFi | es\ MonpMai n. not "'
Adapt or updat e program downl oaded. ..

Processing Data file :'c:\FDT\ ADPFi | es\ AdpEr ase. not"'
Adapt or erased. ..

Processing Data file :'c:\FDT\ ADPFi | es\ AdpWite. not'
Updati ng. ..

Adapt or updat ed successfully

<Connection continues...>

122 Eland E20

The E1 and E20 have firmware in two areas. a common emulator area (‘Level 0') and an FDT area
(‘Level 1'). Typically FDT will only update the Level 1 areabut in some casesaLevel 0 updateis
also required. The dialog box shown below appears when the Level 0 area has successfully been
updated. Follow the instruction given in the dialog box.

FLASH Development Toolkit x|

Updating of the firmware has been completed.

If you are using the E1, re-connect the USE interface cable
and dick on the 'OK' button,

If you are using the E20, turn off the power for the emulator.
Then turn on the power again and dick on the 'OK button.,

Figure 12-3 Updated Message
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Chapter 13 Interface Boards

FDT supports a number of interface boards for allowing FDT to communicate with, and control
the mode pins of target devices.

13.1  ES8(incorporating E8Dir ect)

The E8 isa USB debugging and flash programming interface board. It converts the data from USB
to serial, and alows control of up to four I/O pins and the reset signal. It can supply 3.3 or 5.0
volts to the target but the I/O and seria voltage levels must be the same. The E8 has two modes of
operation:

E8 Mode: Thisis the default mode when the E8 is plugged in. In this mode, the pin settings for
controlling the 1/0 pins are predefined.

E8Direct Mode: Thisis ageneral purpose mode of operation where the user specifies the pin
settings for controlling the target 1/O pins. To enter thismode, FDT sends a special command
which causes the E8 to re-enumerate as E8Direct. Once in E8Direct mode, to return to E8 mode
the E8 must be unplugged and replugged.

WARNING: Since E8Direct isintended for use with Renesas Starter Kits (RSK), use of
E8Direct with other boardsisnot supported. E8aDirect also supports use with Renesas
Starter Kits (RSK), Generic Boot devices and some 0.35um devices. Damage may occur to
the hardwareif incorrect settingsare used. It isimportant to always ensur e that the tar get
boar d power is switched off when plugging the connector into the target board.
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13.2  E8a (incorporating E8aDir ect)

Similar to the E8, the E8ais a USB debugging and flash programming interface board. It converts
the data from USB to serial, and allows control of up to six I/O pins and the reset signal. It can
supply 3.3 or 5.0 volts to the target but the I/O and serial voltage levels must be the same. The E8a
board utilises a clock synthesiser to allow higher baud rates and improved baud rate matching
between the interface board and the target board. The E8a has two modes of operation, but
switching between them is automatic:

E8a Mode: Thisisthe default mode when the E8ais plugged in. In this mode, the pin settings for
controlling the mode pins are predefined.

E8aDirect Mode: Thisisageneral purpose mode of operation where the user specifiesthe pin
settings for controlling the target 1/O pinsin asimilar manner to the E8Direct.

Note that when actively connected to an E8a, FDT will display details of the active E8a seria
number in the status bar.
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13.3  E1(incorporating E1Direct)

The E1 isa USB debugging and flash programming interface board. It converts the datafrom USB
to serial, and allows control of up to six 1/0O pins and the reset signal. It can supply 3.3 or 5.0 volts
to the target but the 1/0 and seria voltage levels must be the same. The E1 board utilises a clock
synthesiser to allow higher baud rates and improved baud rate matching between the interface
board and the target board. The E1 has two modes of operation, but switching between them is
automatic:

E1 Mode: Thisisthe default mode when the E1 is plugged in. In this mode, the pin settings for
controlling the mode pins are predefined (but the FDT does not support this).

E1Direct Mode: Thisisageneral purpose mode of operation where the user specifies the pin
settings for controlling the target 1/O pins.

Note that when actively connected to an E1, FDT will display details of the active E1 seria
number in the status bar.
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13.4  EZ20 (incorporating E20Dir ect)

The E20 isa USB debugging and flash programming interface board. It converts the data from
USB to serial, and alows control of up to six 1/0 pins and the reset signal (when the 38-pin to 14-
pin conversion adapter isin use). The E20 board utilises a clock synthesiser to alow higher baud
rates and improved baud rate matching between the interface board and the target board. The E20
has two modes of operation, but switching between them is automatic:

E20 Mode: Thisisthe default mode when the E20 is plugged in. In this mode, the pin settings for
controlling the mode pins are predefined (but the FDT does not support this).

E20Direct Mode: Thisisageneral purpose mode of operation where the user specifiesthe pin
settings for controlling the target 1/O pins.

Note that when actively connected to an E20, FDT will display details of the active E20 seria
number in the status bar.
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135 E8Firmwareand Devicel D

When plugged in initially the E8 will report itself as a Renesas E-Series Device.
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[Ergd DVDJCD-ROM drives
[# =% Floppy disk controdess
¥ 5h Flappy disk drives
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& Kewboards
[+ ) Mice and ather poinbing desiceas
= B Monitors
[+ B8 Nebwork adapters
- Ports (COM & LFT)

=

emasas Emulator
«# Rienesas E-Series |16 Driver
i 505] ard RAID cortrafers
€} Sound, video and game conftrolers
[+ g‘é System devices

Uriversal Serial Bus controlers

[ |

Figure13-1 Initial E8 enumeration

To use the E8Direct functionality the E8 must be restarted, atask done automatically by FDT
during a connection operation (which may involve afirmware upgrade, see Chapter 12 — Updating
the Adapter Software). The Output window will contain the following messages

Preparing for re-enuneration of E8 to E8Direct. ..
Sendi ng re-enuneration command. ..
Request sent successfully, closing E8 Comms. ..

At this point the E8 will re-identify itself to Windows as an E8Direct device.

NOTE: It will remain as an E8Direct device until next unplugged or the machine is powered
down.
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'3, Device Manager
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Figure 13-2

E8Direct enumeration
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136 Pins
Pin No. E8 Direct Pin Name E8a Direct Pin Name

1 CQut put D CQut put D

2 GN\D GN\D

3 Qut put C Qut put C

4 CQut put A CQut put A

5 Target Txd (I nput from Txd of Target Txd (I nput from Txd of Target

Target device to RxdO of device to Rxd0 of 2215RUF on EB8a)
2215UF on E8)

6 G\D (Connected to G\D on E8) Qutput E

7 Cut put B Cut put B

8 UVCC (can supply 3.3 or 5V or UVCC (can supply 3.3 or 5V or detect if

detect if target is powered) target is powered)

9 BUSY (Not used for E8Direct) BUSY\ UVCC2 Serial voltage input (for
CLK, Data, Tx & Rx - can supply 3.3 or 5V
or detect if target is powered)

10 G\D (Connected to G\D on E8) Qutput F

11 Target Rxd (Qutput to Rxd of
Target device from Txd0 of
2215UF on E8)

Target Rxd (Qutput to Rxd of Target
device from Txd of 2215RUF on E8a)

12 G\D (Connected to G\D on E8)

G\D (Connected to G\D on E8)

13 RESET

RESET

14 UCONNECT (Connect to GND on
Tar get board)

UCONNECT (Connect to GND on Target
boar d)
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El E20
PinNo. | pin Name Pin Name (14 Pins of the Conversion | Pin Name (38 Pins)
Adapter)
1 i 04 i 04 iol
2 G\D G\D i 02
3 i 05 i 05 i 00
4 i 00 i 00 -
5 SEND SEND UCONNECT
(connected to
G\D on the
target board)
6 iol iol -
7 i 03 i 03 -
8 UCC (can supply 3.3 or 5 uvce i 03
V or detect if target is
power ed)
9 UVCC2 (can supply 3.3 or 5 | uvCC2 RESET
V or detect if target is
power ed)
10 io02 io2 -
11 RECEI VE RECEI VE SEND
12 G\D GN\D -
13 RESET RESET -
14 UCONNECT (connected to GND | UCONNECT (connected to G\D | UVCC
on the target board) on the target board)
15 i 04
16 -
17 uvee2
18 -
19 RECEI VE
20 -
21 i 05
22 -
23 -
24 -
25 -
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26

27

28

29

30

31

32

33

34

35

36

37

38

“-": The pin which FDT does not use
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Chapter 14 QzROM Programming

QzROM isanew type of programmable flash memory, found in some 4 and 8 bit MCUs. Itis
based most closely around the Protocol D style device but has several important differences:

One time programming - each byte of QzZROM can only be written once.

QzROM cannot be erased - there is no erase command.

Security Protection - QzROM has security protection. After protection, attempts to start the
target MCU for connection can result in an error status, i.e. further reads from (or writes to) the
device are not possible.

Blank check - QzROM has a Blank check command whereas other Protocol D devicesdon't. If
Device Protection is set to “ Automatic” or “Interactive” FDT will use thisto check the device
write state before programming.

FDT isaware of QzZROM based on the device that is configured for the project.
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14.1 Reserved Areas

QzROM introduces the concept of ‘reserved areas’ into FDT, for example the M37545G4 has an
8-byte reserved areawithin the ROM. A reserved areais a defined area of Flash that FDT will not
read, write or blank check. Within the Hex Editor these reserved areas are shown as a series of

‘**’ characters.

«* userarea,MOT - [DxDR00fod] - |0l x|
ooo0ff0d 75 ?5 75 PS5 75 P5 75 75 75 75 78 vuiiuuuiuvau :ﬂ
QO00fE18 75 ?5 75 75 75 75 75 75 75 75 75  uuuuuuuuuuu
D000fE23 75 7?5 75 725 75 75 75 7% 75 75 7%  uuuuuuuiaau
0DD0ff2e 75 ?5 75 75 75 ?5 75 75 75 75 75 uuuuuuuiuuu
DODNfE3e 75 75 75 75 75 75 75 75 75 75 75  uuuuuuuiuuu
gDDoOff44 75 P55 75 7R Y5 75075 75 75 75 75 wuuunumiguu
DO0D0ff4f 75 7?5 75 75 75 75 75 75 75 75 75  uwuuuuuuivau
0ND0ffSa 75 75 75 Fh 75 7575 75 V5 75 75 vuuunuuuuuu
gDDoffes 75 ?5- 75 PR 5 F5 75 75 75 7R V5 guauuuauumiuuiu
ODDOfE70 75 75 75 Y% 75 P9 75 75 7% V5 V5 uuauuuuusuauauw
onDoff7b 75 PS5 75 7R 75 75 75 75 75 75 75 unumuuuiuuu
go00ffEe 75 75 75 75 75 ?5 75 75 75 75 75 vuuuuuuiuaau
0NDOfE91 75 75 75 P75 OVD 75 75 75 75 75 75 uwauuuuuuuuy
ODD0fES9e 75 75 75 75 75 75 75 75 75 75 75 uuuwunmuiguu
0DDOffa? 75 75 75 75 75 ?5 75 75 75 75 5 uuuuuuuuuuu
onoDoffb2 75 75 75 P 75 5 75 V5 75 75 75 unuuuuuuiuuug

o000t §bd 7t ” 5 LR F LTS RV FRRRLFAT

0000t fcs CVEL R RRFFTRARRR TR
noonifdg uu
onooffde= el
gnooffex 7 3 FETFTRAFRFEFIFARRF AN
O0OOfEEL 25 75 75 75 FE WLoT7L ¥R OFS 75 [FTEIVAVRFFIRARRN EFY :Ej
L] I :ll. User Flash |

Figure14-1 Hex Editor view of Reserved Area

Any attempt to type or copy data, etc. into these areas will be ignored, as will attempts to copy
dataout. Files saved from this view will have no data for these areas (internally FDT treats this

data as OxFF despite what may be read in).

14.2  Security Protection

QzROM also introduces the concept of Security Protection into FDT, which isoptionally set as

FDT disconnects (Note — once set, this cannot be undone).

For more information, please see the section on ROM Code Protection.
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Chapter 15 Locking

15.1  Locking Overview

Locking of erase blocks against writing or erasing is a feature supported by some of the M16C
family devices and some of the Generic Boot devices.

FDT offers control over these locking settings at connection, disconnection and during normal
operations. The options are available from atoolbar button and a menu entry:

2o | E 2

Figure15-1 Toolbar Button

%" Connect ko Device Chrl4-Ale+-C

ﬁz [scanmect

7 Erase FLASH Blocks Chrl+-Al+E
¥ Blank Check Chrl+AlE+HE
ﬁfﬁ pload Image Chrl+alk+H
$ Download Ackive File Chrl AP
¥ FLAsH Checksum i+ AlE+S
e,

%ﬁ Block Locking. .. kAl +L

. Cancel Operation Chrl+Break

}lé Configure Flash Project alt+3hift+R,

Figure15-2 Menu Entry

Each erase block that supports the feature can be locked and unlocked individually (Note: an
unlock can only be performed by erasing the block). However, the setting will have no effect until
disconnecting to the device. The lock status of each erase block can be set automatically at

disconnect by FDT.
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15.2  Connection

If FDT is connecting to a device that supports the locking feature it will check the current locked

state of each erase block that has a corresponding lock bit (as defined in the project configuration
file). Then, depending on the current connection setting (selectable from the Locking Dialog - see
section 15.3), FDT will do one of three things:

1. Automatically Disable Locks

FDT will automatically disable the locking of device on connection. Thiswill allow all blocks
on the device to be written or erased - whether they are currently locked or not.

2. Query User
FDT will ask the user what to do about the locking of the device on connection:

Flash Development Toolkit x|

P The device reports ane ar more erase blocks are currently locked
2)

Should FOT kemporarily disable this locking ko allow erase and program?

Yes Mo |

Figure 15-3 Query on Connection Message

If "Yes" isclicked, then the locking will be disabled, asin (1). If "No" is selected then the
locking settings will be left alone, as below.

3. Do Nothing

FDT will not change any of the current lock settings on the device. Subsequently, FDT will
abort the operation if an attempt is made to write or erase to alocked block.
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15.3 Locking Dialog

The Locking Dialog, accessible from either the toolbar or the 'Device->Block Locking..." menu,
controls how FDT behaves with those devices that support protected erase blocks. The dialog,
with example device is shown below:

Block Locking x|
—0On Connect—————On Disconnect
What should FOT do by Lock Bit State | State At Dizconnect | ihat should FDT do by default
default when connecting to -5, e when disconnecting fram a
a device with locking EE% lzer Flash ; device with locking ability?
ability? © LB EBS Locked
Dizable Locks Unlocked
L { Aillows write & erase) Locked (" Set Locks/Unlocks
; Unlocked
] Cuery User To Set
o Lacked o Locks/Unlocks
g Unlocked
¢ Da MNathing Unlacked ¢ Da MNathing
Unlacked
Unlocked
..... I~ | Enable Editine
oK I Cancel

Figure 15-4 Block Lock Configuration Dialog

1. On Connect
The left hand side of the dialog controls how FDT behaves as it connects to a device with
locking ability. See more on thisin the Connection section.

2. On Disconnect
The right hand side of the dialog controls how FDT behaves as it disconnects from a device
with locking ability. See more on this in the Disconnection section.
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3. Lock Bit State Tree View

The central part of the dialog shows the lock bit status of the device as atree view, similar to
the Erase Blocks Dialog. The view highlights several important pieces of information:

Lock Bit State | State At Disconnect
=%, MyDevice
=1-%, User Flash Loclked at
Locked -8, FBS Locked =" Jisconnect
- 1EB7 Unlacked
&Y EBE Locked
Unlocked 1EES Unlacked
-8 BB Locked TUnlocked at
- 1EB3 Unlocke] s——
: Unlocked disconnect
Unlacked
Unlocked

Does not support
locking

Figure 15-5 Lock Bit State Tree View Settings

L ock Bit State

The 'Lock Bit State' column shows the lock bit state of each erase block. There are two symbolsto
show this state:

D the erase block was found to be locked
i_i- the erase block was found to be unlocked

The erase block may have no symbol at all and be greyed. Thisisasign that the block does not
have locking support. Thisis automatically detected by FDT from the project configuration file.
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State at Disconnect

The 'State at Disconnect' column shows what the lock bit state of each erase block will be set to
when FDT disconnects from the device (assuming that the user does not select the 'Do Nothing'
radio option). There are two possible values:

Locked - the erase block will be protected at disconnect.

Unlocked - the erase block will be unprotected at disconnect. NB - if the block was locked at
connection FDT will have to erase the block to unlock it. This action will be confirmed as
necessary (see the Disconnection section).

If the erase block does not support locking this entry will read "N/A". By default the disconnect
state will mirror the lock bit state found at connection. To change this default, check the 'Enable
Editing' box next to the tree view. Thiswill enable the view and allow the disconnect settingsto be
changed. Double-clicking the setting will toggle its current state.

Note - if FDT is not yet connected to the device then thistree will be blank. In addition the 'Enable
Editing' checkbox will be unavailable.
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15.4  Disconnection

Depending on the current disconnection setting (selectable from the Locking Dialog - see section
15.3), FDT will do one of three things when a user chooses 'Disconnect’ from the toolbar or menu:

1 Set

As part of the disconnection process FDT will automatically lock and unlock those blocks
specified in the locking dialog. NB - should locked blocks need unlocking FDT will prompt to
confirm the action as it would require those blocks to be erased.

FLASH Development Toolkit x|

&, FOT will unlack the Fallowing Blacks, buk Ehis will require them to be erased:
.\_ﬁ

EE4 (0:x000FS000 - 0x000F3FFF)

Conkinue?

Yes Mo

Figure 15-6 Erase Confirmation Message

If the user selects"Yes' FDT will lock and unlock as appropriate. If the user selects"No" then
no erase will occur and no locks will be set - however, the disconnection operation will
continue.
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2. Query User
If the Query user option is selected then FDT will display alimited view of the Locking
Diaog. This showsthe lock bit state of the device, and the lock bit state of the device asit will
be set at disconnection. This state can still be edited at this point by checking the 'Enable
Editing' checkbox. Two other options are given, set the locks or do nothing (the default):

Block Locking x|

—i0n Disconnect

Lock Bit State | State At Dizconnect | What should FOT da with the
= % R — o | block locking zettings now?
=%, User Flazh —
% EBS Locked
; IInlocked
L;c?qcede " Set Locks/Unlocks
Unlocked
Buery [zer To Set
Lacked O o A ol
Unlocked
Irlacked + Do Mothing
IInlocked
IInlocked

(]9 I Cancel

Figure 15-7 Query on Disconnect Dialog

Selecting to set the locks will cause FDT to lock and unlock the blocks as appropriate - asin
(2) above. Selecting to do nothing will cause FDT to ignore any locking settings and skip
straight to the disconnection process - asin (3) below. Clicking 'Cancel’ at this point will
cancel both the dialog and the disconnect operation as awhole.

3. Do Nothing

FDT will issue no lock or unlock commands and the device will be left in its current locking
state. The disconnection process will happen as normal.
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Chapter 16 Unique Code Programming

Unigue Code Programming is afeature to allow FDT to program an automatically incremented
code into an area of flash. The typical application of this feature would be for serial numbering.
The numbering process is controlled from a user specified external file.

When in normal FDT project mode, Unique Code Programming is enabled, disabled and
configured from the Tools menu by [Tools- >Unique Code Programming...].

When in Simple Interface Mode, then the same dialog can be found via the [Options— >Unique
Code Programming...] menu. Unigue Code Programming is not available when in Basic Mode.

Once enabled, for every programming action, FDT will add in a specified serial number and
automatically iterate to the next number on the following programming run. This serial number
inclusion will be accounted for in any read verification or checksum operation. Additionally, the
whole process can also be incorporated into the scripting language for automated control.

When the end of the external fileisreached (or the specified end value within the file) FDT will
halt programming operations until the project is closed and reopened (if in "Restart on Session”
mode) or the index is manually reset (if in "User Specified" mode).

The current status of the Unique Code Programming feature can be found in the status bar:

Qﬁ---ﬁﬁw;nﬁﬁz NE3T 0003 )

Figure16-1 Unique Code Status I ndicator

When the feature is enabled, the status shows the previously programmed unique code and the
value of the next to be used. When the feature is disabled this status will be blank.
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16.1  Configuration Dialog

x
' Enabled " Digabled o |
— Filz Lozation
Code File : | workhcodefile. tat Browse... |
— File Start Point
£~ Restart on Sezsion {*' Cantinue From Previous & User Specified
Mext Indesx : [blank for file start] End Index : [blank for file end)
|1 oo |
<Sample Senal Value: <Sample Seral WV alue:
— Data Ovenrite
¥ Continue " Abort

Figure 16-2 Unique Code Configuration Dialog
16.1.1 Enable\Disable

These radio buttons control whether FDT will use the Unique Code feature. The remainder of the
settings will be inactive until thisfeature is enabled.

16.1.2 FileLocation

The unique codes are read from alist within the file specified in this edit field. The "Browse..."
button can be used to manually look for the file or the file can be directly dropped onto the dial og.
FDT does not assume any file extension, but the file must be text based. See section 16.2 for more
details on the file structure.
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16.1.3 File Start Point
These options determine how FDT reads the data out of the specified code file:
16.1.3.1 Restart on Session

FDT will start at the beginning of thelist (in the code file) and continue iterating through each
valuein thelist until it reachesthe end. Every time FDT isrestarted it will begin again at the start
of thelist.

16.1.3.2 Continue From Previous\ User Specified
This allows a subset of values from the code file list to be used.

Next Index: thisisthe (inclusive) value of the index that FDT should use as the next point for the
unique code programming. FDT will attempt to look up the value associated with thisindex and
display the result below the edit field. To automatically start at the start of the codefilelist, leave
this value blank (" Start-Of-File" will be displayed below the edit field). After a successful
programming run this number will be iterated to the next index in the code file list. This updated
starting point will be saved between FDT sessions.

End Index: thisisthe (inclusive) value of the index that FDT should use as the finishing point for
thelist iteration. FDT will attempt to look up the value associated with thisindex and display the
result below the edit field. To automatically read through to the end of the codefilelist, leave this
value blank ("End-Of-File" will be displayed below the edit field).

16.1.4 Data Overwrite

FDT will insert the unique code at the memory location specified in the code file. If datais already
found at thislocation, in the datafile to be programmed, there are two options to control how FDT
will react:

Continue: the unique code will be written into the specified location in the programming data and
any existing entries at this location will be overwritten.

Abort: if aconflict is detected the programming will be aborted
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16.2 FileFormat

FDT expects the unique codefile list to be text based; have a header section detailing where and
how to write the unique codes and finally a paired list of index and unique code values. The data
can be tab, space or comma delimited. Any line beginning // will be treated as a comment line and
ignored. Additionally, any line containing wholly whitespace will also be ignored.

16.2.1 Header section

format Describes how FDT should interpret the unique code values stored in the list. Valid
values are:

ASCI| (codes 0x20 to OX7E)

Hex

area Indicates which 'Memory Area FDT should add the unique code into. Valid values
depend on selected device, but include:

User Flash

User Flash 1

User Flash 2

Data Flash

User Boot Flash

address The address within the specified Memory Areathat FDT should write the unique
code into. The valueis assumed to be hexadecimal based and can have aleading Ox
orH'

size The valueis the decimal number of bytes that will be written at the specified
address (i.e. for ASCII format "one file character = one byte" but for HEX values
"onefile character = one nibble" )

The header section should be found at the start of the file. Each specifier should be on a separate
lineand FDT expects al fieldsto be detailed (although it will assume "User Flash" for the area).
The values should be tab(s), space(s) or comma delimited.
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16.2.2 Code Section

Thelist of unique codes is denoted using the heading pair of Index and Data. The following pairs
are the index of the code and the code itself, e.g.

index data

000001 ACD?24000001
000002 ABD?24000002
000003

The code section is assumed to be everything after the "index" and "data" pair - with each new
code on a separate line. The index does not have to start at 0, but is assumed to be decimal and
increment contiguously. The separation between the index value and the data value should be

tab(s), space(s) or acomma.

16.2.3 ExampleFile
/1 config info
format HEX

area User Fl ash
address 0xFO00

size 6

/1 code |ist

i ndex data

000001 ABCD24000001
000002 ABCD24000002
000003 ABCD24000003
000004 ABCD24000004
000005 ABCD24000005

...comment line, for information only

...specify formatting for the data section of thefile
...datawill bewritten into the"User Flash" area
...datawill be written at address OxFO00 in "User Flash"
...datawill be read in as 6 byte blocks from the data section below
...empty line (ignored)

...comment line, for information only

...header pair for data (denotes start of list)

..first index and data - 6 bytes as specified by 'size' above
...second index on new line

...third index

...fourth index

...final index for this set
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Chapter 17 ROM Code Protection

171 QzROM Devices

QzROM introduces the concept of Security Protection into FDT, which isoptionally set asFDT
disconnects (Note once set, this cannot be undone).

The majority of devices have two levels of protection, Full (which prevents any later reconnection
to the device) or None (which allows reconnection normally). Newer devices have more levels -
allowing a partia protection of the device and yet still allowing alater connection (but with the
protected data region masked).

There are three options for the setting of security protection:

1. Automatic FDT will protect the device asit disconnects. The level of protection will be
determined when Automatic isinitialy selected, typically Full. If the device offers multiple
levels of protection then adialog will appear to allow the user to select the level that should
automatically be applied:

Protection Type

* Pratect on Dizconnect

Cancel |

" Do Mothing

Figure17-1 Automatic Protect choice
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2. Prompt FDT will ask what to do during the disconnect, i.e. whether to protect or not. The
choice is between full protection (or other levelsif supported by the device) or no protection at
al. The default is No.

Protection Type )

i~ Protect on Dizconnect

I .ﬂ h Cancel |

&+ [io Mothing

Figure 17-2 Disconnect Protect choice
3. None FDT will not protect the device on disconnect.

As the disconnect actually happens the result of the operation will be echoed to the Output
window. There are several ways of changing this setting depending on the current mode of
operation:

17.1.1  Toolbar

In full FDT mode and with aQzROM based project the Protection toolbar will be enabled. This
shows the currently chosen option, which can be changed by simply clicking on an adjoining icon.

& & & &
Figure17-3 Automatic
& | & | &
Figure17-4 Prompt
& & & &

Figure17-5 None
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Note clicking on the icons will not immediately protect the device. Thisis still merely the current
disconnect setting.

17.1.2 Project

It isaso possible to change this option from the project properties dialog, as well as viewing the
current setting. Thisis done from the Programmer tab:

Flash Properties — Industrial Controller =
Property I "Walue

security Protection

Device Protection futomatic
Mezzage Level Hiegh
RFeadback erification Mo

Fezet on Disconnect Mo
Connection Reset NS
Feinterrogate on Connect [\IIF'.

File Crwer Warning Yes

Erazure of Uzer Boot Area Mo

Function Map :
Wik ite M
Fead NS
Eraze M
Blark Check, M A
Data Buffer [k niown
Bytes fvailable [nknomr

‘rampt

e

| ]
lr\. Kermel }1. Communications }1. Drevice }-..Prngrammer Modules

Figure 17-6 Security Protect property

Double clicking on the Security Protection field will bring up anew dialog allowing the entry to

be changed.

Protection Type

™ Pratect on Dizconnect

I 02000 - 0=FFFF [Ful]

.ﬂ Cancel |

' Prompt on Dizconnect

" Do Mothing

Figure 17-7 Security Protect dialog change
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17.1.3 Simplelnterface\ Basic Mode

Should the user be in amode where only the Simple Interface dialog is accessible, this setting can
instead be changed via a menu option.

FDT Simple Interface (Supported Version)
COptiohz

Logif...

mMAB0EE0E
Blatch Erase Made ;

| : Exit |
Gempsrs Yade Port : | EBa: (Disconnected)

AutoDizconnect

Readback Werify

Request Checksum

Etase Device Befare Prosram
File Owver Warning

'esas¥ FDT4 D3¥Wwiork spaces¥ 0z ROMYEMIZDEEDI¥MIZDEE0E ddi

» |
Erasure of User Book Area
Security Protection Butomatic b |
Set [0 Code.. » Prompt
Slock: Lucking.. hone m Flazh | [Mizconnect |
Other Properties Settings K
Field Proeramming 4

Unigue Code Programming...

About...

Figure 17-8 Security Protect Simple I nterface

The check mark shows the currently selected option. Note these menu options will be disabled if
the project is not QzZROM based.
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17.2  R32C Devices

The operation of this command isvery similar to QzZROM Security Protection in that the same
toolbar and dialog options are used. However, the important differenceis that, even when Parallel
protection mode is set, FDT's ability to connect, read, erase, program, etc. the device is unaffected.
The protection will only disable ROM reads when connected via a parallel interface.

There are three options for the setting of security protection (which are set as FDT disconnects):

1. Automatic — FDT will protect the device asit disconnects:

2. Prompt — FDT will ask what to do during the disconnect, i.e. whether to protect or not. The
choice is between full protection or no protection at all. The default is*No'.

Protection Type

" Protect on Disconnect

I .ﬂ Cancel |

*' [io Mothing

Figure 17-9 Disconnect Protect choice
3. None—FDT will not protect the device on disconnect.

As the disconnect actually happens the result of the operation will be echoed to the Output
window. There are several ways of changing this setting depending on the current mode of
operation:
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17.2.1 Toolbar

In full FDT mode the Protection toolbar will be enabled. This shows the currently chosen option,
which can be changed by smply clicking on an adjoining icon.

ProtectionMINE
& & & &
Figure17-10 Automatic
& | & &
Figure17-11 Prompt
& & |eF| o

Figure17-12 None

Note: clicking on the iconswill not immediately protect the device. Thisis still merely the
current disconnect setting.
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17.2.2 Proj ect

It isaso possible to change this option from the project properties dialog, as well as viewing the

current setting. Thisis done from the Programmer tab:

Flash Properties — Industrial Controller =
Property I "Walue

security Protection

Device Protection futomatic
Mezzage Level Hiegh
RFeadback erification Mo

Fezet on Disconnect Mo
Connection Reset NS
Feinterrogate on Connect [\IIF'.

‘rampt

File Crwer Warning Yes

Erazure of Uzer Boot Area Mo

Function Map :
Wik ite M
Fead NS
Eraze M
Blark Check, M A
Data Buffer [k niown
Bytes fvailable [nknomr

4 |

4
lr\. Kermel }1. Communications }1. Drevice }-..Prngrammer & Modules I|-|I

Figure 17-13 Security Protect property

e

Double clicking on the “ Security Protection” field will bring up anew dialog allowing the entry to
be changed.

Protection Type ™

™ Pratect on Dizconnect

| 048000 - O4FFFF [Full =l

Cancel |

' Prompt on Dizconnect

" Do Mothing

Figure 17-14 Security Protect dialog change
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17.2.3 Simple Interface\ Basic Mode

Should the user be in amode where only the Simple Interface dialog is accessible, this setting can
instead be changed via a menu option.

FDT Simple Interface (Supported Version)
COptiohz

Logif...

REFG4110
Batch Eraze Mode ;

| : Exit |
Gempsrs Yade Port : | EBa: (Disconnected)

AutoDizconnect

Readback Werify

Request Checksum

Erase Device Before Prosram
File Owver Warning

|Renesas¥FDT4DE¥Wnrkspaces¥REQG¥R5F541 10¥REFE4110.ddi

» |
Etasure of lser Book Area
Security Protection Butomatic b |
Set [0 Code.. » Prompt
Block Locking... M )

ook osking one m Flazh | [Mizconnect |

Other Properties Settings K
Field Proeramming 4

Unigue Code Programming...

About...

Figure17-15 Security Protect Simple Interface

The check mark shows the currently selected option. Note — these menu options will be disabled if
the device does not support protection.
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Chapter 18 Windows Vista® and Windows” 7

Changes made to FDT to support the Windows Vista® and Windows”® 7 operating system have
affected both the installation of FDT and the subsequent layout of files. In summary, to install or
maintain FDT, a user should be running in Administrative mode. However, for daily use, FDT
now supports being run by the "Limited User" type.

18.1 Installation

Installation requires an Administrator level user to complete properly. Thisis primarily because of
theinstallation of USB drivers and of the requirement to write to the protected "Program Files"
area (assuming the default path is chosen). Aswell asinstalling the main application, support files
will also automatically be installed to the following default locations:

XP = C:\Documents and Settings\All Users\Application Data\Renesas\FDT4.08
Vista\7 = C:\ProgramData\Renesas\FDT4.08

NB - depending on system setup, the user may also be warned that the driversinstalled by FDT
are unsigned.

18.2 FDT usage
On execution, FDT will aso create support filesin the users own home directory:

XP = C:\Documents and Settings\<user>\Local Settings\Application Data\Renesas\FDT4.08
Vista\7 = C:\Users\< user>\AppData\L ocal\Renesas\FDT4.08

The key benefit to this user-based approach is that many more FDT settings will now be specific
to the currently logged on user, e.g. recently used workspaces and files. Additionally, the default
Workspaces directory will now no longer be found in the protected "Program Files' area.

18.21 AccessRights

The Access Rights feature is no longer available when running under Windows Vista® and
Windows® 7. The feature was removed in preference to the User Access Control built into the O/S.
If control is needed over who has access to files or workspaces then these should now be located
in the protected or shared areas provided by default in the O/S.
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Chapter 19 Intelligent Flash Security (IFS)

19.1 Outline

Some generic boot devicesinclude the intelligent flash security (IFS) facility for protecting the
flash ROM from programming or erasure. The FDT providesthe ‘ Set ID Code’ option for writing
and erasing ID codes (key codes). Thisis controllable while the FDT isin normal operation or not
connected to the device. When the settings for this option are altered, however, the new settings
only become active when the FDT is disconnected from the device. This option isavailable as a
toolbar button and a menu item (these are not effective for devices that do not have the IFS
facility).

F ¥ T 2 e U)o | s

Figure19-1 Toolbar Button

r&a Connect to Device Citr [+ A [+
‘@: [izzonnent

ﬁ Eraze FLASH Blocks Cirl+At+E
ﬁ?? Blank Check Cirl+alt+B
¢ * Upload Image Crl+ &+
‘rf? [awnlead| Active File Ctel+alt+R
¥ FLASH Checkzum Ctrl+Blt+5
80 Go From fddress.. e+ GG
= Eun Cirl+ AR
€47 Block Lacking.. Cirl+Alt+L
16 Set ID Code.. Cirl+A1t+T
. Cancel| Operatian G+ Break
}'? Confieure Flazh Project Alt+sShift+R.

Figure19-2 Menu Option
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19.2 1D Code Settings Dialog Box

To open the ‘1D Code Settings' dialog box, click on the ‘ Configure ID Code' toolbar button and
select [Device-> Set ID Code...], or select the corresponding menu options in Simple Interface
Mode or Basic Simple Interface Mode. This dialog box allows you to make detailed settings for
programming or erasing of the ID code.

ID Gode Settinegs x|

—0n Digoonnect

f* Wirite D Code " Eraze ID Code What should FOT do by default
when dizconnecting fram a
1D Code device with 1D Code?

Security Level I 1
+ Get 1D Code!

High 8 Bytes: |D123456?BBabGDEF
e Cery User To Set ID

Lowe 8 Bytes: I]QSM.ECDEFDDDDDD Cinde

Save D Code |  Load ID Code | € Do Nathine

(0] 4 I Cancel

Figure 19-3 1D Code Settings Dialog Box
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Iltem Description

Write ID Code Select thisitem to write an ID code. This button activatesthe ‘1D
Code' group box in which the ID code can be entered (default:
selected).

Erase ID Code Select thisitem to erase the ID code (default: non-selected).

Security Level Specify the security level (default: 1). Thisvalue must be a 1-digit
decimal number (0-9).

High 8 Bytes Enter the higher-order 8 bytes of the ID code (default: al digits

‘F'). Thisvalueisin hexadecimal notation.

Note: If the value entered takes up less than 8 bytes, the FDT will
automatically pad the value with OxFF from the left.

Low 8 Bytes Enter the lower-order 8 bytes of the ID code (default: all digits
‘F’). Thisvaueisin hexadecimal notation.

Note: If the value entered takes up less than 8 bytes, the FDT will
automatically pad the value with OxFF from the | eft.

Save ID Code Selecting this item opensthe ‘ Save ID Code' dialog box. The ID
code will be saved in the specified * fid file.

Load ID Code Selecting thisitem opensthe ‘Load ID Code' dialog box. The ID
code will be loaded from the specified * .fid file.

Set ID Code The ID codeis automatically written or erased in accord with the

settings when the FDT is disconnected from the device.

Query User To Set ID Code The 'ID Code Settings' dialog box appears again when the FDT is
disconnected from the device.

Do Nothing The ID codeis not written or erased when the FDT is disconnected
from the device.

Note: The FDT erasesthe ID code currently stored in the device before writing anew ID code.
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19.3 Actionin Caseof an Error

The dialog box shown below appears when writing or erasing of the ID code has failed. Clicking
on‘Yes disconnectsthe FDT from the device. Clicking on ‘No’ cancels disconnection of the FDT
S0 that you can start the process of setting an 1D code again.

FLASH Development Toolkit x|

"'-, ID Cade setting Failed
[

Do you wish to disconnect From the device?

Figure19-4 Error Message
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Chapter 20 Upgrading to FDT 4.08

Installing FDT 4.08 should not adversely affect your other FDT version installations. The USB
drivers may be upgraded by installing FDT 4.08, and the Access Rights usernames and passwords
will be common, but these are the only shared components. Each version of FDT installsits own
set of kernels and keeps its own settings. Installing FDT 4.08 will also update the support email
addresses for some previous versions of FDT. The most recently installed version of FDT will be
the application registered for use with the FDT file extensions. Thisis so that the most recently
installed version will be used when afileis double clicked from Windows® Explorer.

If you are an existing user of FDT, and your existing project needs to be migrated to FDT 4.08, the
recommendations are as follows:

If the project specifically requires the kernels distributed with an earlier version of FDT (or a
customised kernel based upon an older version), it is possible to choose the “ Other” option to
select the “User Defined” kernel. It is recommended however, that wherever possible, the latest
kernels be used. Using kernels from previous versions of FDT may lead to adecrease in
functionality (e.g. FDT 3.1 and above kernels include the information that FDT requires to
calculate the asynchronous serial error rates; use of kernels distributed prior to FDT 3.1 will result
in this feature being disabled).

For projectsusing FDT versions prior to FDT 3.0, a new workspace and project should be created
using the wizard. Thiswill ensure that the new settings are generated asrequired by FDT and isa
very quick process using the Project Wizard. The workspace files used by FDT versions prior to
version 3.2 are not compatible with FDT 4.08 due to the enhancements since then.

Workspaces from previous versions of FDT (from version 3.2) can be opened with FDT 4.08 but
should not be opened with the original version again after they have been upgraded. Any errors
related to “ SyntaxHighlightingFile.dbs’ can be ignored in this case. Toolbar positions and states
may also be affected by opening old format workspaces. File associations may need setting up
once the project has been upgraded to allow double clicking to open the selected file and
downloading.
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Appendix Error Messages

Error No.

Error Message

Description

15005

Error No. 15005:
'COMX' read time out

* “COMX” isaselected COM port
such as COM1 or COM4.

A problem has arisen during communications between
the device and the FDT (host computer) for some
reason and the timeout period has el apsed.
Communications are not possibleif the baud rate set
for the FDT does not match that for the actual device
on the target board. Check the following points.

e Baud rate

- Check the operating frequency of the device and
make sure that it is within the allowed range for the
transfer rate and that the baud rate is appropriate.

e Clock frequency

- Check that the operating frequency of the device
selected for the FDT matches the clock frequency of
the actual device on the target board.

¢ Connection between the device on the target board
and host computer

- Communications may fail if aUSB-RS232C
converter, self-produced cable, or self-produced
extension cable for connection to the E8a*, etc. isin
use.

This error may appear along with error 15019
(“Download() failed”), 15024 (“Boot failed”), or
16162 (“The connection timed out”).

*Note: Correct operation of the E8ais only guaranteed
with the cableincluded in the E8a package.

15016

Error No. 15016:
Changing baud rate to xxxxx bps

* “xxxxx bps’ is the baud-rate
value that has been set, and might
for example be “38400 bps’ or
“57600 bps”.

There are no problems with the FDT settings but
settings (including clock settings) for the actual device
on the target board are incorrect. Check the settings
for the actua device on the target board.

This error may appear along with error 16148/16149
(“Kernel Error Response”).

15019

Error No. 15019:
Download() failed

A problem has arisen during communi cations between
the device and the FDT (host computer) for some
reason and thus programming is not possible (i.e.
downloading has failed).

This error may appear along with error 15005
(“"COMX' read time out”). For how to deal with the
error, refer to the entry for error 15005.
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Error No.

Error Message

Description

15024

Error No. 15024: Boot failed

The FDT has encountered atimeout error because the
device was not in boot mode or communications
between the device and host computer failed. Check
the following points.

e Connection between the device on the target board
and host computer

- Communications may fail if aUSB-RS232C
converter, self-produced cable, self-produced
extension cable for connection to the E8a*, etc. isin
use.

e Device on the target board

- Check the voltage of the power supply for the device
on the target board.

- Méake sure that the boot-mode and pin-handling
settings for the device are correct.

- Make sure that the device selection is correct.

*Note: Correct operation of the E8ais only guaranteed
with the cable included in the E8a package.

15025

Error No. 15025: Erase failed

Erasing datain the flash memory in the device has
failed. The following reasons for this error are
possible.

(a) A correct power-supply voltage was not being
supplied to the device (from the E8a or target board).
(b) The device was not operating correctly due to pin
Settings.

(c) The device has been damaged.

(d) Commands were not executed because of failed
communications between the device and host
computer*.

Be sure to check for conditions () to (d).

* Communications may fail when a USB-RS232C
converter, self-produced cable, self-produced

extension cable for connection to the E8a, etc. isin
use.
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Error No.

Error Message

Description

15031

Error No. 15031: Erase failed

When the device s activated in boot mode, the FDT
erases the data in the flash memory. This error
indicates that erasure has failed.

() A correct power-supply voltage was not being
supplied to the device (from the E8a or target board).
(b) The device was not operating correctly dueto pin
settings.

(c) The device has been damaged.

Be sure to check for conditions (a) to (c).

15026
15060
15061

Error No. 15026:
Unable to open comms

Error No. 15060:
Error while opening the port

Error No. 15061:
Error while closing the port

The FDT was unable to recogni ze the communications
port. Check the port settings for the host computer you
areusing.

When we get inquiries regarding this error, in many
cases it is because the host computer is not compatible
with RS232C, leading to (a) a USB-RS232C converter
being in use or (b) a serial-USB conversion IC and a
self-produced conversion circuit (board) being in use.

Unlike the RS-232C interface of a host computer,
ports are controlled viathe USB in cases (a) and (b),
so the communicationstiming is dightly delayed. This
may hamper the adjustment of timing between the
FDT and device on the target board. To avoid this
problem, use a host computer that is compatible with
RS232C or an E8athat is connectable to the host
computer via USB.

16129

Error No. 16129:

Unable to download main kernel -
Invalid End of Setting Data
Response Received

Anillega command was received in the state of
waiting for a data-setting compl etion command. Check
the model name and pin settings of the device on the
target board.

16148

Error No. 16148:

Kernel Error Response: Oxbf 0x24
Baud Rate change failed - check
clock and baud rate compatibility

The newly specified baud rateisillegal (the size of the
error in the bit rate for serial communicationsis too
big). Make appropriate settings for the input clock
frequency, multiplier for the main clock frequency,
and multiplier for the peripheral clock frequency in the
[Device Settings] dialog box.

When we get inquiries regarding this error, in many
casesit is due to the selection of an inappropriate
multiplier for the peripheral clock frequency. For
details on clock supply, refer to the hardware manual
for the devicein use. Also check the clock settings for
the device on the target board.
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Error No.

Error Message

Description

16149

Error No. 16149:
Kernel Error Response: Oxbf 0x25
Input clock error

The input clock frequency is beyond the range where
the device can operate. Make appropriate settings for
the input clock frequency, multiplier for the main
clock frequency, and multiplier for the peripheral
clock frequency in the [Device Settings] dialog box.
When we get inquiries regarding this error, in many
casesit is due to the selection of an inappropriate
multiplier for the peripheral clock frequency. For
details on clock supply, refer to the hardware manual
for the device in use. Also check the clock settings for
the device on the target board.

16151

Error No. 16151:
Kernel Error Response: Oxbf 0x27
Operating frequency error

The clock frequency does not match the operating
frequency specifications of the device characteristics.
The FDT checks the allowed range of operating
frequencies for the device (only by calculation) against
the conditions input through the FDT (input clock
frequency and multiplier). Make sure that the
conditions input through the FDT are correct.

16162

Error No. 16162:
The connection timed out

A problem has occurred during communications
between the device and FDT (host computer) for some
reason and communications are thus not possible.

This error may appear along with error 15005
(“'COMX' read time out”). For how to deal with the
error, refer to the entry for error 15005.

16164

Error No. 16164
Checksum Read Error

An incorrect checksum value was given in response to
a checksum command.

In some protocols adopted for devices, an additional
byte as a sum code is used to guarantee the command
data. The checksum is correct when the lowest-order
byte of the result of command data + sum codeis 0.
This error thus indicates that the sum of data
(including the sum code) sent from the devicein
response to a checksum command was not 0.

Possible reasons for this error include unstable serial
communications between the FDT and device, and if
thisisthe caseit is probably because device-pin
handling isincorrect (pins TxD and RxD are not
pulled up or Vcl-pin handling isincorrect) or the
communications cable connecting the host computer
and device on the target board istoo long.
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Error No. Error Message Description

16172 Error No. 16172: Writing to the device is not possible for some reason.
Kernel Error Response: 0xd0 0x53 Possible reasons for this error include an attempt to
Operation failed write to the device without erasing it, incorrect pin

settings, or failure of the normal supply of power to
the device.

16194 Error No. 16194: Theinput ID code does not match the code set in the
ID code check failure device being programmed.

Make sure that the ID code is correct. If you do not
remember the ID code, you cannot use a serial
programmer to read, write, or erase datain the device.
Use aparallel programmer instead.

17145 Error No. 17145: The QzROM device that you attempted to write to was
The programming attempt hasbeen | not blank or was partly protected. Check the state of
aborted because thereis conflicting | the device.
data at OXXXXX in the device. The | hen an attempt to write to a protected addressiis
Project is set to Automatic Device | made error 17159 is returned.

Protection (no data was written).

17159 Error No. 17159: Programming of the flash memory has failed for some

Unable to download file reason. Check the conditions in which programming
was attempted (such as the power voltage for the
device).

17502 Error No. 17502: The FDT was incapable of correctly controlling the

Received error response from
E8/E8a

device through the E8/E8a. Check the connections of
the FDT to the device and the E8/E8a.

If the problem you have encountered cannot be solved despite the information given above, save
the log information and attach it to the e-mail to be sent for inquiry.

To save the log information

1. Select [Help -> Technical Support -> Create Bug Report...].
2. Select [Save to disk...] from the pull-down menu for [How would you like to submit the

report].

3. Click on the [Submit] button.
4. Select the location where the file should be saved and click on the [Save] button.
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